Oracle Utilities Analytics
Installation Guide
Release 2.6.0
E70875-01

April 2016
(Updated November 2017)
### Contents

#### Chapter 1
**Introduction**
- About Oracle Utilities Analytics Installation ............................................. 1-1
- Installation Components ........................................................................... 1-1
- Installation Types .................................................................................... 1-2
  - Initial Installation .................................................................................. 1-2
  - Upgrade ................................................................................................. 1-3
  - Demo Installation .................................................................................. 1-4

#### Chapter 2
**Preparing for Installation** ........................................................................ 2-1
- Installation Checklist ................................................................................ 2-2
- Prerequisite Software .............................................................................. 2-2
  - Prerequisite Software for Oracle Utilities Analytics Database Component ............................................. 2-2
  - Prerequisite Software for Oracle Utilities Analytics Installer ................................................................. 2-2
  - Prerequisite Software for Oracle Data Integrator Based ELT Component ................................................. 2-3
  - Prerequisite Software for Oracle Utilities Analytics Administration Tool Component .......................... 2-3
  - Prerequisite Software for Oracle Utilities Analytics Dashboards Component ......................................... 2-3
- Deployment ............................................................................................... 2-4
- Operating Systems and Application Servers ............................................. 2-5
- Supported Source Application Versions .................................................... 2-6
- Additional Notes on the Supported Platforms ........................................... 2-6
  - Oracle Unbreakable Enterprise Kernel ........................................................................................................... 2-6
  - Oracle VM Support ................................................................................ 2-6
  - Oracle Support Policy on VMWare ......................................................... 2-6

#### Chapter 3
**Oracle Utilities Analytics Initial Installation** ............................................. 3-1
- Installing Oracle Utilities Analytics Database Component ............................ 3-1
- Copying and Decompressing the Install Media ........................................... 3-1
- Creating the Database ............................................................................... 3-2
- Creating the Users and the Tablespaces ..................................................... 3-2
- Installing the RELADM Schema ................................................................. 3-2
- Installing the MDADM Schema ................................................................. 3-4
- Installing the DWADM Schema ................................................................. 3-5
- Configuring the Spatial Data .................................................................... 3-6
Chapter 4

Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1 ............................................. 4-1

Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or from Version 2.5.2.0.1 to Version 2.6.0 ............ 4-2

Prerequisites ................................................................................................................................. 4-2

Upgrading Oracle Utilities Analytics Database Component .......................................................... 4-11

Upgrading Oracle Utilities Analytics Based ELT Component ...................................................... 4-15

Creating the WebLogic Domain for Oracle Data Integrator Agent.................................................... 4-18

Starting the WebLogic Admin Server .......................................................................................... 4-21

Starting the Managed Server ...................................................................................................... 4-21

Upgrading Oracle Utilities Analytics Administration Tool Component ..................................... 5-60

Chapter 5

Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5 ............................................................. 5-1

Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5 to Version 2.6.0 ................................. 5-2

Prerequisites ................................................................................................................................. 5-2

Upgrading Oracle Data Integrator Based Oracle Utilities Analytics .............................................. 5-3

Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics .................................... 5-36

Upgrading Oracle Utilities Analytics Administration Tool Component ..................................... 5-60

Upgrading Oracle Utilities Analytics Dashboards Components ............................................... 5-61

Chapter 6

Installing Demo Database .............................................................................................................. 6-1

Installing Oracle Utilities Analytics Demo Database Component .................................................. 6-1

Copying and Decompressing the Install Media ............................................................................. 6-1

Creating the Database and Importing the Dump File .................................................................... 6-2

Configuring the Security .............................................................................................................. 6-5

Configuring the Spatial Data ........................................................................................................ 6-5

Installing Oracle Utilities Analytics Dashboards Component ..................................................... 6-6

Copying and Decompressing the Install Media ............................................................................. 6-6

Starting the Installer ..................................................................................................................... 6-6

Installation Steps .......................................................................................................................... 6-7

Deploying the Repository (RPD) File ............................................................................................ 6-9
Chapter 7
Spatial Configuration ......................................................................................................................................................... 7-1
   Acquiring the Spatial Data................................................................................................................................................. 7-1
   Installing Spatial Data ......................................................................................................................................................... 7-1
   Importing the Spatial Data into Oracle Utilities Analytics Spatial Data Tables ......................................................... 7-2
      Importing Theme Related Spatial Data into Oracle Utilities Analytics ............................................................... 7-3
      Improving Performance by Prefetching the Map Tiles ............................................................................................... 7-6
   Loading the Oracle Utilities Specific Themes .............................................................................................................. 7-7
   Additional Setup for Oracle Utilities Outage Analytics ............................................................................................... 7-7

Chapter 8
Installing the NMS Business Intelligence Publisher Reports .......................................................................................... 8-1
Welcome to Oracle Utilities Analytics, Release 2.6.0.

This guide provides information for those installing and configuring Oracle Utilities Analytics on Windows, Linux, Solaris, and AIX systems.

The preface includes the following:

• **Audience**
• **Prerequisite Knowledge**
• **Related Documents**
• **Conventions**
• **Documentation Accessibility**
• **Documentation Roadmap**

**Audience**

This guide is intended for use by anyone who is responsible for installing or upgrading Oracle Utilities Analytics.

**Prerequisite Knowledge**

Oracle Utilities Extractors and Schema and Oracle Utilities Analytics Dashboards make use of several technologies. It is assumed that you have a working knowledge of the following to configure and administer Oracle Utilities Analytics:

- **Oracle Data Warehouse**
  
  https://docs.oracle.com/database/121/DWHSG/toc.htm

- **Oracle Data Integrator**
  
  http://docs.oracle.com/middleware/1213/odi/index.html

- **Oracle GoldenGate**
  
  http://docs.oracle.com/goldengate/1212/gg-winux/index.html

- **Oracle WebLogic Server**
  
  https://docs.oracle.com/middleware/1213/wls/index.html

- **Oracle Business Intelligence Enterprise Edition**
Related Documents

The following documentation is included with this release.

**Installation, Administration, and Release Notes**

- Oracle Utilities Analytics Release Notes
- Oracle Utilities Analytics Getting Started Guide
- Oracle Utilities Analytics License Information User Manual
- Oracle Utilities Analytics Installation Guide
- Oracle Utilities Analytics Quick Install Guide
- Oracle Utilities Analytics Administration Guide
- Oracle Utilities Analytics Developer’s Guide

**Metric Reference Guides**

- Oracle Utilities Analytics Dashboards for Oracle Utilities Meter Data Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Customer Analytics, Revenue Analytics and Credit & Collections Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Exception Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Mobile Workforce Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Distribution Analytics and Outage Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Work and Asset Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Oracle Utilities Operational Device Analytics Metric Reference Guide

**Data Mapping Guides**

- Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping Guide

You can view the latest documentation at [http://docs.oracle.com/cd/E72219_01/documentation.html](http://docs.oracle.com/cd/E72219_01/documentation.html).
# Conventions

The following text conventions are used in this document:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface</td>
<td>Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.</td>
</tr>
<tr>
<td>italic</td>
<td>Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.</td>
</tr>
<tr>
<td>monospace</td>
<td>Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.</td>
</tr>
</tbody>
</table>

# Abbreviations

The following table lists the commonly used abbreviations used in this guide:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>APEX</td>
<td>Oracle Application Express</td>
</tr>
<tr>
<td>CDC</td>
<td>Changed Data Capture</td>
</tr>
<tr>
<td>ELT</td>
<td>Extraction, Loading and Transformation</td>
</tr>
<tr>
<td>ETL</td>
<td>Extraction, Transformation, and Loading</td>
</tr>
<tr>
<td>OBIEE</td>
<td>Oracle Business Intelligence Enterprise Edition</td>
</tr>
<tr>
<td>BI</td>
<td>Business Intelligence</td>
</tr>
<tr>
<td>ODI</td>
<td>Oracle Data Integrator</td>
</tr>
<tr>
<td>OGG</td>
<td>Oracle GoldenGate</td>
</tr>
<tr>
<td>OUA</td>
<td>Oracle Utilities Analytics</td>
</tr>
<tr>
<td>WAM</td>
<td>Oracle Utilities Work and Asset Management</td>
</tr>
<tr>
<td>CC&amp;B</td>
<td>Oracle Utilities Customer Care and Billing</td>
</tr>
<tr>
<td>MDM</td>
<td>Oracle Utilities Meter Data Management</td>
</tr>
<tr>
<td>MWM</td>
<td>Oracle Utilities Mobile Workforce Management</td>
</tr>
<tr>
<td>NMS</td>
<td>Oracle Utilities Network Management System</td>
</tr>
<tr>
<td>ODM</td>
<td>Oracle Utilities Operational Device Management</td>
</tr>
<tr>
<td>OSDC</td>
<td>Oracle Software Delivery Cloud</td>
</tr>
</tbody>
</table>

# Documentation Accessibility

For information about configuring and using accessibility features for Oracle Utilities Analytics, see the documentation at [http://docs.oracle.com/cd/E23943_01/bi.1111/e10544/appaccess.htm#BIEUG2756](http://docs.oracle.com/cd/E23943_01/bi.1111/e10544/appaccess.htm#BIEUG2756).

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For more information, visit: http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Documentation Roadmap

This guide is organized based on the typical flow you need to follow to install and configure Oracle Utilities Analytics. Use the following documentation roadmap to find the information that you need to install Oracle Utilities Analytics.

1. Overview
   This chapter includes a general description about Oracle Utilities Analytics and provides information about the installation types and components required to install or upgrade Oracle Utilities Analytics.

2. Supported Platforms and Hardware Requirements
   This chapter shows each of the operating system/server combinations that Oracle Utilities Analytics is certified for.

3. Planning the Installation
   This chapter describes the setup steps or pre-installation tasks that you must complete before you begin an Oracle Utilities Analytics installation or upgrade.

4. Performing an Initial Installation
   This chapter provides the steps for a new Oracle Utilities Analytics installation. It includes procedures to install various components for Oracle Utilities Analytics to be functional.

5. Performing an Upgrade from v2.5.1.2 or v2.5.2.0.1
   This chapter includes the steps to upgrade Oracle Utilities Analytics from version 2.5.1.2 or 2.5.2.0.1 to version 2.6.0.

6. Performing an Upgrade from v2.5.0.0.5
   This chapter provides the instructions to upgrade Oracle Utilities Analytics from version 2.5.0.0.5 to version 2.6.0.

7. Installing Demonstration Database
   This chapter provides instructions for installing the demonstration database.

8. Configuring Spatial Data
   This chapter provides information about spatial data setup for the Oracle Business Intelligence Enterprise Edition dashboards in Oracle Utilities Analytics and how to set up the spatial data. It explains the steps to acquire, install import, and load the spatial data.

9. Installing NMS BI Publisher Reports
   This chapter describes the steps to install the NMS IEEE outage reports in Oracle Utilities Analytics.
Chapter 1
Introduction

This chapter provides an overview of the Oracle Utilities Analytics, Release 2.6.0 installation. It is a complete installation and does not need to install any of the previous versions.

**Note:** For information about configuring and administering Oracle Utilities Analytics (Oracle Utilities Analytics Dashboards and Oracle Utilities Extractors and Schema), refer to the *Oracle Utilities Analytics Administration Guide*.

A typical Oracle Utilities Analytics installation involves installing various components across different installation types. This chapter focuses on these details:

- Installation Components
- Installation Types
- Media Pack Components

### Installation Components

The Oracle Utilities Analytics installation includes installing the following components. For a successful installation, it is required to install ALL of these components:

- **Oracle Utilities Analytics Database** - Contains star schemas and product metadata.
- **Oracle Utilities Analytics ELT** - Based on Oracle Data Integrator (ODI), it includes pre-built ODI objects necessary for ELT processes.
  
  **Note:** Oracle GoldenGate (OGG) is used to capture the data and is required for ODI-based ELT.
- **Oracle Utilities Analytics Administration** - An Oracle Application Express (APEX) application used to maintain several Oracle Utilities Analytics configuration parameters.
- **Oracle Utilities Analytics Dashboard** - Includes the pre-built OBIEE Web Catalog, RPD file, and answers, based on OBIEE.

  **Note:** Install this component on the server where OBIEE is installed. It also includes a demo database with pre-populated data used for training or demonstration purposes. Refer to the *Installing Demo Database* chapter for more information.

Refer to [Prerequisite Software](#) in the *Preparing for Installation* chapter for information about the prerequisite software required to install each of the components.
Installation Types

The first step in the installation procedure is to determine the installation type that meets your business requirements. The possible installation types are as follows:

- **Initial Installation** - A base installation, typically used for a production environment.
- **Upgrade** - An upgrade installation from version 2.5.1.2 or 2.5.2.0.1 or 2.5.0.0.5 to version 2.6.0.
- **Demo Installation** - A base installation with pre-populated demo data, typically used for demonstration or training purposes.

The following sections describe these installation types in detail.

**Initial Installation**

This type is applicable for a new Oracle Utilities Analytics installation. For an initial installation, you must install all of the following components:

- Oracle Utilities Analytics Database
- Oracle Utilities Analytics ELT
- Oracle Utilities Analytics Administration
- Oracle Utilities Analytics Dashboard

Following is a high-level workflow of the installation process:

- **Step 1**: Install the database components in the order below:
  - Oracle Database 12.1.0.2.0
  - WebLogic 10.3.6
  - ODI 12.1.3 with JavaEE
  - Oracle Utilities Analytics Database
  - Oracle Utilities Analytics Administration
  - Oracle Utilities Analytics ODI-Based ELT

- **Step 2**: Install the dashboard components as below:
  - Oracle Client 12.1.0.2.0 and Oracle Repository Creation Utility
  - OBIEE 11.1.1.9.1
  - Oracle Utilities Analytics Dashboard

Refer to the Preparing for Installation chapter for information about the prerequisite software required to install each of the components. Refer to the Oracle Utilities Analytics Initial Installation chapter for the respective component installation steps.

**Upgrade**

This installation type is applicable while upgrading Oracle Utilities Analytics from the following versions:

- 2.5.1.2 or 2.5.2.0.1 to 2.6.0
- 2.5.0.0.5 to 2.6.0

For an upgrade, you must upgrade all of the following components:

- Oracle Utilities Analytics Database
- Oracle Utilities Analytics ELT
Following is a high-level workflow of the upgrade process:

- **Step 1:** Upgrade the database components in the order below:
  - Oracle Database 12.1.0.2.0
  - Oracle Utilities Analytics Database
  - Oracle Utilities Analytics Administration
  - Oracle Utilities Analytics ODI-Based ELT

- **Step 2:** Install/upgrade the dashboard components as below:
  - Oracle Client 12.1.0.2.0 and Oracle Repository Creation Utility
  - OBIEE 11.1.1.9.1
  - Oracle Utilities Analytics Dashboard

Refer to the Preparing for Installation chapter for information about the prerequisite software required to install each of the components.

If you are upgrading the product from version 2.5.1.2 or 2.5.2.0.1, refer to chapter Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1 for the steps involved in upgrading each of the required components.

If you are upgrading the product from version 2.5.0.0.5, refer to chapter Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5 for the steps involved in upgrading each of the required components.

### Demo Installation

This installation type is applicable when installing a database component for Oracle Utilities Analytics Dashboards for demonstration or training purposes. For a demo installation, install the following components:

- Oracle Utilities Analytics Demo Database
- Oracle Utilities Analytics Dashboard

Following is a high-level workflow of the demo installation process:

- **Step 1:** Install the database components in the order below:
  - Oracle Database 12.1.0.2.0
  - Import demo data

- **Step 2:** Install the dashboard components as below:
  - Oracle Client 12.1.0.2.0 and Oracle Repository Creation Utility
  - OBIEE 11.1.1.9.1
  - Oracle Utilities Analytics Dashboard

Refer to the Preparing for Installation chapter for information about the prerequisite software required to install each of the components. Refer to the Installing Demo Database chapter for the respective component installation steps.
Media Pack Components

The Oracle Utilities Analytics Media Pack consists of the following packages:

**Documentation Packages**
- Oracle Utilities Analytics Release Notes
- Oracle Utilities Analytics Quick Install Guide
- Oracle Utilities Analytics Installation Guide
- Oracle Utilities Analytics Administration Guide
- Oracle Utilities Analytics Developer's Guide
- Oracle Utilities Analytics License Information User Manual
- Oracle Utilities Analytics Dashboards for Customer Analytics, Revenue Analytics, and Credit & Collections Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Exception Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Mobile Workforce Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Distribution Analytics and Outage Analytics
- Oracle Utilities Analytics Dashboards for Work and Asset Analytics Metric Reference Guide
- Oracle Utilities Analytics Dashboards for Operational Device Analytics Metric Reference Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Customer Care and Billing Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Meter Data Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Mobile Workforce Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Network Management System Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Operational Device Management Data Mapping Guide
- Oracle Utilities Extractors and Schema for Oracle Utilities Work & Asset Management Data Mapping Guide

**Installation Packages**
- Oracle Utilities Analytics v2.6.0 Dashboard Component Multiplatform
- Oracle Utilities Analytics v2.6.0 ETL Component Based on OWB Multiplatform
- Oracle Utilities Analytics v2.6.0 ELT Component Based on ODI Multiplatform
- Oracle Utilities Analytics v2.6.0 Oracle Database Multiplatform
- Oracle Utilities Analytics v2.6.0 Demo Data
Chapter 2

Supported Platforms and Hardware Requirements

This chapter provides an overview of the operating system/server combinations that this Oracle Utilities Analytics release is certified for. It includes:

- Operating Systems and Application Servers
- Hardware and Web Browser Requirements
- Memory Requirements
- Additional Notes on Supported Platforms
- Support for Software Patches and Upgrades
Operating Systems and Application Servers

An Oracle Utilities Analytics installation is tested and supported on a wide variety of operating system, application server, and database server combinations. The following table provides the details of the minimum versions supported.

<table>
<thead>
<tr>
<th>Browser</th>
<th>Operating System (Client)</th>
<th>Operating System (Server)</th>
<th>Chipset</th>
<th>Application Server</th>
<th>Oracle Business Intelligence Edition (OBIEE)</th>
<th>Oracle Data Integrator (ODI)</th>
<th>JDK</th>
<th>Oracle GoldenGate</th>
<th>Oracle REST Data Service</th>
<th>Database</th>
</tr>
</thead>
<tbody>
<tr>
<td>IE 11.x</td>
<td>AIX 7.1 (64-bit)</td>
<td>Power 64-bit</td>
<td>x86_64</td>
<td>WebLogic 10.3.6</td>
<td>11.1.1.9.1</td>
<td>12.1.3</td>
<td>1.7.0</td>
<td>12.1.2.1.1</td>
<td>3.0</td>
<td>Oracle 12.1.0.2.0</td>
</tr>
<tr>
<td></td>
<td>Windows 7/8.1/10 (64 Bit)</td>
<td>Oracle Linux 6.5 (64-bit)</td>
<td>x86_64</td>
<td>WebLogic 10.3.6</td>
<td>11.1.1.9.1</td>
<td>12.1.3</td>
<td>1.7.0</td>
<td>12.1.2.1.0</td>
<td>3.0</td>
<td>Oracle 12.1.0.2.0</td>
</tr>
<tr>
<td>Firefox 38.0ESR+(OBIEE only)</td>
<td>Oracle Linux 7.x (64-bit)</td>
<td>SPARC</td>
<td>WebLogic 10.3.6</td>
<td>11.1.1.9.1</td>
<td>12.1.3</td>
<td>1.7.0 (75)</td>
<td>12.1.2.1.0</td>
<td>3.0</td>
<td>Oracle 12.1.0.2.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Windows Server 2012 R2 (64-bit)</td>
<td>x86_64</td>
<td>WebLogic 10.3.6</td>
<td>11.1.1.9.1</td>
<td>12.1.3</td>
<td>1.7.0 (75)</td>
<td>12.1.2.1.0</td>
<td>3.0</td>
<td>Oracle 12.1.0.2.0</td>
<td></td>
</tr>
</tbody>
</table>

Important: For the latest system requirements and supported platforms details, refer to the knowledge article “System Requirements and Supported Platforms for Oracle Utilities Analytics v2.6.0” available on My Oracle Support (https://support.oracle.com/).

Oracle Utilities Analytics supports Oracle Data Integrator based ELT only from the following combination of source and target databases.

- 11g source --> 12c target
- 12c source --> 12c target

For Oracle Utilities Meter Data Management and Oracle Utilities Mobile Workforce Management source systems, ensure that the source database is on Oracle Database Server 12c.

Hardware and Web Browser Requirements

<Talk to Sanjeet/Banu for these details>

<Hardware Requirements, etc>

Memory Requirements

<Talk to Sanjeet/Banu for these details>

<Disk Space Requirements, etc>
Additional Notes on Supported Platforms

**Oracle Unbreakable Enterprise Kernel** - This version of Oracle Utilities Analytics is supported on Oracle Unbreakable Enterprise Kernel.

**Oracle VM Support** - This version of Oracle Utilities Analytics is supported on Oracle VM Server for x86 3.3 for the supported releases of Oracle Linux and Microsoft Windows operating systems.

**Oracle Support Policy on VMWare** - Refer to My Oracle Support knowledge base article 249212.1 for Oracle’s support policy on VMWare (https://support.oracle.com).

Support for Software Patches and Upgrades

Due to the ongoing nature of software improvement, vendors periodically issue patches and service packs for the operating systems, application servers, and database servers on top of specific versions that Oracle products have already been tested against.

If it is necessary to apply an upgrade, it is recommended to do so in a test environment that is running on the same platform as your production environment prior to updating the production environment itself.

Always contact Oracle Support prior to applying vendor updates that do not guarantee backward compatibility.
Chapter 2
Preparing for Installation

This chapter provides information to plan an Oracle Utilities Analytics installation, including:

- Prerequisite Software
- Supported Source Application Versions
- Deployment
- Installation Checklist

Prerequisite Software

Before you install Oracle Utilities Analytics, you are required to install the prerequisite software. Refer to the respective installation documentation of the software for download and installation instructions.

*Note:* Ensure that the same operating system user is used to install all software prerequisites and Oracle Utilities Analytics components.

The list of prerequisite software required to install Oracle Utilities Analytics is as below:

- Prerequisite Software For Oracle Utilities Analytics Database
- Prerequisite Software for Oracle Utilities Analytics Installer
- Prerequisite Software for ODI-Based ELT Component
- Prerequisite Software for Oracle Utilities Analytics Administration
- Prerequisite Software for Oracle Utilities Analytics Dashboards

Prerequisite Software For Oracle Utilities Analytics Database

The prerequisite software for the Oracle Utilities Analytics database component is as follows:

**Oracle Database Server Enterprise Edition 12.1.0.2.0** - This Oracle Utilities Analytics release is supported on Oracle Database Server Standard Edition 12.1.0.1.0 when using ODI-based ELT component.

Prerequisite Software for Oracle Utilities Analytics Installer

The prerequisite software for Oracle Utilities Analytics Installer is JDK 1.7.0 (75).
Prerequisite Software for ODI-Based ELT Component

The prerequisite software for ODI-based ELT component of Oracle Utilities Analytics is as follows:

- JDK 1.7.0 (75)
- Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard Edition 12.1.0.1.0
- Oracle Fusion Middleware Infrastructure and Oracle Data Integrator 12.1.3 with Java EE (ODI patch 19949726 should be installed after installing ODI 12.1.3)
- Oracle GoldenGate

Install Oracle GoldenGate on the source application database server as well as the target database server. Download it from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

- Oracle Utilities Analytics Administration

Prerequisite Software for Oracle Utilities Analytics Administration

The prerequisite software for Oracle Utilities Analytics Administration component is as follows:

- Oracle Database Server Enterprise Edition 12.1.0.2.0 or Oracle Database Server Standard Edition 12.1.0.1.0
- Oracle Apex 4.2.6
- Oracle WebLogic 10.3.6

Prerequisite Software for Oracle Utilities Analytics Dashboards

The prerequisite software for Oracle Utilities Analytics dashboard component is as follows:

- Oracle Business Intelligence Enterprise Edition 12.2.1.0.0

   Note: Install the Oracle 12.1.0.2.0 client if OBIEE is not installed on the database server. If it is installed, then there is no need to install Oracle client.

After installing OBIEE, save a snapshot of the last page of OBIEE installation that shows the details of BI Oracle Home, Instance Home, etc. These values are used during the Oracle Utilities Analytics installation.

Supported Source Application Versions

The following are the supported source application versions:

<table>
<thead>
<tr>
<th>Source Application</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Utilities Customer Care and Billing</td>
<td>2.4.0.3</td>
</tr>
<tr>
<td></td>
<td>2.5.0.1</td>
</tr>
<tr>
<td>Oracle Utilities Network Management System</td>
<td>1.11.0.4</td>
</tr>
<tr>
<td></td>
<td>1.12.0.3</td>
</tr>
<tr>
<td>Oracle Utilities Work and Asset Management</td>
<td>2.1.1</td>
</tr>
<tr>
<td>Oracle Utilities Meter Data Management</td>
<td>2.1.0.3</td>
</tr>
<tr>
<td>Source Application</td>
<td>Version</td>
</tr>
<tr>
<td>------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Oracle Utilities Mobile Workforce Management</td>
<td>2.2.0.3</td>
</tr>
<tr>
<td></td>
<td>2.3.0</td>
</tr>
<tr>
<td>Oracle Real-Time Scheduler</td>
<td>2.2.0.3</td>
</tr>
<tr>
<td></td>
<td>2.3.0</td>
</tr>
<tr>
<td>Oracle Utilities Operational Device Management</td>
<td>2.1.1</td>
</tr>
</tbody>
</table>

**Note:** For latest edge application version details, refer to the knowledge article “System Requirements and Supported Platforms for Oracle Utilities Analytics v2.6.0” available on My Oracle Support (https://support.oracle.com/).

**Deployment**

A standard Oracle Utilities Analytics deployment consists of a database and an application server. Two WebLogic installations are performed on the application server - for OBIEE and ODI. Oracle GoldenGate is installed on both source as well as target database servers.

The following figure shows a standard Oracle Utilities Analytics deployment.
Installation Checklist

The following checklist guides you through the Oracle Utilities Analytics installation process. The details for each step are provided in respective subsequent chapters.

1. Confirm that the recommended hardware is ready. Refer to Supported Platforms and Hardware Requirements for details.
2. Install prerequisite software. Refer to the Prerequisite Software for more details.
3. Determine the installation type. Refer to Installation Types to determine the installation type for your scenario.
4. Ensure that you have downloaded the Oracle Utilities Analytics v2.6.0 components.
5. Perform the installation steps as applicable to the installation type.
   • Initial Installation - For initial installation, follow the instructions mentioned in the Oracle Utilities Analytics Initial Installation chapter.
   • Upgrade - For upgrade to v2.6.0, follow the instructions in Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1 and Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5 chapters for the respective version you are upgrading from.
   • Demo Installation - For instructions to proceed with demo installation, refer to the Installing Demo Database chapter.
This chapter provides instructions for a new Oracle Utilities Analytics installation. It includes:

- Before You Install
- Installing Oracle Utilities Analytics Database
- Installing Oracle Data Integrator Based ELT Component
- Installing Oracle Utilities Analytics Administration Component
- Installing Oracle Utilities Analytics Dashboards Component

Before You Install

Refer to My Oracle Support for up-to-date additional information about this Oracle Utilities Analytics release.

Installing Oracle Utilities Analytics Database

This section describes the steps to install Oracle Utilities Analytics Database on the database server, including:

- Installing Prerequisite Software
- Copying and Decompressing Install Media
- Creating the Database
- Creating Users and Tablespaces
- Installing the RELADM Schema
- Installing the MDADM Schema
- Installing the DWADM Schema
- Configuring Spatial Data

Installing Prerequisite Software

The prerequisite software has to be installed before you begin the component installation. Refer to Prerequisite Software For Oracle Utilities Analytics Database for details.
Copying and Decompressing Install Media

To copy and decompress install media, follow these steps:

1. Download Oracle Utilities Analytics v2.6.0 Oracle Database from the Oracle Utilities Analytics v2.6.0 Oracle Database Multiplatform.zip file.

   Download the zip from Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory.

   For example: c:\OUA\temp for a Windows machine or /OUA/temp for a Linux machine.

   This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.


The installation media is decompressed successfully. Proceed with creating the database.

Creating the Database

In an initial installation, it is recommended to use the Database Configuration Assistant (DBCA) utility to create the database.

   Note: Refer to Oracle database documentation to know more about Database Configuration Assistant (DBCA).

Create the database with the same character set as the source database character set. Set the open cursor limit to 3000 and processes to 1000 at the time of the database creation.

Creating Users and Tablespaces

To create the required users and tablespaces, perform the following steps:

1. Create users in the database with the below names (without giving specific roles):

   - DWADM
   - DWUSER
   - DWREAD
   - MDADM
   - RELADM
   - OUA_MASTER
   - OUA_WORK
   - DWSTAGE

   Though users can be created using any tablespace name, same names should be configured in a metadata table. Configure the tablespace names on the Storage Configuration page in Oracle Utilities Analytics Administration.

   See the Oracle Utilities Analytics Administration chapter in Oracle Utilities Analytics Administration Guide for more details.
2. Create roles with the following names:
   - DW_USER
   - DW_READ
   - DW_PRIVS_ROLE
   - DW_REPLICATE

3. Connect to the database as sys user.

   Execute Usersgrants.sql in BI260/Scripts/Usersgrants.sql. This SQL provides required grants to the users created in step 1.

   The required users and tablespaces are created.

---

**Installing the RELADM Schema**

The RELADM schema is a metadata schema consisting of database objects used to store the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

- Reviewing Storage.xml
- Installation Procedure
- Generating Database Statistics

**Reviewing Storage.xml**

The storage.xml file (included in the package and is in <TEMPDIR>/BI260/RELADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or RELADM user does not have quota on CISTS_01 tablespace, edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

**Installation Procedure**

To install the RELADM schema, follow these steps:

**Note:** This procedure prompts you for the password of RELADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

**In Windows:**

1. Add Java 7 to the path variable. For example:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI260\RELADM\Jarfiles\*
   ```

3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.
4. Execute OraDBI.jar.
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,RELADM -j
   <JDK Home> -f <TEMPDIR>/BI260\RELADM\Jarfiles -v 1 -e true
   ```

   In Unix:
   1. Add Java 7 to the path variable. For example:
      ```
      export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
      ```
   2. Set classpath pointing to OraDBI.jar and all dependency jars.
      ```
      export CLASSPATH=<TEMPDIR>/BI260/RELADM/Jarfiles/*
      ```
   4. Execute OraDBI.jar.
      ```
      java com.oracle.ouaf.oem.install.OraDBI -d
      jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
      <ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,RELADM -j
      <JDK Home> -f <TEMPDIR>/BI260/RELADM/Jarfiles -v 1 -e true
      ```

   The utility creates the RELADM schema and system data definitions. If an error occurs while executing a SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects.

Connect to the database as `sys user` and execute the following command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
```

**Installing the MDADM Schema**

The MDADM schema is a metadata schema that consists of the database objects used for storing the Oracle Utilities Analytics metadata.

For example: ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including:

- Reviewing Storage.xml
- Installation Procedure
- Generating Database Statistics

**Reviewing Storage.xml**

The storage.xml file (included in the package located at `<TEMPDIR>/BI260/MDADM/Install-Upgrade`) allocates all the base tables and indexes to the default tablespace `CISTS_01`.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.
**Note**: If the database does not have CISTS_01 tablesapce or MDADM user does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the correct tablespace name on which MDADM has quota.

**Installation Procedure**

To install the MDADM schema, follow these steps:

**Note**: This procedure prompts you for the password of MDADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

**In Windows**:

1. Add Java 7 to the path variable. For example:
   ```plaintext
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```plaintext
   set CLASSPATH=<TEMPDIR>\BI260\MDADM\Jarfiles\*
   ```
3. Navigate to the `<TEMPDIR>\BI260\RELADM\Install-Upgrade` folder.
4. Execute OraDBI.jar as shown below:
   ```plaintext
   ```

**In Unix**:

1. Add Java 7 to the path variable. For example:
   ```plaintext
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```plaintext
   export CLASSPATH=<TEMPDIR>/BI260/MDADM/Jarfiles/*
   ```
3. Navigate to the `<TEMPDIR>\BI260\RELADM\Install-Upgrade` folder.
4. Execute OraDBI.jar.
   ```plaintext
   ```

The utility creates the MDADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the database as **sys user** and execute the following command:

```plaintext
execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
```
Installing the DWADM Schema

The DWADM schema contains star schema objects (such as facts and dimensions) that contain the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

- Reviewing Storage.xml File
- Installation Procedure
- Generating the Database Statistics

Reviewing Storage.xml File

The storage.xml file (included in the package located at <TEMPDIR>/BI260/DWADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01.

If few tables or indexes outside of the default tablespace need to be allocated, it should be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

Note: If the database does not have CISTS_01 tablespace or DWADM user does not have quota on CISTS_01 tablespace, edit Storage.xml to indicate the correct tablespace name on which DWADM has quota.

Installation Procedure

To install the DWADM schema, follow these steps:

Note: This procedure prompts you for the password of DWADM user. Ensure that OraDBI.jar (in the step below) is run using JDK Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows:

1. Add Java 7 to the path variable. For example:
   
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   
   ```
   set CLASSPATH=<TEMPDIR>\BI260\DWADM\Jarfiles\*
   ```

3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.

4. Execute OraDBI.jar as shown below:
   
   ```
   java com.oracle.ouaf.oem.install.OraDBI –d
dbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
<ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM –j
<JDK Home> -f <TEMPDIR>\BI260\DWADM\Jarfiles –v 1 -e true
   ```

In Unix:

1. Add Java 7 to the path variable. For example:
   
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   
   ```
   export CLASSPATH=<TEMPDIR>/BI260/DWADM/Jarfiles/*
   ```
3. Run OraDBI.jar as follows:

```
java com.oracle.ouaf.oem.install.OraDBI -d
jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
<ORACLE SERVICE NAME>,DWADM,<Password of DWADM
user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM -j
<JDK Home> -f <TEMPDIR>/BI260/DWADM/Jarfiles -v 1 -e true
```

The utility creates the DWADM schema and system data definitions. If an error occurs while executing a SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating the Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the data as `sys user` and execute the following command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

**Configuring Spatial Data**

Refer to chapter Spatial Configuration for details about spatial configuration.

**Installing Oracle Data Integrator Based ELT Component**

This section describes the installation procedure of Oracle Data Integrator based ELT component. It includes:

- Installing Prerequisite Software
- Setting up Oracle GoldenGate
- Copying and Decompressing the Install Media
- Starting the Installer
- Installation Steps
- Creating a Database Directory
- Creating the WebLogic Domain for Oracle Data Integrator Agent
- Starting the WebLogic Admin Server
- Starting the Managed Server

**Installing Prerequisite Software**

The Oracle Data Integrator based ELT component is installed on the Oracle Utilities Analytics application server. Refer to Deployment for information about deploying Oracle Utilities Analytics.

To proceed with installing the ELT component, ensure the following:

- The operating system user that is used to install all the related software is used to install the ELT component also.
- Set up the source applications with required configurations before proceeding with the ELT component installation. This enables to successfully extract data from them into Oracle Utilities Analytics.
- Verify that the prerequisite software mentioned in Prerequisite Software for Oracle Data Integrator Based ELT Component are installed.
• Do not create any repositories while installing Oracle Data Integrator. During the process, do the following:
  • Select the **Skip Repository Configuration** option.
  • Select the **Developer Installation** and **Java EE Installation** options in the **Select Installation Type** step.

**Setting up Oracle GoldenGate**

This section describes setting up Oracle GoldenGate to work with Oracle Utilities Analytics.

- Setting up Oracle GoldenGate on the Source Database Server
- Setting up Oracle GoldenGate on the Target Database Server
- Setting up Oracle GoldenGate JAgent on Target and Source Database Servers

**Setting up Oracle GoldenGate on the Source Database Server**

To set up each source instance, follow these steps:

1. Create a directory on the source database server and install Oracle GoldenGate there. It will be Oracle GoldenGate home (OGG_Home) on the source database server.

   For example: `<path>/GoldenGate Home`

   **Note**: Make a note of this directory path; it is used in the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate.

   Download Oracle GoldenGate 12.1.2.1.0 from Oracle Software Delivery Cloud ([https://edelivery.oracle.com](https://edelivery.oracle.com)). For installation instructions, refer to the respective installation documentation at [http://docs.oracle.com/goldengate/1212/gg-winux/index.html](http://docs.oracle.com/goldengate/1212/gg-winux/index.html).

3. Provide the Oracle GoldenGate Home location as the directory location created in step 1.

4. Open a command terminal/window and set the source `ORACLE_SID` and `ORACLE_HOME` variables.

5. Set `LD_LIBRARY_PATH` as follows:

   In Unix:
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   In Windows:
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%
   ```

6. In the Command window, change the directory to Oracle GoldenGate Home directory, and then execute the command below:

   In Unix:
   ```
   ./ggsci
   ```

   In Windows:
   ```
   ggsci
   ```

   The Oracle GoldenGate prompt is shown.

7. At the Oracle GoldenGate prompt, execute the following commands in the order they are listed:

   • `create SUBDIRS`
• start mgr

This command starts the Oracle GoldenGate manager process.

• info all

This command verifies if the manager process is running.

• exit

This command exits Oracle GoldenGate.

8. Ensure that the source database is in the **archivelog** mode.

9. Connect to the source database as the **sys user** and execute the statements shown below:

```sql
alter database add supplemental log data (primary key) columns;
alter system set enable_goldengate_replication=TRUE scope=both;
```

10. In the Command window, navigate to the Oracle GoldenGate home (**OGG_Home**) directory.

11. 

12. 

13. 

14. 

15. 

16. Connect to the database as the sys user using the **SQL*Plus** (**OGG_Home** should be the current directory while invoking **SQL*Plus**).

17. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and make sure to assign a tablespace to this user that is not assigned to any other user.

   **Important Note:** Make a note of the GoldenGate Owner Username; it will be used during Oracle Utilities Analytics installation.

18. Connect to the source database with sys user and execute the following commands:

   **Note:** Make sure to change GoldenGate owner placeholder with actual name of database user as created in previous step.

```sql
grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
grant unlimited tablespace to <GoldenGate owner> with admin option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>','capture');
grant unlimited tablespace to <GoldenGate Owner> with admin option;
Revoke dba from <GoldenGate Owner>;
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;
```

19. Connect to the source application ADM schema such as CISADM, and execute the below commands:

   **For Oracle Utilities Customer Care and Billing source database, execute the following grants:**
Grant select on F1_MST_CONFIG to <GoldenGate owner user created in the step mentioned above>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in the step mentioned above>
Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in the step mentioned above>
Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created in the step mentioned above>

For Oracle Utilities Operational Device Management source database, execute the following grants:
Grant select on F1_MST_CONFIG to <GoldenGate owner user created in the step mentioned above>
Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in the step mentioned above>

For Oracle Utilities Meter Data Management source database, execute the following grants:
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>

For Oracle Utilities Work and Asset Management source database, execute the following grants:
Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>
Grant select on <application ADM Schema>. F1_MST_CONFIG to <GoldenGate Owner>
Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>

**Note**: While executing the SQL commands in the steps 15, 16 and 17, provide the GoldenGate owner user if prompted for. All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the sys user.

20. Run the command:
   @marker_setup.sql
21. Run the command:
   @ddl_setup.sql
22. Run the command:
   @role_setup.sql
23. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.
24. Change directory to the Oracle GoldenGate home directory, and execute the following steps:

   **Note**: The following prerequisite steps are to be executed before running the OUA installer. Refer to the Oracle GoldenGate Administering Oracle GoldenGate Guide for more info.

---

**Configuration for Encrypting Data with the ENCKEYS Method**
a. Execute the following command:
```
cd <OGG_HOME>
KEYGEN key_length n
```
The above command generates the key value based on the value specified in the parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

c. Repeat the step above for each key values generated.

d. Save the file with name ENCKEYS (Upper case only) without any extension.
   Example:
   ```
cd $OGG_HOME
./keygen 128 1
0x8CE55035DD6893205A7BD6773FA8E670
   ```

e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

f. Input the Logical name, space and key value generated.
   Example contents of file ENCKEYS:
   ```
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
   ```
g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

   Note: It is recommended to name Logical key name after <context_code>KEY. For example: if context code is CCB1, it is recommended to name CCB1KEY.

**Generating the Shared Secret Password**

a. Execute the following command:
```
cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
```
   Example:
   ```
cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
Encrypted password:
AADAAAAAIAIVGHBFLGFCBFCBFJFHFUEJNGCFAQAFEOFBALEGISPOIFW
GRBZHCCMCYGBDAZH
Algorithm used: AES128
   ```

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm name used and the generated Encrypted password.

**Setting up Oracle GoldenGate on the Target Database Server**

Perform the following steps:
1. Create a directory on the target database server. For example, ../GoldenGateHome. Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home (OGG_Home)** on the target Oracle Utilities Analytics database server.

   **Important Note:** Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a **Command** window and set the target ORACLE_SID and ORACLE_HOME variables.

   Set LD_LIBRARY_PATH using the following commands:

   **For Unix:**
   
   ```bash
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   **For Windows:**
   
   ```bash
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
   ```

4. In the **Command** window, change the directory to the **GoldenGate home directory** and execute the command:

   **For Unix:**
   
   ```bash
   ./ggsci
   ```

   **For Windows:**
   
   ```bash
   ggsci
   ```

   This opens the Oracle GoldenGate prompt.

5. On the **Oracle GoldenGate** prompt, execute the **create SUBDIRS** command.

6. On the **Oracle GoldenGate** prompt, execute the **start mgr** command to start the Oracle GoldenGate manager process.

7. On the **Oracle GoldenGate** prompt, execute the **info all** command to view the manager process is running.

8. Exit Oracle GoldenGate by executing **exit** command and create a directory named **diroby** inside the **OGG_Home** directory.

9. Connect to the target database as the sys user and execute below statement:

   ```sql
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. Go to OGG_Home directory.

11. If ENCKEYS file does not exist, open a new ASCII ENCKEYS file and add those key value/values generated on the sources to ENCKEYS file in target OGG home for the context codes for which source configuration is being done.

    Example contents of ENCKEYS file in target OGG home:

    ```plaintext
    CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
    ```

---

**Setting up Oracle GoldenGate JAgent on Target and Source Database Servers**

GoldenGate JAgent setup should be done on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers.

Follow these steps to setup GoldenGate on both target and source servers:
Installing Oracle Utilities Analytics - Initial Installation

After the Oracle GoldenGate software is installed and the Manager is running, follow the below steps to configure the JAGENT.

1. Start the rmiregistry services and note down the port on which RMI server is started. Use the following command:
   
   rmiregistry 5559 &
   
   Here, we have specified port number as 5559. If the port number is not specified, default port 1099 is used.

2. Edit the Config.properties file in the <GG home>/cfg and add/modify the below parameters.

   <ACTUAL> : jagent.host=localhost
   <CHANGE TO> : jagent.host=<<actual hostname on which OGG is installed>>

   <ACTUAL> : monitor.jmx.username=cmroot
   <CHANGE TO> : monitor.jmx.username=jmx_src

   <ACTUAL> : jagent.username=root
   <CHANGE TO> : jagent.username=<<OGG software installed OS user>>

   <ACTUAL> : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started

   <ACTUAL> : agent.type.enabled=OGGMON
   <CHANGE TO> : agent.type.enabled=OEM

3. Add the following parameter:

   jagent.ssl=false

4. Edit the GLOBALS file in the <GG home> and add the below command.

   EnableMonitoring

5. Execute the below command from <GG Home>:

   For Unix:
   ./pw_agent_util.sh -jagentonly

   For Windows:
   pw_agent_util.bat -jagentonly

6. Enter the Oracle wallet password. This password has to be entered as the password for the JAGENT while running the installer (for target gg) and while running source configuration (for source gg). Please make a note of the password. Please note down the password, jagent.rmi.port value (JAgent Port), this info is required in subsequent installation.

7. Create a folder with the Context_code name in <GG Home>/dirdat

   For example: If WAM2 is the context being created for the WAM source then create a folder with name "WAM2" within the <GG Home>/dirdat/ folder.

8. Create a folder with name in <GG Home>/diroby

9. Go to OGG_Home directory and go to the GoldenGate prompt:

   ggsci

10. Start the jAgent process using the following command:

    start jagent
Copying and Decompressing the Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.6.0 Multiplatform part (Oracle Utilities Analytics V2.6.0 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA|temp or /OUA|temp (Referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Multiplatform.zip to <TEMPDIR>.

Starting the Installer

Go to the temporary folder where you have downloaded the installer and run the following command from this folder:

```java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest```

Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7.

The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

If you select Oracle Data Integrator Based ETL as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository Details, Target GoldenGate Details and JAgent details.

If you select Dashboard as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details and OBIEE Home Details.

If you select both Oracle Data Integrator Based ETL and Dashboard as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository Details, Target GoldenGate Details, JAgent details and OBIEE Home Details.

Note: If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:spl|temp (in Windows). If the file exists, delete the file before invoking the installer.

Installation Steps

To install Oracle Data Integrator Based ETL, perform the following steps

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location here and click Next.

   Note: The specified Oracle home directory must be an empty directory.

3. The Select Installation Type page appears. In the Select Installation Type page, select ODI Based ETL and click Next.
Note: Based on the selected installation type, the options on the left navigation panel changes. When you select Oracle Data Integrator Based ETL as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository Details and Target GoldenGate Details.

4. The Database and Java Home Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>This is the JDK home location.</td>
<td>Provide location of JDK 1.7 Example: /u01/jdk_1.7.0_75</td>
</tr>
</tbody>
</table>

5. The Target Database Connection Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

6. The ODI Home and Schema Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>The directory where Oracle Data Integrator (ODI) has been installed.</td>
<td>Example: /u01/Middleware/Oracle_ODI1</td>
</tr>
<tr>
<td>Supervisor User</td>
<td>The name of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>The password of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR user password</td>
</tr>
</tbody>
</table>
7. The **ODI Agent and Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm the password of the Supervisor here.</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name.</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>The password of the master repository schema.</td>
<td></td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator master repository schema here.</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name.</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>The password of the work repository schema.</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator work repository schema here.</td>
<td></td>
</tr>
</tbody>
</table>

8. The **Target GoldenGate Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host of the Oracle GoldenGate Manager.</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /opt/local/gggs_12.1.2.1.0</td>
</tr>
</tbody>
</table>
9. The **Target JAgent Details** page appears. Enter the target server JAgent details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Database Home</td>
<td>This is the database home installed location on the target database server. In case GoldenGate for target is not installed on the Oracle Utilities Analytics database server, provide oracle client home location on the server on which GoldenGate is installed.</td>
<td>Example: <code>/u00/oracle/app/oracle/product/11.2.0/dbhome_1</code></td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the GoldenGate host.</td>
<td>The default value is 7830</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>This is the algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>This is the Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>This is shared secret key configured in Oracle GoldenGate on the target database server. Go to the Oracle GoldenGate prompt and run the command: <code>encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT</code> Provide the result of above command as the value.</td>
<td></td>
</tr>
</tbody>
</table>

9. The **Target JAgent Details** page appears. Enter the target server JAgent details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Host</td>
<td>The host of the Oracle GoldenGate JAgent.</td>
<td>Example: <code>/opt/local/ggs_12.1.2.1.0</code></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>This is the Oracle GoldenGate installed location where GoldenGate JAgent is running.</td>
<td>Example: <code>/opt/local/ggs_12.1.2.1.0</code></td>
</tr>
<tr>
<td>JAgent Port</td>
<td>Use the JAgent RMI port (5557) which is defined in the config properties file.</td>
<td></td>
</tr>
<tr>
<td>JAgent User</td>
<td>This is the OS user which is used to configure JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent Wallet Password</td>
<td>This is the JAgent Wallet password.</td>
<td></td>
</tr>
</tbody>
</table>
10. The **Installation Summary** page appears. Verify the installation options you selected.

11. Click **Install** to begin the installation.

   If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

12. The **Installation Progress** page appears which allows you to see the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The detailed logs of the installation are also available in the `logs/system` directory under the installation location.

   If you want to quit before the installation is completed, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

13. In the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

**Note:** To configure source, refer to the Chapter 5: Configuring Oracle Utilities Analytics in *Oracle Utilities Analytics Administration Guide*.

### Creating a Database Directory

Create a database directory 'B1_DATA_DUMP_DIR' on the target database as well as on each source database. This directory is used for logging the export import task used during the initial ELT load. The following is a sample SQL that creates the database directory pointing to the file system path `/scratch/file_data`:

```sql
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
```

### Configuring Oracle Data Integrator Repository Creation Utility (RCU)

Follow the steps below to configure the Oracle Data Integrator Repository Creation Utility:

1. Make sure RCU for ODI is run and the required schemas are created in the target database.
   
   ODI_ORACLE_HOME is an Oracle Home path which was used as Oracle Home while installing ODI Infrastructure installation and Oracle Data Integrator (ODI) installation.

2. Set or export JAVA_HOME variable to the 1.7.0_55+ installed directory.

3. Go to `$ODI_ORACLE_HOME/Oracle_Home/oracle_common/bin`

4. Execute the RCU utility.
   
   **Example:**
   ```
   export JAVA_HOME=/scratch/bi_oradata_01/jdk1.7.0_75
cd  /scratch/bi_oradata_01/Middleware_ODI_12.1.3_EE/Oracle_Home/oracle_common/bin
./rcu
   ```

5. In the Repository Creation Utility, select **Create Repository->System Load and Product Load** option.

6. In the second page, provide the database connection details.
7. In the **Select Components** page, the options should look like below. Unselect the Oracle Data Integrator component.

![Select Components Page](image)

8. In the next page, make a note of or remember the passwords given as they will be required when creating the Oracle Data Integrator domain. It is not required to create the Oracle Data Integrator domain at this stage. It should be done after running the Oracle Utilities Analytics installer and before running source configuration tool.

### Creating the WebLogic Domain for Oracle Data Integrator Agent

The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to complete the steps.

Perform the following steps to bring up the WebLogic ODI Agent:

1. Navigate to the Oracle Data Integrator (ODI) installed location `<MW_HOME>/oracle_common/common/bin`, run the below command and follow the steps to provide the masterschema and workschema provided in the configuration.

   **For Unix:**
   - Run `./config.sh`

   **For Windows:**
   - Run `config.cmd`

2. Create a new WebLogic domain.
   
   Choose option to create a new domain in Configuration Type screen and select correct Domain Location.

   Recommended domain location is `$ODI_ORACLE_HOME/Oracle_Home/user_projects/domains/odi_domain`

   Click **Next**.

3. On the Templates screen, make sure **Create Domain Using Product Templates** is selected, and then select the following templates:

   - Oracle Enterprise Manager Plugin for ODI - 12.1.3.0 [em]

   Selecting this template automatically selects the following as dependencies:
• Oracle Enterprise Manager - 12.1.3.0 [em]
• Oracle JRF - 12.1.3.0 [oracle_common]
• WebLogic Coherence Cluster Extension - 12.1.3.0 [wlserver]
• Oracle Data Integrator - Agent - 12.1.3.0 [odi]
  Selecting this template automatically selects the following as dependencies:
  • Oracle Data Integrator - Agent Libraries - 12.1.3.0 [odi]
  • Oracle Data Integrator SDK Shared Library Template - 12.1.3.0 [odi]
• Oracle Data Integrator - Console - 12.1.3.0 [odi]

Click **Next** to proceed.

4. On the **Application Location** page, you do not need to edit any values.
   Click **Next** to proceed.

5. Configure the **Administrator User Name** and **Password** for WebLogic.
   Provide the WebLogic password.
   Click **Next**.

6. On the Domain Mode and JDK page:
   • Select the **Production Mode** option.
   • Provide the **JDK 1.7.0_75+**

7. On the **Database Configuration Type** page, select RCU data option in auto configuration option.
   Enter `<prefix>_STB` schema details, database details and click 'Get RCU Configuration' button.
   Click **Next** to proceed.

   Select only the **ODI Master Schema** checkbox. Provide the following details:
   • DBMS/Service: Target Database Name
   • Host Name: Database Serverhost
   • Port: Database Port
   • Schema Owner: OUA_MASTER
   • Schema Password: OUA_MASTER Password
   Click **Next** to proceed.

9. Deselect the **ODI Master Schema** checkbox.

10. Select the **ODI Work Schema** checkbox. Provide the below details:
    • DBMS/Service: Target Database Name
    • Host Name: Database Serverhost
    • Port: Database Port
    • Schema Owner: OUA_WORK
    • Schema Password: OUA_WORK Password
    Click **Next** to proceed.

11. On the **JDBC Component Schema Test** page, test the JDBC Component Schema by selecting the **Select All** and clicking the **Test Selected Connections**.
Click **Next** to proceed.

12. On the **Credentials** page, specify SUPERVISOR username credentials, click on +ADD button to add odi_domain credentials. The screen capture is as following, ensure it is done correctly.

![Credentials screen capture]

13. On the **Advanced Configuration** page, select the following options:
   - Administration Server
   - Managed servers, Clusters and Coherence

   Click **Next** to proceed.

14. On the **Administration Server** page,
   - Provide the **Listening Port**, which is not in use.

   Click **Next** to proceed.

15. Configure the **Managed Servers** by providing the following:
   - **Server Name**: odi_server1
   - **Listen Address**: All Local Addresses
   - **Port**: Provide the port, which is provided in the step 7 in the section Installation Steps.)

16. Configure the **Cluster**.

   Click **Next**.

17. Configure the **Coherence Cluster**.

   Click **Next**.

18. Configure the **Machines**.

   Click **Next**.

19. On the **Configuration Summary** page, click **Create** to create the domain odi_domain.

20. Ensure configuration is successfully done.

21. Click **Next** to proceed.

22. After the domain is created, go to the domain location, create the `boot.properties` file for WebLogic login. Create the `<MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security` folder if not present.
23. Go to `<MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security`, then create `boot.properties` file with the below values:
   - username=weblogic
   - password=Weblogic password

24. Create the `<MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security` folder if not present.

25. Go to `<MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security`, and then create `boot.properties` file with the below values:
   - username=weblogic
   - password=Weblogic password

Starting the WebLogic Admin Server

Perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home - `<MW_HOME>/user_projects/domains/odi_domain/bin`.
2. Execute the `startweblogic` command for UNIX and Windows:
   
   For Unix:
   ```shell
   nohup ./startWebLogic.sh > startWebLogic.log &
   ```
   
   For Windows:
   ```bash
   startWebLogic.cmd
   ```

Starting the Managed Server

Starting Managed Server odi_server1

Perform the following steps:

1. To start managed server odi_server1, change the directory to the WLS Home:
   
   Execute the following commands:
   
   For Unix:
   ```bash
   <MW_HOME>/user_projects/domains/odi_domain/bin
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
   ```
   
   For Windows:
   ```bash
   StartManagedWeblogic.cmd odi_server1
   ```

2. From the Oracle Data Integrator Studio, navigate to Topology > Agents> OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of configured Oracle Data Integrator Java EE agent.
Installing Oracle Utilities Analytics Administration Component

Oracle Utilities Analytics Administration Tool is an Oracle Application Express (APEX) based configuration tool that can be used to configure Oracle Utilities Analytics. This section describes how to install the Administration Tool for Oracle Utilities Analytics configuration and change the default password of the Admin user, including:

- **Installation Steps**
- **Changing the Default Password of the Admin User**

**Note**: Install the Oracle Utilities Analytics Administration component on the Oracle Utilities Analytics database server.

### Installation Steps

**Note**: Verify that the prerequisite software products mentioned in the section Prerequisite Software for Oracle Utilities Analytics Administration Tool Component are installed.

Perform the following steps to install Oracle Utilities Analytics Administration Tool:

1. Download Apex 4.2.6 and copy to database server under the /temp directory. Unzip the file.
   
   ```
   cd /temp/apex
   ```

   Connect to the Oracle Utilities Analytics database with the sys user and execute the following command:
   
   a. `@apxremov.sql`
   b. `@apxrtins <Tablespace name> <Tablespace name> <Temp Tablespace name> /i/`
      
      For example, `@apxrtins CISTS_01 CISTS_01 TEMP /i/`
   c. `@apxchpwd.sql`
   d. `ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;`
   e. `ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;`
   f. `@apex_rest_config.sql`

   You must remember the password for these two users, APEX_Listener user and APEX_REST_PUBLIC_USER.

2. Import the Admin Tool for Oracle Data Integrator configuration:
   
   a. Unzip the **Oracle Utilities Analytics V2.6.0 Multiplatform.zip** file. This file has a folder called AdminTool.
   b. Create the ../AdminTool directory on the database server and copy the contents of the AdminTool directory (from the zip file) to this directory.
   c. Go to the ../AdminTool directory, i.e., `cd ../AdminTool`.
   d. Connect as the system user and execute the following scripts:
      
      - Create the workspace and configure the users:
        `@CreateAppWorkspace.sql`
      - Import application:
        `@DeployAdminApp.sql`
      - Deploy supporting objects:
        `@DeploySupportingObjects.sql`
3. Download Apex 4.2.6 and copy to the server where you want to set up the Administration Tool under /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory.

   **Note:** Create /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory if it does not exist.

4. Download Oracle Rest Data service and copy to the server where you want to set up the Administration Tool under /scratch/bi_oradata_01/Softwares/apex_listener directory.

   **Note:** Create /scratch/bi_oradata_01/Softwares/apex_listener directory if it does not exist.

5. Navigate to the scratch/bi_oradata_01/Softwares/apex_listener directory and unzip the file ords.3.0.0.121.10.23.zip.

   ```bash
   cd /scratch/bi_oradata_01/Softwares/apex_listener
   ```

6. Navigate to the cd /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory and unzip the file apex_4.2.6_en.zip.

   ```bash
   cd /scratch/bi_oradata_01/Softwares/apex_4.2.6
   ```

7. Create a directory on the server for the Apex configuration.

   For example, `mkdir /scratch/bi_oradata_01/apex_configuration`

8. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listener directory:

   ```bash
   cd /scratch/bi_oradata_01/Softwares/apex_listener
   ```

9. Execute the following command:

   ```bash
   java -jar ords.war install advanced
   ```

   **Note:** Use JDK1.7 or later to execute.

   You need to provide the required inputs as shown below:

   ```bash
   $ ORDS=1.11 java -jar ords.war install advanced
   This Oracle REST Data Services instance has not yet been configured.
   Please complete the following prompts
   Enter the location to store configuration data:/scratch/bi_oradata_01/apex_configuration
   Enter the name of the database server [localhost]:
   Enter the database listen port [1521]:
   Enter 1 to specify the database service name, or 2 to specify the database SID [1]:
   Enter the database service name:
   Enter 1 if you want to verify/install Oracle REST Data Services schema or 2 to skip this step [1]:
   Enter the database password for ORDS_PUBLIC_USER:
   Confirm password:
   Please login with SYSDBA privileges to verify Oracle REST Data Services schema. Installation may be required.
   Enter the username with SYSDBA privileges to verify the installation [SYS]:sys
   Enter the database password for sys:
   Confirm password:
   INFO: Oracle REST Data Services schema does not exist and will be created.
   Enter the default tablespace for ORDS_METAADATA [SYSTEM]:
   Enter the temporary tablespace for ORDS_METAADATA [TEMP]:
   Enter the default tablespace for ORDS_PUBLIC_USER [USERS]:
   Enter the temporary tablespace for ORDS_PUBLIC_USER [TEMP]:
   Enter 1 if you want to use PL/SQL Gateway or 2 to skip this step [1]:
   Enter the PL/SQL Gateway database user name [APEX_PUBLIC_USER]:
   Enter the database password for APEX_PUBLIC_USER:
   Confirm password:
   ```
10. Navigate to the `/scratch/bi_oradata_01/Softwares/apex_listener` directory:
   
   cd /scratch/bi_oradata_01/Softwares/apex_listener
   
   Execute the following command:
   
   java -jar ords.war static /scratch/bi_oradata_01/Softwares/apex_4.2.6/apex/images
   
   **Note:** It creates i.war file.

11. Install Weblogic 10.3.6 with jdk 1.7.0+

12. Create Weblogic domain.

   Navigate to the `<Middleware Home>/wlserver_10.3/commin/bin`
   cd `<Middleware Home>/wlserver_10.3/commin/bin`
   
   Execute the following:
   
   ./config.sh
   
   a. Click Next.
b. Provide the domain name and do not change the domain location. Click Next.

c. Provide **Weblogic User Password** and make sure to remember it.
d. Select jdk1.7 and click **Next**.

e. Select the **Administration Server, Managed Servers, Clusters and Machines** options as shown below:
f. Provide Listen Port as available port and remember this port number. Click **Next**:

![Configure the Administration Server](image)

---

<table>
<thead>
<tr>
<th>Name</th>
<th>Listen address</th>
<th>Listen port</th>
<th>SSL listen port</th>
<th>SSL enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>AdminServer</td>
<td>All Local Addresses</td>
<td>10001</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>

---

g. Click **Add** and provide values as shown below:

![Configure Managed Servers](image)
h. Click **Next**:

![Configure Clusters Window](image)

i. Click **Next**:

![Configure Machines Window](image)
j. Click **Next**.

13. Create the `boot.properties` file.
14. Start the Admin and Managed server.
15. Log into Weblogic console and click on **Lock & Edit**.

16. Click **Install**.
17. Provide Path as: `/scratch/bi_oradata_01/Softwares/apex_listener` and select the `ords.war` file.
18. Click **Next**.

19. Select the **Apex Server** option and click **Next**.
20. Select the options as shown below:

![Application Assistant Screen]

21. Select the options as shown below:

![Application Assistant Screen]

22. Click **Activate Changes**.

![View changes and restarts]

23. Repeat the steps from 13 to 20 to deploy **i.war** file.
24. Login to Weblogic console and click on **Deployment** > **Monitoring**. Select i and ords. And then, click on **Start** and select **Servicing All Requests** option.

25. Click **Yes**.

26. Restart the Admin and Managed servers.

27. Go to the following URL to access the Administration Tool:

   http://<hostname>:<managed server port no>/ords/?p=104

28. Credentials to access the Administration Tool:

   - User ID: Admin
   - Password: Admin_123
Changing the Default Password of the Admin User

The following APEX API can be used to change the password of the admin user. This script should be run after connecting to the database as user SYSTEM.

The string 'New password' should be replaced with the new password for the admin account before running the script.

```sql
begin
    wwv_flow_api.set_security_group_id(p_security_group_id=>nvl(wwv_flow_application_install.get_workspace_id,2090606133849294));
end;
/

begin
    apex_util.edit_user(
        p_user_id     => '2090514487849294',
        p_user_name => 'ADMIN',
        p_web_password => 'New password',
        p_new_password => 'New password'
    );
end;
/

commit;
/

Important Note: It is strongly recommended that you should change the default password after logging in.
Installing Oracle Utilities Analytics Dashboards Component

**Note:** Ensure that the same Operating System (OS) user is used to install the Oracle Utilities Analytics Dashboards component that is used to install all the prerequisite software.

**Note:** Verify that the prerequisite software products mentioned in the section Prerequisite Software for Oracle Utilities Analytics Dashboards Component are installed.

**Note:** Install the Oracle Utilities Analytics Dashboards component on the Oracle Utilities Analytics application server (refer to the section Deployment for the details on deploying Oracle Utilities Analytics).

This section describes how to install the dashboards component of Oracle Utilities Analytics. The section includes the following:

- Copying and Decompressing the Install Media
- Starting the Installer
- Installation Steps
- Deploying the Repository (RPD) File
- Deploying the Web Catalog
- Configuring and Deploying the MapViewer
- Post-deploying the Custom MapViewer
- Enabling WriteBack
- Deploying the Analytics EAR
- Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 11.1.1.9.1

### Copying and Decompressing the Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics Dashboards component v2.6.0 ([Oracle Utilities Analytics V2.6.0 Multiplatform.zip](https://edelivery.oracle.com)) from the Oracle Software Delivery Cloud.

2. Create a temporary directory, such as `c:\OUA\temp` or `/OUA/temp` (Referred to `<TEMPDIR>` below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip **Oracle Utilities Analytics V2.6.0 Multiplatform.zip** to `<TEMPDIR>`.

### Starting the Installer

Go to the temporary folder where you have downloaded the install and run the following command from this folder:

```
java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest
```

**Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7.

The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.
A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

**Note:** If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

### Installation Steps

To install the Dashboards, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The **Welcome** page appears. Review this information before you begin the installation and click **Next** to continue with the installation.

2. The **Installation Location** page appears. Define the **Installation Location** here and click **Next**.

   **Note:** The specified Oracle home directory must be an empty directory.

3. The **Select Installation Type** page appears. In the **Select Installation Type** page, select **Dashboards** and click **Next**.

   **Note:** Based on the selected installation type, the options on the left navigation panel changes. When you select **Dashboard** as an **Installation Type**, you need to define **Database and Java Home Details**, **Target Database Connection Details** and **OBIEE Home Details**.

4. The **Database and Java Home Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>This is the JDK home location.</td>
<td>Provide location of JDK 1.7 Example: /u01/jdk_1.6.0_75</td>
</tr>
</tbody>
</table>

5. The **Target Database Connection Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
</tbody>
</table>
6. The **OBIEE Home Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Home</td>
<td>The location on the disk where Oracle Business Intelligence Enterprise Edition software is installed.</td>
<td>Example: /u01/Middleware/Oracle_BI1</td>
</tr>
<tr>
<td>BI Instance Home</td>
<td>This is the instance home location under the location where Oracle Business Intelligence Enterprise Edition software is installed.</td>
<td>Example: /u01/Middleware/instances/instance1</td>
</tr>
<tr>
<td>BI Domain Home</td>
<td>This is the domain home location under the location where Oracle Business Intelligence Enterprise Edition software is installed.</td>
<td>Example: /u01/Middleware/user_projects/domains/bifoundation_domain</td>
</tr>
<tr>
<td>Weblogic Host</td>
<td>The hostname on which weblogic server for Oracle Business Intelligence Enterprise Edition is running.</td>
<td></td>
</tr>
<tr>
<td>Weblogic Port Number</td>
<td>A unique port number within the system that is assigned to the HTTP port. This is the port number that is used as a part of the client URL request to connect to the host. This is Oracle Business Intelligence Enterprise Edition WebLogic console admin port number.</td>
<td>Example: 7001</td>
</tr>
<tr>
<td>Weblogic User</td>
<td>WebLogic domain login user name.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** You will be prompted for the Weblogic user’s password after installation, when configuring Oracle Utilities Analytics.

7. The **Installation Summary** page appears. Verify the installation options here.

8. Click **Install** to begin the installation.

   If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

9. The **Installation Progress** page appears which allows you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal.
from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.

If you want to quit before the installation is completed, click Cancel. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click Cancel will remain on your system, and you will have to remove it manually.

10. In the Installation Completed page, click Finish to close the installer.

The Dashboards component is now installed.

### Deploying the Repository (RPD) File

If you have not made any changes to the deployed RPD, then take the RPD file from the following location: `<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd`, where `<install_dir>` is the Oracle Utilities Analytics Dashboard Component installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence Enterprise Edition 11.1.1.9.1 (Install Oracle Business Intelligence Enterprise Edition 11.1.1.9.0 and apply the patch 21235195) is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.9.1 should be installed on the Windows machine before proceeding with the below steps.

2. Launch the Administration Tool from the Start menu.
   
   Start > Programs > Oracle Business Intelligence > BI Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is “oracle123”.

![Oracle Business Intelligence 11.1.1.9.1](image)
5. Edit the **Connection Pools** shown below by double-clicking on them.

![Connection Pools Diagram]

6. In the **Init Block Connection Pool** group, enter the following:
   - Datasource name = BI Database name
   - User name = DWREAD
   - Password = DWREAD User password

7. In the **Init Block Pool - MDM** group, provide the following (only for Oracle Utilities Meter Data Management):
   - Datasource name = MDM database name
   - User name = CISUSER
   - Password = CISUSER User password

8. In the **Materialized Views Connection** group, enter the following:
   - Datasource name = BI Database name
   - User name = DWREAD
   - Password = DWREAD User password

9. In the **MDM Database Connection** group, provide the following (only for Oracle Utilities Meter Data Management):
   - Datasource name = MDM database name
   - User name = CISUSER
   - Password = CISUSER User password

10. In the **ODIDEV Connection Pool** group, provide the following:
    - Datasource name = BI database name
    - User name = DWUSER
    - Password = DWUSER User password

11. In the **OUBI Database Connection** group, provide the following:
    - Datasource name = BI database name
    - User name = DWREAD
12. Click **Save**.

   **Note:** Click **Yes** when you see the prompt *Do you wish to check global consistency?* and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to **BI Instance > Coreapplication > Deployment**.

15. Lock and edit.

   The repository text box will be enabled.

16. Browse to the modified rpd file and submit.

17. Provide the RPD password “oracle123”, and then click **Apply**.

18. Activate the changes and then restart Oracle Utilities Analytics services.

   **Note:** All the above-mentioned database sets of the connection pool should be updated in the *tnsnames.ora* file in `<OBIEE_INSTALL_DIR>/Oracle_BI1/network/admin`.

---

**Deploying the Web Catalog**

To deploy the web catalogs, follow these steps:

1. Go to the `<Catalog location>/root/shared` and delete the existing catalogs that were delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any catalog added by you can be retained. If Oracle Utilities Network Management System BI publisher reports were deployed, they should be retained.

2. Go to `<Catalog location>/root/system` and remove `spatialmetadata` directory and `spatialmetadata.atr` file.
Installing Oracle Utilities Analytics - Initial Installation

[347x29]Installing Oracle Utilities Analytics - Initial Installation
[558x29]3-41
[408x18]Oracle Utilities Analytics Installation Guide

Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment > Repository for viewing the catalog location. At the bottom, you will see the catalog location.

For UNIX:
1. Navigate to <Install_Dir>/bin directory.
   cd <Install_Dir>/bin.
2. Add Java 7 to the path variable as shown in example below:
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
3. Run ksh ./deploycatalog.sh.
4. Enter the physical catalogs location configured in the Enterprise Manager.
   Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment > Repository for viewing the catalog location. At the bottom, you will see the catalog location.

For Windows:
1. Navigate to <Install_Dir>/bin directory.
   cd <Install_Dir>\bin.
2. Add Java 7 to the path variable as shown in example below:
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
3. Run deploycatalog.cmd.
4. Enter the Physical Catalogs location configured in the Enterprise Manager.
   Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment > Repository for viewing the catalog location. At the bottom, you will see the catalog location.

Configuring and Deploying the MapViewer

Configuring and deploying the MapViewer involves the following:
• Configuring the MapViewer
• Modifying the instanceconfig.xml
• Deploying the Custom MapViewer

Configuring the MapViewer
To configure MapViewer, follow these steps:
1. Log into the WebLogic console.
2. In the WebLogic console, create the 'MAP_DS' datasource.
3. Lock and edit.
4. Navigate to Services > Data Sources.
5. Select New > Generic Data Source and provide the following:
   Name = MAP_DS
   JNDI Name = MAP_DS
   Database Type = oracle
6. Click Next.
7. Enter the following:
   Database Driver = *Oracle's Driver (Thin) for Service connections; Versions 9.0.1 and later
8. Click **Next**.
9. Do not change any values on the next page and click **Next**.
10. Enter the following connection properties:
    - Database Name: BI Database Name
    - Host Name: Database host
    - Port: Database port
    - Database User Name: dwadm
    - Password: dwadm password
11. Click **Next**.
12. On the next page, click **Test Configuration** button. After the successful test, click **Next** again.
13. The **Select Target** page opens. Now select AdminServer under **Servers** and bi_cluster under **Clusters**. Click **Finish**.
14. Click **Activate Changes**.
15. Update the mapViewerConfig file with the below-mentioned tags:
    - **File location**: `<Install Dir>`
      - `<user_projects\domains\bifoundation_domain\config\fmwconfig\mapviewer` File: mapViewerConfig.xml
16. If there is a proxy used, insert the list of host names for all the third-party service providers in the `security_config` node.
    - `<proxy_enabled_hosts>`
      - `elocation.oracle.com`
    - `</proxy_enabled_hosts>`
17. Add the following `ns_data_provider` node:
    - `<ns_data_provider id="obieeNsdp" class="com.oracle.utilities.birdseye.BirdseyeNSDP" />
18. Add the current `map_tile_server` with the following `map_tile_server` node:
    - `<map_tile_server>
      - `<tile_storage default_root_path="/mytilecache"/>
    - `</map_tile_server`

**Modifying the instanceconfig.xml**

Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

**For UNIX:**

```
<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1
```

**For Windows:**

```
<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesComponent\coreapplication_obips1
```
Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add the following code before </ServerInstance>:
   
   ```xml
   <Security>
   <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
   <HttpOnlyCookies>false</HttpOnlyCookies>
   <CookieDomain />
   <CookiePath>/</CookiePath>
   </Security>
   ```

2. Update the following <ServerInstance> element:
   
   ```xml
   <LightWriteback>true</LightWriteback>
   ```

3. Add the following before the end tag </ServerInstance>:
   
   ```xml
   <UI>
   <DefaultStyle>oubi</DefaultStyle>
   <DefaultSkin>blafp</DefaultSkin>
   </UI>
   ```

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags.
   
   ```xml
   <Prompts>
   <MaxDropDownValues>256</MaxDropDownValues>
   <AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
   <AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
   <AutoCompletePromptDropDowns>
   <SupportAutoComplete>true</SupportAutoComplete>
   <CaseInsensitive>true</CaseInsensitive>
   <MatchingLevel>MatchAll</MatchingLevel>
   <ResultsLimit>50</ResultsLimit>
   </AutoCompletePromptDropDowns>
   </Prompts>
   ```

**Deploying the Custom MapViewer**

*Note:* The custom MapViewer is required to integrate weather information into Outage Analytics.

To deploy the custom MapViewer, follow these steps:

**For UNIX:**

1. Navigate to <Install_Dir>/bin directory.
   
   ```bash
   cd <Install_Dir>/bin
   ```

2. Add Java 7 to the path variable as shown in example below:
   
   ```bash
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```

3. Run ksh ./deploymapviewer.sh.

4. Enter the WebLogic Domain Console Password. For example, weblogic123.

**For Windows:**

1. Navigate to <Install_Dir>/bin directory.
   
   ```cmd
   cd <Install_Dir>\bin
   ```

2. Add Java 7 to the path variable as shown in example below:
   
   ```cmd
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

3. Run deploymapviewer.cmd.

4. Enter WebLogic Domain Console password. For example, weblogic123.
Post-deploying the Custom MapViewer

Perform the following steps after deploying the custom MapViewer:


2. Update the MapViewer configuration by navigating to MapViewer > Administration > Configuration. Login to the Mapviewer at this location: http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the below content in the mapViewerConfig.xml with the appropriate values:

   <map_data_source name="MAPCONN"
   jdbc_host="<DB server name>"
   jdbc_sid="<DB Service name>"
   jdbc_port="1521"
   jdbc_user="DWADM"
   jdbc_password="<DWADM user password>"
   jdbc_mode="thin"
   number_of_mappers="32"
   allow_jdbc_theme_based_foi="true"
/>

   **Note**: The exclamatory mark in the front of the password ensures that the password is encrypted.

4. Click **Save**, and then restart.

   **Note**: The above step has to be performed each time after running the `deploymapviewer` command.

Enabling WriteBack

For enabling the Write Back, perform the following steps:

1. Log into Analytics and navigate to Administration>Manage Privileges>WriteBack>Write Back to Database.

2. Click **Denied:Authenticated User** and select the permission **Granted**.

Deploying the Analytics EAR

To deploy the Analytics' EAR, perform these steps:

1. Run the following commands:

   **For UNIX:**
   Perform the following steps:
   a. Navigate to `<Install_Dir>/bin` directory.
      ```
      cd <Install_Dir>/bin
      ```
   b. Add Java 7 to path variable as shown in the example below:
      ```
      export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
      ```
   c. Run `ksh ./deployanalyticsear.sh`.
   d. Enter the WebLogic Domain Console password. For example, weblogic123.

   **For Windows:**
   Perform the following steps:
   a. Navigate to `<Install_Dir>/bin` directory.
      ```
      cd <Install_Dir>/bin
      ```
b. Add Java 7 to the path variable as shown in example below:

```
set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
```
c. Run deployanalyticsear.cmd.
d. Enter the WebLogic Domain Console password. For example, weblogic123.
e. Restart the Oracle Utilities Analytics core services.
f. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business Intelligence Enterprise Edition deployment is completed.

---

### Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 11.1.1.9.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the following steps:

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server and opmn services.
   
   **Note:** Refer to Oracle Business Intelligence Enterprise Edition documentation for the detailed instructions on how to start, stop admin server, managed server and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).
3. Click on the **WebLogic User** (top-most-right section of the page).
4. From the drop-down menu, select **My Account**.
5. Set **Prompt Auto Complete** to **ON**, and click **OK**.
Chapter 4

Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1

This release of Oracle Utilities Analytics supports the following direct upgrade paths:

- Oracle Utilities Analytics version 2.5.1.2 or version 2.5.2.0.1 to version 2.6.0
- Oracle Utilities Analytics version 2.5.0.0.5 to version 2.6.0

**Important Note:** For upgrading from a version not supported by direct upgrade paths as mentioned above, the product must be first upgraded to Oracle Utilities Analytics version 2.5.1.2 or 2.5.2.0.1 or 2.5.0.0.5, and then upgraded to Oracle Utilities Analytics v2.6.0.

This chapter is applicable **only** to customers who are upgrading Oracle Utilities Analytics from version 2.5.1.2 or version 2.5.2.0.1 to version 2.6.0.

If you are upgrading from Oracle Utilities Analytics version 2.5.0.0.5, skip this chapter and proceed with the upgrade by following instructions in the chapter **Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5**.

This chapter consists of the following:

- Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or from Version 2.5.2.0.1 to Version 2.6.0
Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or from Version 2.5.2.0.1 to Version 2.6.0

**Note:** Make sure to install JDK1.7.0_75 and Oracle Data Integrator 12.1.3.0.0 (both Oracle Fusion Middleware Infrastructure and ODI) software on Oracle Utilities Analytics Application server. After the installation of Oracle Data Integrator 12.1.3, ensure you install ODI patch 19949726.

This section describes the procedure to upgrade to Oracle Utilities Analytics v2.6.0:

- **Prerequisites**
- **Upgrading Oracle Utilities Analytics Database Component**
- **Upgrading Oracle Utilities Analytics Based ELT Component**
- **Upgrading Oracle Utilities Analytics Administration Tool Component**
- **Upgrading Oracle Utilities Analytics Dashboards Components**

**Prerequisites**

The required prerequisites are based on the source applications you are using:

- **Oracle Data Integrator Based Source Applications**
  (Oracle Utilities Customer Care and Billing, Oracle Utilities Operational Device Management and Oracle Utilities Network Management System)
- **Oracle Warehouse Builder Based Source Applications**
  (Oracle Utilities Mobile Workforce Management and Oracle Utilities Meter Data Management)

1. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the b1_redef_replication in BI260/Scripts/b1_redef_replication.sql. This SQL creates the procedure to sync the DDL changes from source to Replication schemas.

   Example:
   ```sql
   SQL> @b1_redef_replication.sql
   /  
   Procedure created.
   SQL> show errors;
   No errors.
   SQL>
   ```

**Oracle Data Integrator Based Source Applications**

Ensure to copy jdk_1.7.0_75 and Oracle Data Integrator 12.1.3 (both Fusion Middleware infrastructure and ODI) software on the Oracle Utilities Analytics server.

Make sure that source applications are down and no one is accessing the source database. However, the source database must be up and running.

Perform the following steps as a part of prerequisites:

1. Login into Oracle Utilities Analytics Oracle Data Integrator server and start the ODI client

   ```bash
   cd $ODI_HOME
   cd $ODI_HOME/Oracle_ODI1/oracledi/client
   ./odi.sh
   ```
2. Stop BI_RUN_ALL by performing the steps mentioned below:

   Login to Oracle Database Integrator Studio. Double click on Global/WLS_AGENT and select the Inactive Radio button and save the changes.

3. Go to the Topology tab. Right-click on the OracleDIAgent and select the Upgrade Schedule option.

4. Check that all the jobs are completed by executing the following query after connecting the Oracle Utilities Analytics database. Note that this is applicable if the source system is Oracle Utilities Customer Care Billing / Oracle Utilities Operational Device Management, Oracle Utilities Network Management System.

   ```sql
   SELECT *
   FROM mdadm.b1_jobs_vw
   WHERE status_flg NOT IN ('D', 'E', 'RP');
   
   Note: No rows should be returned from the query mentioned above. If any rows are returned, that means jobs are not yet completed. Wait until all the jobs are completed.
   ```

5. Stop the Oracle Data Integrator admin and managed servers.

6. Sync all the Oracle GoldenGate processes.

   a. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below to get all the context codes.

   ```sql
   SELECT CONTEXT_CD
   FROM b1_prod_instance where CONTEXT_CD<>'B1';
   ```

   b. For each context returned by the query, perform the following steps.

      a. Connect to the source database corresponding to context code with sys user and execute the following command:

         ```sql
         alter system switch logfile
         select SEQUENCE# from v$Log where STATUS='CURRENT';
         ```

         b. Note down the result of the query mentioned above.
c. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below:

```
Select DB_HOST,GG_HOME from b1_gg_cfg where
GG_CFG_CD='<Context_code>' to get source GoldenGate server and Oracle GoldenGate home on source server.
```

d. Connect to the source GoldenGate server and log into the source Oracle GoldenGate prompt.

```
cd <GG_Home>
./ggsci
```

e. Execute the following command:

```
info extract <Context_codeXXX>,showch
```

For example, info extract CCB1AAX,showch

In the **Recovery Checkpoint** section, sequence should be equal or greater than one returned by “select SEQUENCE# from v$Log where STATUS='CURRENT’” query. For example:

![GGSCI (s1c03qmb) 2> info extract CCB1AAX,showch](image)

Repeat the check mentioned in the **step e** for each extract process.

f. Also make sure that the pump processes transfer all the changes to the target server. Lag at the **Chkpt** and **Time Since Chkpt** should look as below.

For example:

![GGSCI (s1c03qmb) 6> info all](image)

g. On the Oracle Utilities Analytics database server, make sure the replicate processes apply all changes for the context code.

- Connect to the MDADM schema of the Oracle Utilities Analytics database and execute below to get target server and GoldenGate Home details on the target server.

```
select DB_HOST,DB_SID,GG_HOST, GG_HOME from b1_gg_cfg
where GG_CFG_CD='B1';
```

- Connect to the target server and login to the GoldenGate prompt.

---

*Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1 4-4*

*Oracle Utilities Analytics Installation Guide*
Execute the following commands:

```
cd <GG_Home >
./ggsci
Dblogin userid MDADM,password <MDADM user password> Send replicat <Context_codeXX>,status
```

The current status will be at EOF as shown below.

```
GGSCI (slc07heq) 2> SEND REPLICAT CCB1AA ,status
Sending STATUS request to REPLICAT CCB1AA ...
Current status: At EOF
Sequence #: 11
RBA: 14889
0 records in current transaction
```

h. Check this for each replicat process for the context code.

i. Ensure all the extracts, replicates of all the sources are in sync.

**Upgrade all the source applications to be compatible with v2.6.0**

*Note:* Source applications databases must be in archive log mode during source applications upgrade. Oracle Golden Gate processes should be up and running on both source and target during the source applications upgrade.

After a successful source upgrade, do not release source applications for end users, also make sure source applications are stopped but source databases are up and accessible.

1. Login into the Oracle Utilities Analytics Golden gate server, go to goldengate home and execute shell script restart.sh from BI260/Scripts/restart.sh. This shell script would start the replicate processes which are stopped due to DDL changes in source system. Once all the DDL changes are synced to replication schema the shell script would be automatically terminated. Monitor restart.sh execution, move to next steps only when restart.sh execution is completed.

2. Validate that all columns are synced up.

3. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute below query. The below query should not return any records.

```
select TABLE_NAME,COLUMN_NAME
from DBA_TAB_COLUMNS@<CONTEXT_CODE>_LINK DTC
where OWNER = 'SOURCE_APPLICATION_SCHEMA'
and exists (select 1
from MDADM.B1_REPLICATION_CFG_VW a
where a.TABLE_NAME = DTC.TABLE_NAME
and CONTEXT_CD = '<CONTEXT_CODE>'
AND (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
MINUS
select TABLE_NAME,COLUMN_NAME
from DBA_TAB_COLUMNS
where OWNER = '<CONTEXTCODE>REP'
and COLUMN_NAME not like 'JRN%';
```

Example: The following is an example query for ODM1 context.

```
select TABLE_NAME,COLUMN_NAME
from DBA_TAB_COLUMNS@ODM1_LINK DTC
where OWNER = 'CISADM'
```
and exists (select 1
    from MDADM.B1_REPLICATION_CFG_VW a
    where a.TABLE_NAME = DTC.TABLE_NAME
    and CONTEXT_CD = 'ODM1'
    AND (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
MINUS
select TABLE_NAME, COLUMN_NAME
from DBA_TAB_COLUMNS
where OWNER = 'ODMIREP'
and COLUMN_NAME not like 'JRN%';

Perform the following steps to cleanup Oracle GoldenGate processes:

1. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below to get all the context codes.

2. Select CONTEXT_CD from the b1_prod_instance where CONTEXT_CD<>'B1';.

3. For each context returned by the query, perform the following steps:
   a. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below to get source GoldenGate db server, SID and Oracle GoldenGate host, home on source server:
      Select DB_HOST, DB_SID, GG_HOST, GG_HOME, GG_CFG_CD from b1_gg_cfg
      where GG_CFG_CD='<Context_code>'
   b. Connect to the source database corresponding to context code with sys user and execute the following command:
      alter system switch logfile
      select SEQUENCE# from v$Log where STATUS='CURRENT';
   c. Note down the result of the query mentioned above.
   d. Connect to the source GoldenGate server and log into the source Oracle GoldenGate prompt.
      cd <GG_Home>
      ./ggsci
   e. Execute the following command:
      info extract <Context_codeXXX>,showch
      For example, info extract CCB1AAX,showch
      In the Recovery Checkpoint section, sequence should be equal or greater than one returned by “select SEQUENCE# from v$Log where STATUS="CURRENT"” query.
      For example,

      ![GGSCI Image]

      Repeat the check mentioned in the step e for each extract process.
   f. Also make sure that the pump processes transfer all the changes to the target server. Lag at the Chkpt and Time Since Chkpt should look as shown below.
g. On the source database server, drop all the GoldenGate processes by following these steps:

Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the following query to get GoldenGate Owner name in the source database.

```
select SCHEMA_NAME
from MDADM.B1_CONTEXT_CFG_VW
where LSCHEMA_NAME = 'Journal'
and CONTEXT_CD = '<Context_code>';  
```

Login to source GoldenGate prompt.

```
login <GG_Home>
./ggsci
```

Execute the following commands:

```
sqlplus userid < GoldenGate Owner >,PASSWORD < GoldenGate Owner password>
stop <Context_code>*
```

For example:

```
stop CCB1*
```

```
delete <Context_code>*
```

For example:

```
delete CCB1*
```

```
stop mgr
```

**Note**: Please note down the source oracle GoldenGate extracts context_codes of each source and source GoldenGate Owner info, it is very important. We will configure the existing Sources with same context during the upgrade.

h. Connect to the sys user of the source database server and execute the following command:

```
<GG_Home>/ddl_disable.sql
```

i. Rename the existing source GG Home on the source server. Remember to note down the GoldenGate manager port number and source GoldenGate home before renaming it.

For example, mv <GG_Home> <GG_Home>.bkp

j. On the Oracle Utilities Analytics database server, make sure the replicate processes apply all changes for the context code.
• Connect to the MDADM schema of the Oracle Utilities Analytics database and execute below to get target server and GoldenGate Home details on the target server.

```
select DB_HOST, DB_SID, GG_HOST, GG_HOME from bl_gg_cfg where GG_CFG_CD='B1';
```

• Connect to the target server and login to the GoldenGate prompt. Execute the following commands:

```
   cd <GG_Home>
   ./ggsci
   Dblogin userid MDADM, password <MDADM user password>
   Send replicat <Context_codeXX>,status
```

The current status will be at EOF as shown below in the screenshot.

![Screenshot of GoldenGate status](image)

• Check this for each replicate process for the context code and ensure replicate processes completed writing all the changes.

• After checking the current status, each replicate process for the context code, execute the following commands:

```
   Stop <Context_code>*
   For example:
   stop CCB1* 
   Delete <Context_code>*
   For example:
   delete CCB1*
```

4. After all source applications changes have been synced in the Oracle Utilities Analytics database, execute the following command after connecting to the target GoldenGate Home prompt.

```
./ggsci
Stop mgr
```

5. Rename the existing target GoldenGate Home directory and remember to note down the **GoldenGate manager port number** and **target GoldenGate home** before renaming it.

6. Upgrade source application databases.

   **Note:**
   • If the source database version is prior to 11.2.0.4, then upgrade to 11.2.0.4 or a later version.
   • If the source database version is on 12c version, then 12.1.0.2 is mandatory.
7. Install new Oracle Data Integrator 12.1.3 (both infrastructure and ODI softwares) if not done already and apply ODI 19949726 patch on Oracle Data Integrator server. The patch on 12.1.3 is available on My Oracle Support (http://support.oracle.com).

Installing ODI 12.1.3.0.0 with Enterprise edition installation requires JDK1.7.0_75 and Oracle Fusion Middleware infrastructure 12.1.3 as prerequisite.

In summary, the ODI installation is as follows:

- Install JDK1.7.0_75
- Install Oracle Fusion Middleware Infrastructure 12.1.3
- Install ODI 12.1.3
- Apply ODI patch 19949726

**Notes About Installing Oracle Fusion Middleware Infrastructure**

Note the Oracle Home path that is provided in the Installation location screen, the Oracle Home path will be required when installing the ODI software.

Infrastructure installation type is ‘Fusion Middleware Infrastructure’

During the ODI 12.1.3 installation, provide the same ‘Oracle Home’ path which was used as Oracle Home while installing Oracle Fusion Middleware Infrastructure installation. Select ‘Enterprise Installation’ in the installation type page.

**Oracle Warehouse Builder Based Source Applications**

If you have Oracle Warehouse Builder based source application (Oracle Utilities Mobile Workforce Management and Oracle Utilities Meter Data Management), bring them down to make sure no one is accessing the application(s).

You must upgrade Oracle Warehouse Builder based source applications to a version, which support Oracle Utilities Analytics v2.6.0. And, you must upgrade the source database to v12.1.0.2.

Here are the steps to be followed:

1. Generate final extract from the source application and upload to the warehouse.
2. Complete all the source side configurations.
   
   For more information on the Source Side Configuration details, refer to the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.
3. Install Oracle GoldenGate on the source GoldenGate server. Make sure that the database location is as per requirement at the time of GoldenGate installation.
   
   Ensure that you remember the GoldenGate Home and GoldenGate Manager Process Port Number.
4. Go to the GoldenGate home location and execute the following command:
   
   cd <GG_Home>
   mkdir diroby
5. Keep the source database is in the archivelog mode.
6. Connect to the source database with sys user and execute the following command.
   
   alter database add supplemental log data (primary key) columns
7. Set `enable_goldengate_replication` parameter in database to true.
8. Create the new tablespace in the source database.
9. Create a database user in the source database, which will be the GoldenGate Owner in the source database and assign the created tablespace as a default tablespace to this user.

10. Connect to the source database with sys user and execute the following commands:

    Note: Make sure to change GoldenGate owner placeholder with actual name of database user as created in previous step.

```
grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
grant unlimited tablespace to <GoldenGate owner> with admin option;
EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>', 'capture');
grant unlimited tablespace to <GoldenGate Owner> with admin option;
Revoke dba from <GoldenGate Owner>;
grant create any view to <GoldenGate Owner>;
grant select any dictionary to <GoldenGate Owner>;
GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;
```

If the source application Oracle Utilities Meter Data Management, then execute the query mentioned below:

```
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
```

11. Execute Oracle GoldenGate scripts.

```
   cd <GG_Home>
   ./ggsci
   create subdirs
```

12. Connect to sys user and execute the following commands.

```
   cd <GG_Home>
   @marker_setup.sql
   @ddl_setup.sql
   @role_setup.sql
   grant GGS_GGSUSER_ROLE to <GoldenGate owner>;
```
Upgrading Oracle Utilities Analytics Database Component

Upgrade the Oracle Utilities Analytics database to 12.1.0.2.0 version, ignore if the Oracle Utilities Analytics database is already on 12.1.0.2.0 version.

Upgrade the Oracle Utilities Analytics Database component on the Oracle Utilities Analytics database server.

Install 12.1.2.1.0 version of Oracle GoldenGate on the Oracle Utilities Analytics database server and start the manager process. Note down the golden gate home and manager port number.

This section describes how to upgrade the database component of Oracle Utilities Analytics v2.6.0. It includes the following topics:

• Copying and Decompressing the Install Media
• Creating the Users and the Tablespaces
• Installing the RELADM Schema
• Installing the MDADM Schema
• Installing the DWADM Schema

Copying and Decompressing the Install Media

To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics version 2.6.0 Oracle Database part (Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp for a Windows machine or /OUA/temp for a Linux machine. This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.

Creating the Users and the Tablespaces

1. Make sure to create users in the database with the following names without giving specific roles if these do not exist already:
   DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

   Note: Though users can be created using any tablespace name, the same names need to be configured in a metadata table. Configure the tablespace names in Oracle Utilities Analytics Administration Tool > Storage Configuration page. See the Oracle Utilities Analytics Administration Tool chapter in the Oracle Utilities Analytics Administration Guide for more details.

2. Connect to the sys user and revoke the DBA privilege from the following users if the DBA privilege has been granted to them:
   DWADM, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

3. Make sure to create roles with the following names if these do not exist already:
   DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE.

4. Connect to the sys user, execute the Usersgrants.sql in /Scripts/Usersgrants.sql. This SQL provides the required grants to the created users.
Installing the RELADM Schema

The RELADM schema is a metadata schema that consists of the database objects used for storing the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

- Reviewing the Storage.xml file
- Installation Steps
- Generating the Database Statistics

Reviewing the Storage.xml file

The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI260/RELADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

**Note:** If database does not have CISTS_01 tablespace or the RELADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

Installation Steps

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In **Windows** environment:

1. Add Java 7 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI260\RELADM\Jarfiles/*
   ```
3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.
4. Execute OraDBI.jar as shown below:
   ```
<ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,,RELADM –j
<JDK Home> –f <TEMPDIR>\BI260\RELADM\Jarfiles –v 1 –e true
   ```

In **Unix** environment:

1. Add Java 7 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI260/RELADM/Jarfiles/*
   ```
4. Execute OraDBI.jar as shown below:
Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1


The utility creates the RELADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating the Database Statistics
During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command:

execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing the MDADM Schema
The MDADM schema is a metadata schema that consists of the database objects used for storing the metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including:

- Reviewing the Storage.xml File
- Installation Steps
- Generating the Database Statistics

Reviewing the Storage.xml File
The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI260/MDADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

Note: If the database does not have CISTS_01 tablespace or the MDADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which MDADM has quota.

Installation Steps
Perform the following steps to install the MDADM schema:

The process prompts you for password of MDADM user. Ensure to run the ORADBI.jar (in the step below) using Java Development Kit Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows environment
1. Add Java 7 to the path variable as shown in the example below:
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   set CLASSPATH=<TEMPDIR>\BI260\MDADM\Jarfiles\
3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.
4. Execute OraDBI.jar as shown below:

   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,,MDADM -j
   <JDK Home> -f <TEMPDIR>\BI260\MDADM\Jarfiles -v 1 -e true
   ```

   In Unix environment:

   1. Add Java 7 to the path variable as shown in example below:
      ```
      export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
      ```

   2. Set classpath pointing to OraDBI.jar and all dependency jars.
      ```
      export CLASSPATH=<TEMPDIR>/BI260/MDADM/Jarfiles/*
      ```

   3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.

   4. Execute OraDBI.jar as shown below:
      ```
      java com.oracle.ouaf.oem.install.OraDBI -d
      jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
      <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,,MDADM -j
      <JDK Home> -f <TEMPDIR>/BI260/MDADM/Jarfiles -v 1 -e true
      ```

   The utility creates the MDADM schema and system data definitions.

   If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating the Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command:

   ```
   execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
   ```

**Installing the DWADM Schema**

The DWADM schema contains the star schema objects such as facts and dimensions that contain all the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

- Reviewing the Storage.xml File
- Installation Steps
- Generating the Database Statistics

**Reviewing the Storage.xml File**

The `storage.xml` file (that comes with the product and is in location `<TEMPDIR>/BI260/DWADM/Install-Upgrade`) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the `storage.xml` file by changing the tablespace name from the default value to a custom value.

If database does not have CISTS_01 tablespace or the DWADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which DWADM has quota.
Installation Steps

Perform the following steps to install the DWADM schema:

The process prompts you for password of DWADM user. Ensure to run the OraDBI.jar (in the step below) using Java Development Kit Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows environment:

1. Add Java 7 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI260\DWADM\Jarfiles\*
   ```
3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.
4. Execute OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI –d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM –j
   <JDK Home> -f <TEMPDIR>\BI260\DWADM\Jarfiles –v 1 -e true
   ```

In Unix environment:

1. Add Java 7 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI260/DWADM/Jarfiles/*
   ```
3. Navigate to the <TEMPDIR>\BI260\RELADM\Install-Upgrade folder.
4. Execute OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI –d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM –j
   <JDK Home> -f <TEMPDIR>/BI260/DWADM/Jarfiles –v 1 -e true
   ```

The utility creates the DWADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating the Database Statistics

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

Post-Installation Steps

1. Connect to the DWADM schema of the Oracle Utilities Analytics database and execute the following:
   ```
   ...\BI260\DWADM\Post-Upgrade\ControlZoneUpdate.sql
   ```
2. Connect to the Oracle Utilities Analytics database with the system user and execute the script mentioned below:

```
.../BI260\DWADM\Post-Upgrade\DataCorrection2511.sql
```

### Upgrading Oracle Utilities Analytics Based ELT Component

**Note:** Upgrade the Oracle Utilities Analytics Based ELT component on the Oracle Utilities Analytics application server.

This section describes how to upgrade the ELT component of Oracle Utilities Analytics v2.6.0. It includes the following topics:

- Prerequisites Before Running the OUI Installer
- Configuring Oracle Data Integrator Repository Creation Utility (RCU)
- Setting up Oracle GoldenGate
- Copying and Decompressing the Install Media
- Starting the Installer
- Upgrade Steps
- Configuring Source Applications

#### Prerequisites Before Running the OUI Installer

Perform these steps before running the OUI installer:

1. Connect to the MDADM schema and execute "select max(global_cfg_id) from b1_global_cfg;" to get the maximum value
2. Advance the B1_GLOBAL_CFG_SEQ sequence in the MDADM schema to value returned by the previous query.

#### Configuring Oracle Data Integrator Repository Creation Utility (RCU)

Follow the steps below to configure the Oracle Data Integrator Repository Creation Utility:

1. Make sure RCU for ODI is run and the required schemas are created in the target database.
   
   ODI_ORACLE_HOME is an Oracle Home path which was used as Oracle Home while installing ODI Infrastructure installation and Oracle Data Integrator (ODI) installation.

2. Set or export JAVA_HOME variable to the 1.7.0_55+ installed directory.

3. Go to `$ODI_ORACLE_HOME/Oracle_Home/oracle_common/bin`

4. Execute the RCU utility.
   
   **Example:**
   ```
   export JAVA_HOME=/scratch/bi_oradata_01/jdk1.7.0_75
cd /scratch/bi_oradata_01/Middleware_ODI_12.1.3_EE/Oracle_Home/oracle_common/bin
./rcu
   ```

5. In the Repository Creation Utility, select **Create Repository->System Load and Product Load** option.

6. In the second page, provide the database connection details.

7. In the **Select Components** page, the options should look like below. Unselect the Oracle Data Integrator component.
8. In the next page, make a note of or remember the passwords given as they will be required when creating the Oracle Data Integrator domain.

It is not required to create the Oracle Data Integrator domain at this stage. It should be done after running the Oracle Utilities Analytics installer and before running source configuration tool.

**Setting up Oracle GoldenGate**

*Note:* This section describes setup required in Oracle GoldenGate to work with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its installation document.

Download Oracle GoldenGate 12.1.2.1.0 from the Oracle Software Delivery Cloud (https://edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers.

This section describes the following:

- Setting up Oracle GoldenGate on the Source Database Server
- Setting up Oracle GoldenGate on the Target Database Server
- Setting up Oracle GoldenGate JAgent on Target and Source Database Servers

### Setting up Oracle GoldenGate on the Source Database Server

Perform the following steps for each source instance:

1. Create a directory on the source database server. For example, `~/GoldenGate Home`. Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home (OGG_Home)** on the source database server.

   *Important Note:* Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a command terminal/window, and set the source `ORACLE_SID` and `ORACLE_HOME` variables.

   Set `LD_LIBRARY_PATH` using the following commands:

   ```bash
   export LD_LIBRARY_PATH=/path/to/oracle/goldengate/lib:
   ```
For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%

4. In the Command window, change directory to the Oracle GoldenGate home directory, and execute the command:

For Unix:

./ggsci

For Windows:

ggsci

This opens the Oracle GoldenGate prompt.

5. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

6. On the Oracle GoldenGate prompt, execute the start mgr command to start the Oracle GoldenGate manager process.

7. On the Oracle GoldenGate prompt, execute the info all command to view the manager process is running. Exit Oracle GoldenGate by executing the Exit command.

8. Ensure that the source database is in the archivelog mode.

9. Connect to the source database as the sys user and execute the below statements:

```sql
alter database add supplemental log data (primary key) columns;
alter system set enable_goldengate_replication=TRUE scope=both;
```

10. Go to the Oracle GoldenGate home (OGG_Home) directory.

11. Connect to the database as the sys user using the SQL*Plus (OGG_Home should be the current directory while invoking SQL*Plus).

12. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and make sure to assign a tablespace to this user that is not assigned to any other user.

   **Important Note:** Make a note of the GoldenGate Owner Username; it will be used during Oracle Utilities Analytics installation.

13. Connect to the source database with sys user and execute the following commands:

   **Note:** Make sure to change GoldenGate owner placeholder with actual name of database user as created in previous step.

   ```sql
   grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
   grant unlimited tablespace to <GoldenGate owner> with admin option;
   EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>','capture');
   grant unlimited tablespace to <GoldenGate Owner> with admin option;
   Revoke dba from <GoldenGate Owner>;
   grant create any view to <GoldenGate Owner>;
   grant select any dictionary to <GoldenGate Owner>;
   GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
   GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;
   ```
14. Connect to the source application ADM schema such as CISADM, and execute the below commands:

**For Oracle Utilities Customer Care and Billing source database, execute the following grants:**

Grant select on F1_MST_CONFIG to "GoldenGate owner user created in the step mentioned above"

Grant select on F1_EXT_LOOKUP_VAL to "GoldenGate owner user created in the step mentioned above"

Grant select on F1_BKT_CONFIG to "GoldenGate owner user created in the step mentioned above"

Grant select on F1_BKT_CONFIG_VAL to "GoldenGate owner user created in the step mentioned above"

**For Oracle Utilities Operational Device Management source database, execute the following grants:**

Grant select on F1_MST_CONFIG to "GoldenGate owner user created in the step mentioned above"

Grant select on F1_EXT_LOOKUP_VAL to "GoldenGate owner user created in the step mentioned above"

**For Oracle Utilities Meter Data Management source database, execute the following grants:**

Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>

Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>

**For Oracle Utilities Work and Asset Management source database, execute the following grants:**

Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>

Grant select on <application ADM Schema>. F1_MST_CONFIG to <GoldenGate Owner>

Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>

Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>

**Note:** While executing the SQL commands in the steps 15, 16 and 17 provide the GoldenGate owner user if prompted for. All the scripts mentioned below are located in **GoldenGate Home** directory and must be executed after connecting to the sys user.

15. Run the command:
   `@marker_setup.sql`

16. Run the command:
    `@ddl_setup.sql`

17. Run the command:
    `@role_setup.sql`

18. Exit the SQL*Plus login and create a directory named **diroby** inside **OGG_HOME** directory.

19. Change directory to the Oracle GoldenGate home directory, and execute the following steps:
Note: The following prerequisite steps are to be executed before running the OUA installer. Refer to the Oracle GoldenGate Administering Oracle GoldenGate Guide for more info.

Configuration for Encrypting Data with the ENCKEYS Method

a. Execute the following command:
   cd <OGG_HOME>
   KEYSGEN key_length n

   The above command generates the key value based on the value specified in the parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

c. Repeat the step above for each key values generated.

d. Save the file with name ENCKEYS (Upper case only) without any extension.

Example:

   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035DD6893205A7BD6773FA8E670

e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

f. Input the Logical name, space and key value generated.

   Example contents of file ENCKEYS:
   CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

   Note: It is recommended to name Logical key name after <context_code>KEY. For example: if context code is CCB1, it is recommended to name CCB1KEY.

Generating the Shared Secret Password

a. Execute the following command:

   cd <OGG_HOME>
   ggsci
   ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY

   Example:

   cd $OGG_HOME
   ./ggsci
   GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY
   CCB1KEY
   Encrypted password:
   AADAAAAAAAAAAIAVGNHBFLGFCHBCTCVBFJHUEJGNCFAOAFE0FBALELISFOEIFWGRBZHCC MCYGYBDASH
   Algorithm used: AES128

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm name used and the generated Encrypted password.
Setting up Oracle GoldenGate on the Target Database Server

Perform the following steps:

1. Create a directory on the target database server. For example, `../GoldenGateHome`. Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home (OGG_Home)** on the target Oracle Utilities Analytics database server.

   *Important Note:* Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a **Command** window and set the target `ORACLE_SID` and `ORACLE_HOME` variables.

   Set `LD_LIBRARY_PATH` using the following commands:

   **For Unix:**
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   **For Windows:**
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
   ```

4. In the **Command** window, change the directory to the **GoldenGate home directory** and execute the command:

   **For Unix:**
   ```
   ./ggsci
   ```

   **For Windows:**
   ```
   ggsci
   ```

   This opens the Oracle GoldenGate prompt.

5. On the **Oracle GoldenGate** prompt, execute the **create SUBDIRS** command.

6. On the **Oracle GoldenGate** prompt, execute the **start mgr** command to start the Oracle GoldenGate manager process.

7. On the **Oracle GoldenGate** prompt, execute the **info all** command to view the manager process is running.

8. Exit Oracle GoldenGate by executing **exit** command and create a directory named **diroby** inside the **OGG_Home** directory.

9. Connect to the target database as the sys user and execute below statement:

   ```
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. Go to **OGG_Home** directory.

11. If **ENCKEYS** file does not exist, open a new ASCII **ENCKEYS** file and add those key value/values generated on the sources to **ENCKEYS** file in target OGG home for the context codes for which source configuration is being done.

    **Example contents of ENCKEYS file in target OGG home:**

    ```
    CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
    ```
Setting up Oracle GoldenGate JAgent on Target and Source Database Servers

GoldenGate JAgent setup should be done on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers.

Follow these steps to setup GoldenGate on target and source servers:

After the Oracle GoldenGate software is installed and the Manager is running, follow the below steps to configure the JAGENT.

1. Start the rmiregistry services and note down the port on which RMI server is started. Use the following command:

   ```bash
   rmiregistry 5559 &
   ```

   Here, we have specified port number as 5559. If the port number is not specified, default port 1099 is used.

2. Edit the Config.properties file in the `<GG home>/cfg` and add/modify the below parameters.

   ```ini
   <ACTUAL>   : jagent.host=localhost
   <CHANGE TO> : jagent.host=<actual hostname on which OGG is installed>
   <ACTUAL>    : monitor.jmx.username=cmroot
   <CHANGE TO> : monitor.jmx.username=jmx_src
   <ACTUAL>   : jagent.username=root
   <CHANGE TO> : jagent.username=<OGG software installed OS user>>
   <ACTUAL>    : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started
   <ACTUAL>    : agent.type.enabled=OGGMON
   <CHANGE TO> : agent.type.enabled=OEM
   ```

3. Add the following parameter:

   ```ini
   jagent.ssl=false
   ```

4. Edit the GLOBALS file in the `<GG home>` and add the below command.

   ```ini
   EnableMonitoring
   ```

5. Execute the below command from `<GG Home>`

   For Unix:
   ```bash
   ./pw_agent_util.sh -jagentonly
   ```

   For Windows:
   ```bash
   pw_agent_util.bat -jagentonly
   ```

6. Enter the Oracle wallet password. This password has to be entered as the password for the JAGENT while running the installer (for target gg) and while running source configuration (for source gg). Please make a note of the password.

7. Create a folder with the Context_code name in `<GG Home>/dirdat`

   For example: If WAM2 is the context being created for the WAM source then create a folder with name "WAM2" within the `<GG Home>/dirdat/` folder.

8. Create a folder with name in `<GG Home>/diroby`

9. Go to OGG_Home directory and go to the GoldenGate prompt:

   ```bash
   ggsci
   ```

10. Start the jAgent process using the following command:

    ```bash
    start jagent
    ```
Copying and Decompressing the Install Media
To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.6.0 Multiplatform part (Oracle Utilities Analytics V2.6.0 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Multiplatform.zip to <TEMPDIR>.

Starting the Installer
1. Go to the temporary folder where you have downloaded the installer and run the following command from this folder:

        java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest

    Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7

2. Set or export JAVA_HOME variable:

        java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest

3. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

    Note: If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:\spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

Upgrade Steps
To install Oracle Data Integrator Based ETL, perform the following steps

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location and click Next.

3. The Select Installation Type page appears. In the Select Installation Type page, select ODI Based ETL and click Next.

    Note: Based on the selected installation type, the options on the left navigation panel changes. When you select Oracle Data Integrator Based ETL as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository Details and Target GoldenGate Details.

4. The Database and Java Home Details page appears. Enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
</tbody>
</table>
5. The **Target Database Connection Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

6. The **ODI Home and Schema Details** page. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>The directory where Oracle Data Integrator (ODI) has been installed.</td>
<td>Example: /u01/Middleware/Oracle_ODI1</td>
</tr>
<tr>
<td>Supervisor User</td>
<td>The name of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR</td>
</tr>
<tr>
<td>Supervisor Password</td>
<td>The password of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm the password of the Supervisor here.</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name.</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>The password of the master repository schema.</td>
<td>OUA_MASTER user's password</td>
</tr>
</tbody>
</table>
7. The **ODI Agent and Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator master repository schema here.</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name.</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>The password of the work repository schema.</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator work repository schema here.</td>
<td></td>
</tr>
</tbody>
</table>

8. The **Target GoldenGate Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host on the Oracle GoldenGate Manager.</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /opt/local/ggs_12.1.2.1.0</td>
</tr>
<tr>
<td>Target Database Home</td>
<td>This is the database home installed location on the target database server. In case GoldenGate for target is not installed on the OUA database server, provide oracle client home location on the server on which GoldenGate is installed.</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the GoldenGate host.</td>
<td>The default value is 7830</td>
</tr>
</tbody>
</table>
9. The **Target JAgent Details** page appears. Enter the following details in the respective fields and click **Next**

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Algorithm</td>
<td>This is the algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>This is the Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>This is shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: <code>encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT</code> Provide the result of above command as the value.</td>
</tr>
</tbody>
</table>

10. The **Installation Summary** page appears. Verify the installation options you selected.

11. Click **Install** to begin the installation.

    If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

12. The **Installation Progress** page appears which allows you to see the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The Detailed logs of the installation are also available in the logs/system directory under the installation location.

    If you want to quit before the installation is completed, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.
13. In the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

**Creating the WebLogic Domain for Oracle Data Integrator Agent**

The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to complete the steps.

Perform the following steps to bring up the WebLogic ODI Agent:

1. Navigate to the Oracle Data Integrator (ODI) installed location `<MW_HOME>/oracle_common/common/bin`, run the below command and follow the steps to provide the masterschema and workschema provided in the configuration.

   **For Unix:**
   - Run `./config.sh`

   **For Windows:**
   - Run `config.cmd`

2. Create a new WebLogic domain.

   Choose option to create a new domain in Configuration Type screen and select correct Domain Location.

   Recommended domain location is `$ODI_ORACLE_HOME/Oracle_Home/user_projects/domains/odi_domain`

   Click **Next**.

3. On the Templates screen, make sure **Create Domain Using Product Templates** is selected, and then select the following templates:

   - Oracle Enterprise Manager Plugin for ODI - 12.1.3.0 [em]
     Selecting this template automatically selects the following as dependencies:
     - Oracle Enterprise Manager - 12.1.3.0 [em]
     - Oracle JRF - 12.1.3.0 [oracle_common]
     - WebLogic Coherence Cluster Extension - 12.1.3.0 [wlserver]
     - Oracle Data Integrator - Agent - 12.1.3.0 [odi]
     Selecting this template automatically selects the following as dependencies:
     - Oracle Data Integrator - Agent Libraries - 12.1.3.0 [odi]
     - Oracle Data Integrator SDK Shared Library Template - 12.1.3.0 [odi]
     - Oracle Data Integrator - Console - 12.1.3.0 [odi]

   Click **Next** to proceed.

4. On the **Application Location** page, you do not need to edit any values.

   Click **Next** to proceed.

5. Configure the **Administrator User Name** and **Password** for WebLogic.

   Provide the WebLogic password.

   Click **Next**.

6. On the Domain Mode and JDK page:

   - Select the **Production Mode** option.
   - Provide the **JDK 1.7.0_75+**
7. On the **Database Configuration Type** page, select RCU data option in auto configuration option.

Enter <prefix>_STB schema details, database details and click ‘Get RCU Configuration’ button.

Click Next to proceed.


Select only the **ODI Master Schema** checkbox. Provide the following details:

- DBMS/Service: Target Database Name
- Host Name: Database Serverhost
- Port: Database Port
- Schema Owner: OUA_MASTER
- Schema Password: OUA_MASTER Password

9. Deselect the **ODI Master Schema** checkbox.

10. Select the **ODI Work Schema** checkbox. Provide the below details:

- DBMS/Service: Target Database Name
- Host Name: Database Serverhost
- Port: Database Port
- Schema Owner: OUA_WORK
- Schema Password: OUA_WORK Password

Click Next to proceed.

11. On the **JDBC Component Schema Test** page, test the JDBC Component Schema by selecting the **Select All** and clicking the **Test Selected Connections**.

Click Next to proceed.

12. On the **Credentials** page, specify SUPERVISOR username credentials, click on +ADD button to add odi_domain credentials. The screen capture is as following, ensure it is done correctly.

13. On the **Advanced Configuration** page, select the following options:
• Administration Server
• Managed servers, Clusters and Coherence

Click Next to proceed.

14. On the Administration Server page,
• Provide the Listening Port, which is not in use.

Click Next to proceed.

15. Configure the Managed Servers by providing the following:
• Server Name: odi_server1
• Listen Address: All Local Addresses
• Port: Provide the port, which is provided in the step 8 in the section Installation Steps.

16. Configure the Cluster.

Click Next.

17. Configure the Coherence Cluster.

Click Next.

18. Configure the Machines.

Click Next.

19. On the Configuration Summary page, click Create to create the domain odi_domain.

20. Ensure configuration is successfully done.

21. Click Next to proceed.

22. After the domain is created, go to the domain location, create the boot.properties file for WebLogic login. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security folder if not present.

23. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security, then create boot.properties file with the below values:

• username=weblogic
• password=Weblogic password

24. Create the <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security folder if not present.

25. Go to <MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security, and then create boot.properties file with the below values:

• username=weblogic
• password=Weblogic password

Starting the WebLogic Admin Server

Perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home -
   <MW_HOME>/user_projects/domains/odi_domain/bin.

2. Execute the startweblogic command for UNIX and Windows:

   For Unix:
   nohup ./startWebLogic.sh > startWebLogic.log &

   For Windows:
Starting the Managed Server

Starting Managed Server odi_server1
Perform the following steps:

1. To start managed server odi_server1, change the directory to the WLS Home:
   Execute the following commands:

   For Unix:
   
   `<MW_HOME>/user_projects/domains/odi_domain/bin
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &`

   For Windows:
   
   `StartManagedWeblogic.cmd odi_server1`

2. From the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of configured Oracle Data Integrator Java EE agent.

Executing Post-Upgrade Script
Perform the following steps to execute the post-upgrade script:

1. Execute B1_MDFIX_ODM_260 in global context.
2. Login to ODI Client and go to Designer Tab.
3. Navigate to Load Plans and Scenario Folders.
5. Right click B1_MDFIX_ODM_260, click Run and select the context as Global and click OK.

Creating a Database Directory
Create a database directory 'B1_DATA_DUMP_DIR' on the target database as well as on each source database. This directory is used for logging the export import task used during the initial ELT load. The following is a sample SQL that creates the database directory pointing to the file system path /scratch/file_data:

   `CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';`

Configuring Source Applications
To configure source applications such as Oracle Utilities Meter Data Management, Oracle Utilities Mobile Workforce Management, Oracle Utilities Network Management System, which were earlier configured with Oracle Warehouse Builder, refer to section Configuring Source in the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

For the other source applications, such as Oracle Utilities Customer Care Billing, Oracle Utilities Operational Device Management, which were earlier configured with Oracle Data Integrator, perform the following steps mentioned in the below sections:

- Prerequisites
- Configuration Steps

Prerequisites
Make sure oracle data integrator (ODI) domain is created and Admin and managed servers are running before running the source configuration tool.

Configuration Steps

To configure the source applications, perform the following steps:

1. Perform the steps for registering a source as described in the Registering a Source section in the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

2. Please use the same context_codes to configure the existing Sources during the upgrade.

3. After config.sh GUI utility execution, execute B1_SYNC_CONTEXT.
   a. To execute B1_SYNC_CONTEXT package, login to Oracle Data Integrator Studio.
   b. Go to Designer.
   c. Navigate to Load Plans and Scenarios> Framework.
   d. Right-click on B1_SYNC_CONTEXT and select Run option.

4. Select the context related to the source application, <no agent> as logical agent, and then click OK.

5. Start all the OGG processes on source and target:
   a. Login into each source application Golden Gate server.
   b. Go to respective Oracle Golden gate Home directory.
   c. Start manager, JAgent and all the respective context extract processes.
   d. Login into Target Oracle Utilities Analytics (OUA) Golden Gate server.
   e. Go to Oracle Golden gate Home directory.
   f. Start manager, jagent and all the respective context extract processes.
6. Start the source application server:
   a. Login into each source application
   b. Start the application and ensure application is up and accessible.
Upgrading Oracle Utilities Analytics Administration Tool Component

Oracle Utilities Analytics Admin Tool is an Oracle Application Express (APEX) based configuration tool that can be used to configure Oracle Utilities Analytics. This section describes how to install the Admin Tool for the Oracle Data Integrator (ODI) configuration and change the default password of the Admin user, including:

1. Download the patch 19595896 from My Oracle Support and copy to database server under the /temp directory.
   Unzip the file as shown below:

   ![Unzip command example]

   ```
   cd /temp
   Connect to the OUA database with the sys user and execute the following command
   a. EXEC DBMS_XDB.SETHTTPPORT(0);
   b. SELECT DBMS_XDB.GETHTTPPORT FROM DUAL;
   c. ALTER USER APEX_PUBLIC_USER ACCOUNT UNLOCK;
   d. ALTER USER APEX_PUBLIC_USER IDENTIFIED BY APEX_PUBLIC_USER;
   e. @apxpatch.sql
   f. @apxldimg.sql /temp/patch
   g. @apex_rest_config.sql
   You must remember the password for these two users, APEX_Listern user and APEX_REST_PUBLIC_USER
   
   ![Rest Configuration script example]

   ```

2. Download Apex 4.2.6 and copy to the server where you want to set up the admin tool under /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory.

3. Download Oracle Rest Data service and copy to the server where you want to set up the admin tool under /scratch/bi_oradata_01/Softwares/apex_listener directory.

4. Navigate to the scratch/bi_oradata_01/Softwares/apex_listener directory and unzip the file ords.3.0.0.121.10.23.zip.
cd /scratch/bi_oradata_01/Softwares/apex_listner

5. Navigate to the cd /scratch/bi_oradata_01/Softwares/apex_4.2.6 directory and unzip the file apex_4.2.6_en.zip.

   cd /scratch/bi_oradata_01/Softwares/apex_4.2.6

6. Create a directory on the server for the Apex configuration.
   For example, mkdir/scratch/bi_oradata_01/apex_configuration

7. Navigate to the /scratch/bi_oradata_01/Softwares/apex_listener directory:

   cd /scratch/bi_oradata_01/Softwares/apex_listener

8. Execute the following command:

   java -jar ords.war install advanced

   **Note:** Use JDK1.7 or later to execute.

   **Note:** You need to provide the required inputs as shown below:
9. Navigate to the `/scratch/bi_oradata_01/Softwares/apex_listener` directory:
   
   cd /scratch/bi_oradata_01/Softwares/apex_listener

   Execute the following command:

   java -jar ords.war static /scratch/bi_oradata_01/Softwares/apex_4.2.6/apex/images

   **Note:** It creates i.war file.

10. Install Weblogic 10.3.6 with jdk 1.7.0+.

11. Create Weblogic domain.

   Navigate to the `<Middleware Home>\wlserver_10.3\comm\bin`
   cd `<Middleware Home>\wlserver_10.3\comm\bin`

   Execute the following:
   
   ./config.sh

   a. Click Next.
b. Provide the domain name and do not change the domain location. Click **Next**.

c. Provide **Weblogic User Password** and make sure to remember it.
d. Select jdk1.7 and click Next.

e. Select the Administration Server and Managed Servers, Clusters and Machines options as shown below:
f. Provide listen port as available port and remember these port numbers. Click Next:

![Configure the Administration Server](image)

f. Provide listen port as available port and remember these port numbers. Click Next:

![Configure Managed Servers](image)

g. Click Add and provide values as shown below:

![Configure Managed Servers](image)
h. Click Next

i. Click Next.
j. **Click Next.**

12. **Create the** `boot.properties` **file.**

13. **Start the** Admin and Managed server.

14. **Log into** Weblogic console and click on **Lock & Edit.**

15. **Click on** Install.

16. **Provide Path as:** `/scratch/bi_oradata_01/Softwares/apex_listener` and select the `ords.war` file
17. Click **Next**

18. Select the **Apex Server** option and click **Next**.

19. Select the options as shown below:
20. Select the options as shown below:

![Screen capture of Install Application Assistant](image1.png)

21. Click **Activate Changes**.

![Screen capture of View changes and restarts](image2.png)

22. Repeat the steps from 13 to 20 to deploy i.war file.
23. Login to Weblogic console and click on Deployment > Monitoring. Select i and ords. And then click on Start and select Servicing All Requests option.

24. Click Yes.

25. Restart the Admin and Managed servers.

26. Go to the following URL to access the Admin tool:
   
   http://<hostname>:<managed server port no>/ords/?p=104

27. Credentials to access the Admin tool:
   
   User ID: Admin
   Password: Admin_123

Changing the Default Password of the Admin User

The following APEX API can be used to change the password of the admin user. This script should be run after connecting to the database as user SYSTEM.

The string 'New password' should be replaced with the new password for the admin account before running the script.

```
begin
```
Important Note: It is strongly recommended that you should change the default password after logging in.
Upgrading Oracle Utilities Analytics Dashboards Components

Note: Upgrade the Oracle Utilities Analytics Dashboards component on the Oracle Utilities Analytics application server.

This section describes how to install the dashboards component of Oracle Utilities Analytics. The section includes the following:

- Prerequisites to Upgrading the Dashboard Component
- Copying and Decompressing the Install Media
- Starting the Installer
- Upgrade Steps
- Deploying the Repository (RPD) File
- Deploying the Web Catalog
- Configuring and Deploying the MapViewer
- Post-deploying the Custom MapViewer
- Enabling WriteBack
- Deploying the Analytics EAR
- Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 11.1.1.9.1

Prerequisites to Upgrading the Dashboard Component

Oracle Utilities Analytics Dashboard component v2.6.0 requires Oracle Business Intelligence Enterprise Edition version 11.1.1.9.0.

Oracle Business Intelligence Enterprise Edition 11.1.1.x.x should be upgraded to 11.1.1.9.0 before proceeding with Oracle Utilities Analytics Dashboard component upgrade. Refer to Oracle Business Intelligence Enterprise Edition documentation for the details of upgrading from 11.1.1.x.x to 11.1.1.9.0.

Patch 21235195 has to be applied after existing Oracle Business Intelligence Enterprise Edition is upgraded to 11.1.1.9.0 version.

Oracle Business Intelligence Enterprise Edition upgrade from 11.1.1.x.x to 11.1.1.9.0 involves the following steps:

1. Stop OBIEE admin, managed, node managers and opmn services.
2. Take the back up of OBIEE middleware home
3. Upgrade Oracle Weblogic Server to 10.3.6 in OBIEE middleware home. Download patch 13529623 to upgrade Oracle Weblogic to 10.3.6. It is not required to upgrade JDK.
4. Download the OBIEE 11.1.1.9 installer.
5. Run the OBIEE 11.1.19 installer with Software install option. This will upgrade JDK to 1.7.0_80 level.
6. Run psa.sh from ../Oracle_BI/bin to upgrade OBIEE repository schema to 11.1.1.9.
   
   SELECT OWNER, VERSION, STATUS, UPGRADED FROM SCHEMA_VERSION_REGISTRY;
7. Start the admin and node managers
8. Login to Weblogic console and click on release configuration if button is enabled
9. Run config.sh from Oracle_BI/bin directory
10. Login to OBIEE analytics and go to the Administration page and run "Scan and Update Catalog Objects That Require Updates".

11. Follow the Upgrade Guide present here for more information [http://docs.oracle.com/middleware/11119/core/FUGBI/bi_plan.htm#FUGBI522](http://docs.oracle.com/middleware/11119/core/FUGBI/bi_plan.htm#FUGBI522)

12. For Patch 21235195, please see the article at [https://support.oracle.com/cpmos/faces/ui/patch/PatchDetail.jspx?parent=DOCUMENT&sourceId=1488475.1&patchId=21235195](https://support.oracle.com/cpmos/faces/ui/patch/PatchDetail.jspx?parent=DOCUMENT&sourceId=1488475.1&patchId=21235195) and the Patch Readme file.

**Copying and Decompressing the Install Media**

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics Dashboards component v2.6.0 ([Oracle Utilities Analytics V2.6.0 Multiplatform.zip](https://edelivery.oracle.com)) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip [Oracle Utilities Analytics V2.6.0 Multiplatform.zip](https://edelivery.oracle.com) to <TEMPDIR>.

**Starting the Installer**

Go to the temporary folder where you have downloaded the install and run the following command from this folder:

```
java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest
```

**Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7.

The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

**Note:** If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:\spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

**Upgrade Steps**

To install the Dashboards, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location here and click Next.

3. The Select Installation Type page appears. In the Select Installation Type page, select Dashboards and click Next.
4. The **Database and Java Home Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>This is the JDK home location.</td>
<td>Provide location of JDK 1.7 (1.7.0_75+)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.7.0_75</td>
</tr>
</tbody>
</table>

5. The **Target Database Connection Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM)</td>
<td>here.</td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

6. The **OBIEE Home Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Home</td>
<td>The location on the disk where Oracle Business Intelligence Enterprise Edition software is installed.</td>
<td>Example: /u01/Middleware/Oracle_BI1</td>
</tr>
<tr>
<td>BI Instance Home</td>
<td>This is the instance home location under the location where Oracle Business Intelligence Enterprise Edition software is installed.</td>
<td>Example: /u01/Middleware/instances/instance1</td>
</tr>
</tbody>
</table>
Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1

4-48

Oracle Utilities Analytics Installation Guide

Note: You will be prompted for the Weblogic user's password after installation, when configuring Oracle Utilities Analytics.

7. The Installation Summary page appears. Verify the installation options here.

8. Click Install to begin the installation.

   If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

9. The Installation Progress page appears which allows you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.

   If you want to quit before the installation is completed, click Cancel. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click Cancel will remain on your system, and you will have to remove it manually.

10. In the Installation Completed page, click Finish to close the installer.

   The Dashboards component is now installed.

Deploying the Repository (RPD) File

If you have not made any changes to the deployed RPD, then take the RPD file from the following location: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd, where <install_dir> is the Oracle Utilities Analytics Dashboard Component installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the Windows machine on which Oracle Business Intelligence Enterprise Edition 11.1.1.9.1 is installed or on your local machine where the Oracle Business Intelligence Developer Client Tool (11.1.1.9.0) is installed.

Follow these steps to deploy the RPD file:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>BI Domain Home</td>
<td>This is the domain home location under the location where Oracle Business</td>
<td>Example: /u01/Middleware/user_projects/domains/bifoundation_domain</td>
</tr>
<tr>
<td></td>
<td>Intelligence Enterprise Edition software is installed.</td>
<td></td>
</tr>
<tr>
<td>Weblogic Host</td>
<td>The hostname on which weblogic server for Oracle Business Intelligence</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Enterprise Edition is running.</td>
<td></td>
</tr>
<tr>
<td>Weblogic Port Number</td>
<td>A unique port number within the system that is assigned to the HTTP port.</td>
<td>Example: 7001</td>
</tr>
<tr>
<td></td>
<td>This is the port number that is used as a part of the client URL request</td>
<td></td>
</tr>
<tr>
<td></td>
<td>to connect to the host. This is Oracle Business Intelligence Enterprise</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Edition WebLogic console admin port number.</td>
<td></td>
</tr>
<tr>
<td>Weblogic User</td>
<td>WebLogic domain login user name.</td>
<td></td>
</tr>
</tbody>
</table>
1. Oracle Business Intelligence Enterprise Edition 11.1.1.9.1 should be installed on the Windows machine or Oracle Business Intelligence Developer Client Tool (11.1.1.9.0) should be installed on your local machine before proceeding with the below steps.

2. On the Windows machine, launch the Administration Tool from the Start menu.
   Start > Programs > Oracle Business Intelligence > BI Administration.
   Or on your local machine, launch the Administration Tool from Start menu
   Start > Programs > Oracle Business Intelligence Enterprise Edition Plus Client > Administration

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. The default password is "oracle123".

5. Edit the Connection Pools shown below by double-clicking on them.

6. In the Init Block Connection Pool group, enter the following:
   - Datasource name = BI Database name
   - User name = DWREAD
   - Password = DWREAD User password
7. In the **Init Block Pool - MDM** group, provide the following (only for MDM):
   - Datasource name = MDM database name
   - User name = CISUSER
   - Password = CISUSER User password

8. In the **Materialized Views Connection** group, enter the following:
   - Datasource name = BI Database name
   - User name = DWREAD
   - Password = DWREAD User password

9. In the **MDM Database Connection** group, provide the following (only for MDM):
   - Datasource name = MDM database name
   - User name = CISUSER
   - Password = CISUSER User password

10. In the **ODIDEV Connection Pool** group, provide the following:
    - Datasource name = BI database name
    - User name = DWUSER
    - Password = DWUSER User password

11. In the **OUBI Database Connection** group, provide the following:
    - Datasource name = BI database name
    - User name = DWREAD
    - Password = DWREAD User password
12. Click **Save**.

   **Note:** Click **Yes** when you see the prompt 'Do you wish to check global consistency?' and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to **BI Instance > Coreapplication > Deployment**.

15. Lock and edit. The repository text box will be enabled.

16. Browse to the modified rpd file and submit.

17. Provide the RPD password “oracle123”, and then click **Apply**.

18. Activate the changes and then restart Oracle Utilities Analytics services.

   **Note:** All the above-mentioned database sets of the connection pool should be updated in the `tnsnames.ora` file in `<OBIEE_INSTALL_DIR>/Oracle_BI1/network/admin`.

---

### Deploying the Web Catalog

To deploy the web catalogs, follow these steps:

1. Go to the `<Catalog location>/root/shared` and delete the existing catalogs that were delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any catalog added by you can be retained. If Oracle Utilities Network Management System BI publisher reports were deployed, they should be retained.

2. Go to `<Catalog location>/root/system` and remove `spatialmetadata` directory and `spatialmetadata.atr` file.

   **Note:** Login to the Enterprise Manager, navigate to **Coreapplication > Deployment >Repository** for viewing the catalog location. At the bottom, you will see the catalog location.

For Unix:

1. Navigate to `<Install_Dir>/bin` directory.

   ```bash
   cd <Install_Dir>/bin.
   ```

2. Add Java 7 to the path variable as shown in example below:

   ```bash
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```

3. Run `ksh ./deploycatalog.sh`.

4. Enter the physical catalogs location configured in the Enterprise Manager.

   **Note:** Login to the Enterprise Manager, navigate to **Coreapplication > Deployment >Repository** for viewing the catalog location. At the bottom, you will see the catalog location.

For Windows:

1. Navigate to `<Install_Dir>/bin` directory.

   ```bash
   cd <Install_Dir>in.
   ```

2. Add Java 7 to the path variable as shown in example below:

   ```bash
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

3. Run `deploycatalog.cmd`.

4. Enter the Physical Catalogs location configured in the Enterprise Manager.

   **Note:** Login to the Enterprise Manager, navigate to **Coreapplication > Deployment >Repository** for viewing the catalog location. At the bottom, you will see the catalog location.
Configuring and Deploying the MapViewer

Configuring and deploying the MapViewer involves the following:

- Configuring the MapViewer
- Modifying the instanceconfig.xml
- Deploying the Custom MapViewer

Configuring the MapViewer

To configure Mapviewer, follow these steps:

1. Log into the WebLogic console.
2. In the WebLogic console, create the 'MAP_DS' datasource.
3. Lock and edit.
4. Navigate to Services > Data Sources.
5. Select New > Generic Data Source and provide the following:
   - Name = MAP_DS
   - JNDI Name = MAP_DS
   - Database Type = oracle
6. Click Next.
7. Enter the following:
   - Database Driver = *Oracle’s Driver (Thin) for Service connections; Versions 9.0.1 and later
8. Click Next.
9. Do not change any values on the next page and click Next.
10. Enter the following connection properties:
    - Database Name: BI Database Name
    - Host Name: Database host
    - Port: Database port
    - Database User Name: dwadm
    - Password: dwadm password
11. Click Next.
12. On the next page, click Test Configuration button. After the successful test, click Next again.
14. Click Activate Changes.
15. Update the mapViewerConfig file with the below-mentioned tags:
    - File location: <Install Dir>\user_projects\domains\bifoundation_domain\config\fmwconfig\mapviewer
    - File: mapViewerConfig.xml
16. If there is a proxy used, insert the list of host names for all the third-party service providers in the security_config node.
    - <proxy_enabled_hosts>
    - elocation.oracle.com
    - </proxy_enabled_hosts>
17. Add the following ns_data_provider node:

```xml
<ns_data_provider id="obieeNsdp"
    class="com.oracle.utilities.birdseye.BirdseyeNSDP" />
```

18. Add the current map_tile_server with the following map_tile_server node:

```xml
<map_tile_server>
    <tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>
```

### Modifying the instanceconfig.xml

Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

For UNIX:

```bash
<OBIEE_INSTALL_DIR>/instances/instance1/config/OracleBIPresentationServicesComponent/coreapplication_obips1
```

For Windows:

```bash
<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesComponent\coreapplication_obips1
```

Perform the following changes to the instanceconfig.xml file:

1. Update the security node with the following values. If the security node is not present, add the following code before </Serverinstance>:

```xml
<Security>
    <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
    <HttpOnlyCookies>false</HttpOnlyCookies>
    <CookieDomain/>
    <CookiePath></CookiePath>
</Security>
```

2. Update the following `<ServerInstance>` element:

```xml
<LightWriteback>true</LightWriteback>
```

3. Add the following before the end tag </ServerInstance>:

```xml
<UI>
    <DefaultStyle>oubi</DefaultStyle>
    <DefaultSkin>blafp</DefaultSkin>
</UI>
```

4. Add the following lines in between the `<ServerInstance>` </ServerInstance> tags.

```xml
<Prompts>
    <MaxDropDownValues>256</MaxDropDownValues>
    <AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
    <AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
    <AutoCompletePromptDrop Downs>
        <SupportAutoComplete>true</SupportAutoComplete>
        <CaseInsensitive>true</CaseInsensitive>
        <MatchingLevel>MatchAll</MatchingLevel>
        <ResultsLimit>50</ResultsLimit>
    </AutoCompletePromptDrop Downs>
</Prompts>
```
Deploying the Custom MapViewer

*Note:* The custom MapViewer is required to integrate weather information into Outage Analytics.

To deploy the custom MapViewer, follow these steps:

For Unix:
1. Navigate to `<Install_Dir>/bin` directory.
   ```
   cd <Install_Dir>/bin
   ```
2. Add Java 7 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```
3. Run `ksh ./deploymapviewer.sh`.
4. Enter the WebLogic Domain Console Password. For example, weblogic123.

For Windows:
1. Navigate to `<Install_Dir>/bin` directory.
   ```
   cd <Install_Dir>\bin
   ```
2. Add Java 7 to the path variable as shown in example below:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```
3. Run `deplomapviewer.cmd`.
4. Enter WebLogic Domain Console password. For example, weblogic123.

Post-deploying the Custom MapViewer

Perform the following steps after deploying the custom MapViewer:

2. Update the MapViewer configuration by navigating to MapViewer > Administration > Configuration. Login to the Mapviewer at this location: `http://<HOST>:<MANAGERPORT>/mapviewer`
3. Add the below content in the mapViewerConfig.xml with the appropriate values:
   ```
   <map_data_source name="MAPCONN"
   jdbc_host="<DB server name>"
   jdbc_sid="<DB Service name>"
   jdbc_port="1521"
   jdbc_user="DWADM"
   jdbc_password="!<DWADM user password>"
   jdbc_mode="thin"
   number_of_mappers="32"
   allow_jdbc_theme_based_foi="true"
   />
   ```

   *Note:* The exclamatory mark in the front of the password ensures that the password is encrypted.
4. Click *Save*, and then restart.

   *Note:* The above step has to be performed each time after running the `deplomapviewer` command.

Enabling WriteBack

For enabling the Write Back, perform the following steps:

1. Log into Analytics and navigate to Administration>Manage Privileges>WriteBack>Write Back to Database.
2. Click Denied:Authenticated User and select the permission Granted.
Deploying the Analytics EAR

To deploy the Analytics EAR, perform these steps:

1. Run the following commands:

   For UNIX:
   Perform the following steps:
   a. Navigate to `<Install_Dir>/bin` directory.
      
      \[ cd <Install_Dir>/bin \]
   b. Add Java 7 to path variable as shown in the example below:
      
      \[ export \text{PATH}=/\text{scratch}/\text{softwares}/\text{jdk1.7.0}_71/bin:\$\text{PATH} \]
   c. Run \text{ksh} ./deployanalyticsear.sh.
   d. Enter the WebLogic Domain Console password. For example, weblogic123.

   For Windows:
   Perform the following steps:
   a. Navigate to `<Install_Dir>/bin` directory.
      
      \[ cd <Install_Dir>/bin \]
   b. Add Java 7 to the path variable as shown in example below:
      
      \[ \text{set PATH=} C:\Java\jdk1.7.0_79\bin;%PATH% \]
   c. Run deployanalyticsear.cmd.
   d. Enter the WebLogic Domain Console password. For example, weblogic123.
   e. Restart the Oracle Utilities Analytics core services.

   Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business Intelligence Enterprise Edition deployment is completed.

Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 11.1.1.9.1

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the following steps:

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server and ojdbc60 services.

   Note: Refer to Oracle Business Intelligence Enterprise Edition documentation for the detailed instructions on how to start, stop admin server, managed server and ojdbc60 services.

2. Login to analytics (http://<Server>:<port>/analytics).
3. Click on the WebLogic User (top-most-right section of the page).
4. From the drop-down menu, select My Account.
5. Set Prompt Auto Complete to ON, and click OK.
This release of Oracle Utilities Analytics version 2.6.0 supports the following direct upgrade paths:

- Oracle Utilities Analytics version 2.5.1.2 or version 2.5.2.0.1 to version 2.6.0
- Oracle Utilities Analytics version 2.5.0.0.5 to version 2.6.0

**Important Note:** For upgrading from a version not supported by direct upgrade paths as mentioned above, the product must be first upgraded to Oracle Utilities Analytics version 2.5.1.2 or 2.5.2.0.1 or 2.5.0.0.5, and then upgraded to Oracle Utilities Analytics v2.6.0.

This chapter is applicable only to customers who are upgrading Oracle Utilities Analytics from version **2.5.0.0.5** to version 2.6.0.

If you are upgrading from Oracle Utilities Analytics version **2.5.1.2 or 2.5.2.0.1** to **2.6.0**, skip this chapter and follow instructions in the chapter *Upgrading Oracle Utilities Analytics from Version 2.5.1.2 or Version 2.5.2.0.1*.

This chapter consists of the following:

- Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5 to Version 2.6.0
Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5 to Version 2.6.0

Make sure to install JDK1.7.0_75 and Oracle Data Integrator 12.1.3.0.0 (both Oracle Fusion Middleware Infrastructure and ODI) softwares on the Oracle Utilities Analytics Application server. After the installation of Oracle Data Integrator 12.1.3, ensure you install ODI patch 19949726.

To upgrade to Oracle Utilities Analytics v2.6.0, users must first upgrade to Oracle Utilities Analytics v2.5.0.0.5, if users are on an earlier version of the product.

This section describes the procedure to upgrade to Oracle Utilities Analytics v2.6.0:

- Prerequisites
- Upgrading Oracle Data Integrator Based Oracle Utilities Analytics
- Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics
- Upgrading Oracle Utilities Analytics Administration Tool Component
- Upgrading Oracle Utilities Analytics Dashboards Components

Prerequisites

The required prerequisites are based on the source applications you are using and are described in the following sections:

- Upgrading Oracle Data Integrator Based Oracle Utilities Analytics
  (Oracle Utilities Customer Care and Billing and Oracle Utilities Operational Device Management)
- Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics
  (Oracle Utilities Mobile Workforce Management and Oracle Utilities Meter Data Management and Oracle Utilities Network Management System)

Upgrading Oracle Data Integrator Based Oracle Utilities Analytics

This section explains the steps to upgrade Oracle Data Integrator based source applications. This section consists of the following:

- Prerequisites
- Upgrading Oracle Utilities Analytics Database Component
- Upgrading Oracle Utilities Analytics Based ELT Component
- Upgrading Source Applications to be Compatible With v2.6.0

Prerequisites

Make sure to copy jdk_1.7.0_75 on Oracle Data Integrator server and Oracle Data Integrator 12.1.3 (both infrastructure and ODI) softwares on the Oracle Data Integrator server.

Make sure the target OBIEE applications are down.

Perform the following steps as a part of prerequisites:

1. Login into Oracle Utilities Analytics Oracle Data Integrator server and start the ODI client.
   ```bash
   cd $ODI_HOME
   cd $ODI_HOME/Oracle_ODI1/oracledi/client
   ./odi.sh
   ```

2. Stop BI_RUN_ALL by performing the steps mentioned below:
Login to Oracle Database Integrator Studio. Double click on Global/WLS_AGENT and select the Inactive Radio button and save the changes.

3. Go to the Topology tab. Right-click on the OracleDIAgent and select the Upgrade Schedule option.

4. Check that all the jobs are completed by executing the following query after connecting the Oracle Utilities Analytics database. Note that this is applicable if the source system is Oracle Utilities Customer Care Billing or Oracle Utilities Operational Device Management.

```
SELECT *
FROM mdadm.bl_jobs_vw
WHERE status_flg NOT IN ('D', 'E', 'RP');
```

**Note:** No rows should be returned from the query mentioned above. If any rows are returned, that means jobs are not yet completed. Wait until all the jobs are completed.

5. Stop the Oracle Data Integrator admin and managed servers.

6. Stop source application servers.

   Make sure source applications are stopped but source databases are up and accessible.

7. Sync all the Oracle GoldenGate processes.
   a. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below to get all the context codes.
   b. Select CONTEXT_CD from the b1_prod_instance where CONTEXT_CD<>'B1';

   For each context returned by the query, perform the following steps.

   **Note:** Do not delete the extract, replicate golden gate processes. We will configure the existing sources with same context during the upgrade.
   a. Connect to the source database corresponding to context code with sys user and execute the following command:

```
alter system switch logfile
```
select SEQUENCE# from v$Log where STATUS='CURRENT';

b. Note down the result of the query mentioned above.

c. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below:

```
Select DB_HOST, GG_HOME from b1_gg_cfg where GG_CFG_CD='<Context_code>' to get source GoldenGate server and Oracle GoldenGate home on source server.
```

d. Connect to the source GoldenGate server and log into the source Oracle GoldenGate prompt.

cd <GG_Home>
./ggsci

e. Execute the following command:

```
info extract <Context_codeXXX>,showch
```
For example, info extract CCB1AAX,showch

In the **Recovery Checkpoint** section, sequence should be equal or greater than one returned by “select SEQUENCE# from v$Log where STATUS='CURRENT'” query.

For example:

```
GGSCI (slc03qm6) 2> info extract CCB1AAX,showch
```

Repeat the check mentioned in the step e for each extract process.

f. Also make sure that the pump processes transfer all the changes to the target server.

Lag at the **Chkpt** and **Time Since Chkpt** should look as below.

For example:

```
GGSCI (slc03qm6) 6> info all
```

<table>
<thead>
<tr>
<th>Program</th>
<th>Status</th>
<th>Group</th>
<th>Lag at Chkpt</th>
<th>Time Since Chkpt</th>
</tr>
</thead>
<tbody>
<tr>
<td>MANAGER</td>
<td>RUNNING</td>
<td>CCB1AAP</td>
<td>00:00:00</td>
<td>00:00:01</td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1AAX</td>
<td>00:00:00</td>
<td>00:00:08</td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1ABP</td>
<td>00:00:00</td>
<td>00:00:09</td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1AIX</td>
<td>00:00:00</td>
<td>00:00:08</td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1ACP</td>
<td>00:00:00</td>
<td>00:00:06</td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1AX</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1AP</td>
<td>00:00:00</td>
<td></td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1ADP</td>
<td></td>
<td></td>
</tr>
<tr>
<td>EXTRACT</td>
<td>RUNNING</td>
<td>CCB1ADX</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

g. On the Oracle Utilities Analytics database server, make sure the replicate processes apply all changes for the context code.

  • Connect to the MDADM schema of the Oracle Utilities Analytics database and execute below to get target server and GoldenGate Home details on the target server.
select DB_HOST,DB_SID,GG_HOST, GG_HOME from b1_gg_cfg where GG_CFG_CD='B1';

• Connect to the target server and login to the GoldenGate prompt.

  Execute the following commands:

  cd <GG_Home >
  ./ggsci
dblogin userid MDADM,password <MDADM user password> Send replicat
  <Context_codeXX>,status

  The current status will be at EOF as shown below in the screenshot.

h. Check this for each replicat process for the context code.

i. Ensure all the extracts, replicates of all the sources are in sync.

j. On the source database server, stop all the GoldenGate processes by following these steps:

  cd <GG_Home>
  ./ggsci

  Execute the following commands:

dblogin userid < GoldenGate Owner >,PASSWORD < GoldenGate Owner password>
  stop <Context_code>* For example:
  stop CCB1*

  Stop manager processes after all the extract processes are stopped.

  Stop mgr

Note: Please note down the source Oracle GoldenGate extracts context_codes of each source and source GoldenGate Owner info, this information is very important. We will configure the existing sources with same context during the upgrade.

k. Rename or backup the existing source GG Home on the source server. Remember to note down the GoldenGate manager port number and source GoldenGate home before renaming it.

For example: mv <GG_Home> <GG_Home>.bkp

l. On the Oracle Utilities Analytics database server, make sure the replicate processes apply all changes for the context code. After checking the current status, each replicate process for the context code, execute the following commands:

  Stop <Context_code>* For example:
  stop CCB1*

m. After all source applications changes have been synced in the Oracle Utilities Analytics database, execute the following command after connecting to the target GoldenGate Home prompt.
n. Rename the existing target GoldenGate Home directory and remember to note down the **GoldenGate manager port number** and **target GoldenGate home** before renaming it.

o. It is recommended to take sound consistent source and target databases backup after source is synchronized with target.

8. Upgrade the Oracle Utilities Analytics database to version 12.1.0.2.0.

9. Install version 12.1.2.1.0 of Oracle GoldenGate on the Oracle Utilities Analytics database server and start the manager process.

   Note down the GoldenGate home and manager port number. This is applicable only if the source application is using Oracle Data Integrator based ELT.

   Install new Oracle Data Integrator 12.1.3 (both infrastructure and ODI softwares) and apply ODI 19949726 patch on Oracle Data Integrator server. The patch is available on My Oracle Support (http://support.oracle.com).

   **Note:** Installing ODI 12.1.3.0.0 with Enterprise edition installation requires JDK1.7.0_75 and Oracle Fusion Middleware infrastructure 12.1.3 as prerequisite.

To summarize, a successful ODI installation consists of the following:

- Installing JDK1.7.0_75
- Installing Oracle Fusion Middleware Infrastructure 12.1.3
- Installing ODI 12.1.3
- Applying ODI patch 19949726

### Upgrading Oracle Utilities Analytics Database Component

Upgrade the Oracle Utilities Analytics database to version 12.1.0.2.0 version, ignore if the Oracle Utilities Analytics database is already on 12.1.0.2.0 version.

Upgrade the Oracle Utilities Analytics Database component on the Oracle Utilities Analytics database server.

**Install 12.1.2.1.0 version of Oracle GoldenGate on the Oracle Utilities Analytics database server and start the manager process. Note down the goldengate home and manager port number.** This is applicable only if the source application is using Oracle Data Integrator based ELT.

This section describes how to upgrade the database component of Oracle Utilities Analytics v2.6.0. It includes the following topics:

- Copying and Decompressing the Install Media
- Creating the Users and the Tablespaces
- Installing the RELADM Schema
- Installing the MDADM Schema
- Installing the DWADM Schema

### Copying and Decompressing the Install Media

To copy and decompress the install media, perform these steps:
1. Download Oracle Utilities Analytics version 2.6.0 Oracle Database part (Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp for a Windows machine or /OUA/temp for a Linux machine. This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.

Creating the Users and the Tablespaces

1. Make sure to create users in the database with the following names without giving specific roles if these do not exist already:
   DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

   Note: Though users can be created using any tablespace name, the same names need to be configured in a metadata table. Configure the tablespace names in Oracle Utilities Analytics Administration Tool > Storage Configuration page.
   See the Oracle Utilities Analytics Administration Tool chapter in the Oracle Utilities Analytics Administration Guide for more details.

2. Connect to the sys user and revoke the DBA privilege from the following users if the DBA privilege has been granted to them:
   DWADM,MDADM,RELADM,OUA_MASTER, OUA_WORK and DWSTAGE

3. Make sure to create roles with the following names if these do not exist already:
   DW_USER, DW_READ, DW_REPLICATE and DW_PRIVS_ROLE.

4. Connect to the sys user, execute the Usersgrants.sql in /Scripts/Usersgrants.sql. This SQL provides the required grants to the created users.

5. Copy the DuplicateRecordCheck.sql file from the BI260\DWADM\Pre-Installation directory to the database server under ../<Temp> directory.

6. Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

   Note: If the system displays that no rows are selected, it is good to proceed. If the system displays some data, then contact Oracle Support team and do not proceed with the installation. It is recommended to wait until you get the data fix script.

Installing the RELADM Schema

The RELADM schema is a metadata schema that consists of the database objects used for storing the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

- Reviewing the Storage.xml file
- Installation Steps
- Generating the Database Statistics

Reviewing the Storage.xml file

The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI260/RELADM/Install- Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.
If database does not have CISTS_01 tablespace or the RELADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

**Installation Steps**

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In **Windows** environment:

1. Add Java 7 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI260\RELADM\Jarfiles\*
   ```

3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/:<ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,,RELADM -
   j
   <JDK Home> –f <TEMPDIR>\BI260\RELADM\Jarfiles –v 1 –e true
   ```

In **Unix** environment:

1. Add Java 7 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.7.0.71/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI260/RELADM/Jarfiles/*
   ```

3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/:<ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,,RELADM -
   j
   <JDK Home> -f <TEMPDIR>/BI260/RELADM/Jarfiles -v 1 -e true
   ```

   The utility creates the RELADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating the Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command:
```
execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');
```

**Installing the MDADM Schema**

The MDADM schema is a metadata schema that consists of the database objects used for storing the metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including:

- Reviewing the Storage.xml File
- Installation Steps
• Generating the Database Statistics

Reviewing the Storage.xml File

The `storage.xml` file (that comes with the product and is in location `<TEMPDIR>/BI260/MDADM/Install-Upgrade`) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the `storage.xml` file by changing the tablespace name from the default value to a custom value.

If the database does not have CISTS_01 tablespace or the MDADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which MDADM has quota.

Installation Steps

Perform the following steps to install the MDADM schema:

The process prompts you for password of MDADM user. Make sure to run the `ORADBI.jar` (in the step below) using Java Development Kit Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows environment:

1. Add Java 7 to the path variable as shown in the example below:

   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.

   ```
   set CLASSPATH=<TEMPDIR>\BI260\MDADM\Jarfiles/*
   ```

3. Run OraDBI.jar as shown below:

   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,MDADM -j
   <JDK Home> -f <TEMPDIR>\BI260\MDADM\Jarfiles -v 1 -e true
   ```

In Unix environment:

1. Add Java 7 to the path variable as shown in example below:

   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.

   ```
   export CLASSPATH=<TEMPDIR>/BI260/MDADM/Jarfiles/*
   ```

3. Run OraDBI.jar as shown below:

   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,MDADM -j
   <JDK Home> -f <TEMPDIR>/BI260/MDADM/Jarfiles -v 1 -e true
   ```

The utility creates the MDADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating the Database Statistics

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:
Connect to the sys user, and execute the command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
```

**Installing the DWADM Schema**

The DWADM schema contains the star schema objects such as facts and dimensions that contain all the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

- Executing the Pre-Installation SQL
- Reviewing the Storage.xml File
- Installation Steps
- Generating the Database Statistics

**Executing the Pre-Installation SQL**

Follow the steps below to execute some SQL scripts before proceeding with the installation:

1. Copy the …\Pre-Installation\PreInstallAddColumns.sql and …\Pre-Installation\PreIndexCreation.sql scripts to the database server under ../<Temp> directory.
2. Change the current directory to ../<Temp>.
3. Connect to the DWADM schema and execute the PreInstallAddColumns.sql.
4. Connect to the DWADM schema and execute the PreIndexCreation.sql.

**Reviewing the Storage.xml File**

The `storage.xml` file (that comes with the product and is in location <TEMPDIR>/BI260/DWADM/Install- Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the `storage.xml` file by changing the tablespace name from the default value to a custom value.

If database does not have CISTS_01 tablespace or the DWADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which DWADM has quota.

**Installation Steps**

Perform the following steps to install the DWADM schema:

**Note:** The process prompts you for password of DWADM user. Make sure to run the OraDBI.jar (in the step below) using Java Development Kit Version 7.0.

Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

**In Windows environment**

1. Add Java 7 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI260\DWADM\Jarfiles\*
   ```
3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,,,,,,DWADM -j
   ```
<JDK Home> -f <TEMPDIR>\BI260\DWADM\Jarfiles -v 1 -e true

In Unix environment:
1. Add Java 7 to the path variable as shown in example below:
   ```bash
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```bash
   export CLASSPATH=<TEMPDIR>/BI260/DWADM/Jarfiles/*
   ```
3. Run OraDBI.jar as shown below:
   ```bash
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,DWADM,<Password of DWADM user>,,,,,,DWADM -j
   <JDK Home> -f <TEMPDIR>/BI260/DWADM/Jarfiles -v 1 -e true
   ```

The utility creates the DWADM schema and system data definitions.
If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating the Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command:

```sql
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

**Post-Installation Steps**

1. Connect to the DWADM schema of the Oracle Utilities Analytics database and execute the following:
   ```sql
   ...\BI260\DWADM\Post-Upgrade\ControlZoneUpdate.sql
   ```
2. Connect to the Oracle Utilities Analytics database with the system user and execute the script mentioned below:
   ```sql
   .../BI260\DWADM\Post-Upgrade\DataCorrection2511.sql
   ```

**Upgrading Oracle Utilities Analytics Based ELT Component**

*Note:* Upgrade the Oracle Utilities Analytics Based ELT component on the Oracle Utilities Analytics application server.

Install JDK1.7.0_75, Oracle Data Integrator 12.1.3.0.0 (both infrastructure and ODI) softwares and apply ODI patch 19949726 on Oracle Utilities Analytics Application server if not done already.

This section describes how to upgrade the ELT component of Oracle Utilities Analytics v2.6.0. It includes the following topics:

- Configuring Oracle Data Integrator Repository Creation Utility (RCU)
- Setting up Oracle GoldenGate
- Copying and Decompressing the Install Media
- Starting the Installer
- Upgrade Steps
- Configuring Source Applications

**Configuring Oracle Data Integrator Repository Creation Utility (RCU)**

Follow the steps below to configure the Oracle Data Integrator Repository Creation Utility:
1. Make sure RCU for ODI is run and the required schemas are created in the target database. ODI_ORACLE_HOME is an Oracle Home path which was used as Oracle Home while installing ODI Infrastructure installation and Oracle Data Integrator (ODI) installation.

2. Set or export JAVA_HOME variable to the 1.7.0_55+ installed directory.

3. Go to ODI_ORACLE_HOME/Oracle_Home/oracle_common/bin.

4. Run the RCU utility.

   **Example:**
   ```
   export JAVA_HOME=/scratch/bi_oradata_01/jdk1.7.0_75
   cd /scratch/bi_oradata_01/Middleware_ODI_12.1.3_EE/Oracle_Home/oracle_common/bin
   ./rcu
   ```

5. In the Repository Creation Utility, select Create Repository->System Load and Product Load option.

6. In the second page, provide the database connection details.

7. In the Select Components page, the options should look like below. De-select the Oracle Data Integrator component.

8. In the next page, make a note of or remember the passwords given as they will be required when creating the Oracle Data Integrator domain.

   It is not required to create the Oracle Data Integrator domain at this stage. It should be done after running the Oracle Utilities Analytics installer and before running source configuration tool.

**Setting up Oracle GoldenGate**

*Note:* This section describes setup required in Oracle GoldenGate to work with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its installation document.

Download Oracle GoldenGate 12.1.2.1.0 from the Oracle Software Delivery Cloud (https://edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers.

This section describes the following:

- Setting up Oracle GoldenGate on the Source Database Server
• Setting up Oracle GoldenGate on the Target Database Server
• Setting up Oracle GoldenGate JAgent on Target and Source Database Servers

**Setting up Oracle GoldenGate on the Source Database Server**

**Note:** Before proceeding, start the source database and make sure it is accessible. Bring down the source application server.

Perform the following steps for each source instance:

1. Create a directory on the source database server. For example, ../GoldenGate Home. Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home** (OGG_Home) on the source database server.

   **Important Note:** Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a command terminal/window, and set the source ORACLE_SID and ORACLE_HOME variables.

   Set LD_LIBRARY_PATH using the following commands:

   **For Unix:**
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   **For Windows:**
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%\lib;%LD_LIBRARY_PATH%
   ```

4. In the **Command** window, change directory to the Oracle GoldenGate home directory, and execute the command:

   **For Unix:**
   ```
   ./ggsci
   ```

   **For Windows:**
   `ggsci`

   This opens the Oracle GoldenGate prompt.

5. On the **Oracle GoldenGate** prompt, execute the **create SUBDIRS** command.

6. On the **Oracle GoldenGate** prompt, execute the **start mgr** command to start the Oracle GoldenGate manager process.

7. On the **Oracle GoldenGate** prompt, execute the **info all** command to view the manager process is running. Exit Oracle **GoldenGate** by executing the **Exit** command.

8. Ensure that the source database is in the **archivelog** mode.

9. Connect to the source database as the sys user and execute the below statements:

   ```
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. Go to the **Oracle GoldenGate home** (OGG_Home) directory.

11. Connect to the database as the sys user using the **SQL*Plus** (OGG_Home should be the current directory while invoking **SQL*Plus**).

12. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and make sure to assign a tablespace to this user that is not assigned to any other user.
**Important Note:** Make a note of the GoldenGate Owner Username; it will be used during Oracle Utilities Analytics installation.

13. Connect to the source database with sys user and execute the following commands:

   **Note:** Make sure to change GoldenGate owner placeholder with actual name of database user as created in previous step.

   ```sql
   grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
   grant unlimited tablespace to <GoldenGate owner> with admin option;
   EXECUTE dbms_goldengate_auth.grant_admin_privilege('<GoldenGate Owner>','capture');
   grant unlimited tablespace to <GoldenGate Owner> with admin option;
   Revoke dba from <GoldenGate Owner>;
   grant create any view to <GoldenGate Owner>;
   grant select any dictionary to <GoldenGate Owner>;
   GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
   GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
   GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;
   ``

14. Connect to the source application ADM schema such as CISADM, and execute the below commands:

   **For Oracle Utilities Customer Care and Billing source database, execute the following grants:**

   ```sql
   Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step mentioned above>
   Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the step mentioned above >
   Grant select on F1_BKT_CONFIG to < GoldenGate owner user created in the step mentioned above >
   Grant select on F1_BKT_CONFIG_VAL to < GoldenGate owner user created in the step mentioned above >
   ``

   **For Oracle Utilities Operational Device Management source database, execute the following grants:**

   ```sql
   Grant select on F1_MST_CONFIG to < GoldenGate owner user created in the step mentioned above>
   Grant select on F1_EXT_LOOKUP_VAL to < GoldenGate owner user created in the step mentioned above>
   ``

   **For Oracle Utilities Meter Data Management source database, execute the following grants:**

   ```sql
   Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
   Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
   ``

   **For Oracle Utilities Work and Asset Management source database, execute the following grants:**

   ```sql
   Grant select on <application ADM Schema>. F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
   ```
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>;
Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

Note: While executing the SQL commands in the steps 16, 17 and 18, provide the GoldenGate owner user if prompted for. All the scripts mentioned below are located in **GoldenGate Home** directory and must be executed after connecting to the sys user.

15. Run the command:
   @marker_setup.sql
16. Run the command:
   @ddl_setup.sql
17. Run the command:
   @role_setup.sql
18. Exit the SQL*Plus login and create a directory named **diroby** inside **OGG_Home** directory.
19. Change directory to the Oracle GoldenGate home directory, and execute the following steps:

   Note: The following prerequisite steps are to be executed before running the OUA installer. Refer to the **Oracle GoldenGate Administering Oracle GoldenGate Guide** for more info.

### Configuration for Encrypting Data with the ENCKEYS Method

a. Execute the following command:

```
   cd <OGG_HOME>
   KEYGEN key_length n
```

   The above command generates the key value based on the value specified in the parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

c. Repeat the step above for each key values generated.

d. Save the file with name ENCKEYS (Upper case only) without any extension.

   Example:
   ```
   cd $OGG_HOME
   ./keygen 128 1
   0x8CE55035D0693205A7BD6773FA8E670
   ```

e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

f. Input the Logical name, space and key value generated.

   Example contents of file ENCKEYS:
   ```
   CCB1KEY 0x8CE55035D0693205A7BD6773FA8E670
   ```

g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.
Note: It is recommended to name Logical key name after `<context_code>KEY. For example: if context code is CCB1, it is recommended to name CCB1KEY.

Generating the Shared Secret Password

a. Execute the following command:

```
cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
```

Example:
```
cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
Encrypted password:
AADAAAAAAAAAAAIAVGNHBFLGCHBTVCBFJFHUEJGNCFAOAFE0FBALELISFOE1FW
GRBZCCMCYGYBDAZH
Algorithm used: AES128
```

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm name used and the generated Encrypted password.

Setting up Oracle GoldenGate on the Target Database Server

Perform the following steps:

1. Create a directory on the target database server. For example, ../GoldenGateHome. Oracle GoldenGate should be installed in this directory. This will be Oracle GoldenGate home (OGG_Home) on the target Oracle Utilities Analytics database server.

   Important Note: Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a Command window and set the target ORACLE_SID and ORACLE_HOME variables.

   Set LD_LIBRARY_PATH using the following commands:

   For Unix:
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   For Windows:
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
   ```

4. In the Command window, change the directory to the GoldenGate home directory and execute the command:

   For Unix:
   ```
   ./ggsci
   ```

   For Windows:
   ```
   ggsci
   ```
   This opens the Oracle GoldenGate prompt.

5. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.
6. On the Oracle GoldenGate prompt, execute the `start mgr` command to start the Oracle GoldenGate manager process.

7. On the Oracle GoldenGate prompt, execute the `info all` command to view the manager process is running.

8. Exit Oracle GoldenGate by executing `exit` command and create a directory named `diroby` inside the OGG_Home directory.

9. Connect to the target database as the sys user and execute below statement:
   
   ```
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. Go to OGG_Home directory.

11. If ENCKEYS file does not exist, open a new ASCII ENCKEYS file and add those key value/values generated on the sources to ENCKEYS file in target OGG home for the context codes for which source configuration is being done.

   Example contents of ENCKEYS file in target OGG home:

   ```
   CCB1KEY 0x8CE55035DD6893205A7B6773FA8E670
   ```

### Setting up Oracle GoldenGate JAgent on Target and Source Database Servers

GoldenGate JAgent setup should be done on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers.

Follow these steps to setup GoldenGate on target and source servers:

After the Oracle GoldenGate software is installed and the Manager is running, follow the below steps to configure the JAGENT.

1. Start the rmiregistry services and note down the port on which RMI server is started. Use the following command:

   ```
   rmiregistry 5559 &
   ```

   Here, we have specified port number as 5559. If the port number is not specified, default port 1099 is used.

2. Edit the Config.properties file in the `<GG home>/cfg` and add/modify the below parameters.

   ```
   <ACTUAL>   : jagent.host=localhost
   <CHANGE TO> : jagent.host=<<actual hostname on which OGG is installed>>
   
   <ACTUAL>   : monitor.jmx.username=cmroot
   <CHANGE TO> : monitor.jmx.username=jmx_src
   
   <ACTUAL>   : jagent.username=root
   <CHANGE TO> : jagent.username=<OGG software installed OS user>>
   
   <ACTUAL>   : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started
   
   <ACTUAL>   : agent.type.enabled=OGGMON
   <CHANGE TO> : agent.type.enabled=OEM
   ```

3. Add the following parameter:

   ```
   jagent.ssl=false
   ```

4. Edit the GLOBALS file in the `<GG home>` and add the below command.

   ```
   EnableMonitoring
   ```

5. Execute the below command from `<GG Home>`

   For Unix:
./pw_agent_util.sh -jagentonly

For Windows:
   pw_agent_util.bat -jagentonly

6. Enter the Oracle wallet password. This password has to be entered as the password for the JAGENT while running the installer (for target gg) and while running source configuration (for source gg). Please make a note of the password.

7. Create a folder with the Context_code name in <GG Home>/dirdat

   For example: If WAM2 is the context being created for the WAM source then create a folder with name "WAM2" within the <GG Home>/dirdat/ folder.

8. Create a folder with name in <GG Home>/diroby

9. Go to OGG_Home directory and go to the GoldenGate prompt:
   
   ggsci

10. Start the jAgent process using the following command:

    start jagent

### Copying and Decompressing the Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.6.0 Multiplatform part (**Oracle Utilities Analytics V2.6.0 Multiplatform.zip**) from the Oracle Software Delivery Cloud ([https://edelivery.oracle.com](https://edelivery.oracle.com)).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip **Oracle Utilities Analytics V2.6.0 Multiplatform.zip** to <TEMPDIR>.

### Starting the Installer

1. Go to the temporary folder where you have downloaded the installer and run the following command from this folder:

   ```
   java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest
   ```

   **Note**: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7.

2. Set or export JAVA_HOME variable:

   ```
   java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest
   ```

3. The **Welcome** page appears. Review this information before you begin the installation and click **Next** to continue with the installation.

   A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

   **Note**: If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:\spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

### Upgrade Steps

To install Oracle Data Integrator Based ETL, perform the following steps

1. Run the Oracle Utilities Analytics Installer. The **Welcome** page appears. Review this information before you begin the installation and click **Next** to continue with the installation.

2. The **Installation Location** page appears. Define the **Installation Location** and click **Next**.
3. The **Select Installation Type** page appears. In the **Select Installation Type** page, select **ODI Based ETL** and click **Next**.

**Note:** Based on the selected installation type, the options on the left navigation panel changes. When you select **Oracle Data Integrator Based ETL** as an **Installation Type**, you need to define **Database and Java Home Details, Target Database Connection Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository Details** and **Target GoldenGate Details**.

4. The **Database and Java Home Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>This is the JDK home location.</td>
<td>Provide location of JDK 1.7 Example: /u01/jdk_1.7.0_75</td>
</tr>
</tbody>
</table>

5. The **Target Database Connection Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

6. The **ODI Home and Schema Details** page. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>The directory where Oracle Data Integrator (ODI) has been installed.</td>
<td>Example: /u01/Middleware/Oracle_ODI1</td>
</tr>
<tr>
<td>Supervisor User</td>
<td>The name of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR</td>
</tr>
</tbody>
</table>
### ODI Agent and Details

7. The **ODI Agent and Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor Password</td>
<td>The password of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm the password of the Supervisor here.</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name.</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>The password of the master repository schema.</td>
<td>OUA_MASTER user's password</td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator master repository schema here.</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name.</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>The password of the work repository schema.</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator work repository schema here.</td>
<td></td>
</tr>
</tbody>
</table>

### Target GoldenGate Details

8. The **Target GoldenGate Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host on the Oracle GoldenGate Manager.</td>
<td></td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /opt/local/ggs_12.1.2.1.0</td>
</tr>
</tbody>
</table>
9. The **Target JAgent Details** page appears. Enter the following details in the respective fields and click Next.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Database Home</td>
<td>This is the database home installed location on the target database server. In case GoldenGate for target is not installed on the OUA database server, provide oracle client home location on the server on which GoldenGate is installed.</td>
<td>Example: <code>/u00/oracle/app/oracle/product/12.1.0.2.0/dbhome_1</code></td>
</tr>
<tr>
<td>GoldenGate Manager Port</td>
<td>The port number on which Oracle GoldenGate Manager is running on the GoldenGate host.</td>
<td>The default value is 7830</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>This is the algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>This is the Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared Secret</td>
<td>This is shared secret key configured in Oracle GoldenGate on the target database server.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: <code>encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT</code> Provide the result of above command as the value.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Host</td>
<td>The host of the Oracle GoldenGate JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>This is the Oracle GoldenGate installed location where GoldenGate JAgent is running.</td>
<td>Example: <code>/opt/local/ggs_12.1.2.1.0</code></td>
</tr>
<tr>
<td>JAgent Port</td>
<td>Use the JAgent RMI port which is defined in the config properties file.</td>
<td></td>
</tr>
<tr>
<td>JAgent User</td>
<td>This is the OS user which is used to configure JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent Wallet Password</td>
<td>This is the JAgent Wallet password.</td>
<td></td>
</tr>
</tbody>
</table>
10. The **Installation Summary** page appears. Verify the installation options you selected.

11. Click **Install** to begin the installation.

   If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

12. The **Installation Progress** page appears which allows you to see the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The Detailed logs of the installation are also available in the logs/system directory under the installation location.

   If you want to quit before the installation is completed, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

13. In the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

**Creating the WebLogic Domain for Oracle Data Integrator Agent**

The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to complete the steps.

Perform the following steps to bring up the WebLogic ODI Agent:

1. Navigate to the Oracle Data Integrator (ODI) installed location `<MW_HOME>/oracle_common/common/bin`, run the below command and follow the steps to provide the masterschema and workschema provided in the configuration.

   For Unix:
   - Run `./config.sh`

   For Windows:
   - Run `config.cmd`

2. Create a new WebLogic domain.

   Choose option to create a new domain in Configuration Type screen and select correct Domain Location.

   Recommended domain location is `$ODI_ORACLE_HOME/Oracle_Home/user_projects/domains/odi_domain`

   Click **Next**.

3. On the Templates screen, make sure **Create Domain Using Product Templates** is selected, and then select the following templates:

   - Oracle Enterprise Manager Plugin for ODI - 12.1.3.0 [em]
     - Selecting this template automatically selects the following as dependencies:
       - Oracle Enterprise Manager - 12.1.3.0 [em]
       - Oracle JRF - 12.1.3.0 [oracle_common]
       - WebLogic Coherence Cluster Extension - 12.1.3.0 [wlserver]
       - Oracle Data Integrator - Agent - 12.1.3.0 [odi]

   Confirm JAgent Wallet Password
   
   Re enter JAgent Wallet password to confirm.
• Oracle Data Integrator - Agent Libraries - 12.1.3.0 [odi]
• Oracle Data Integrator SDK Shared Library Template - 12.1.3.0 [odi]
• Oracle Data Integrator - Console - 12.1.3.0 [odi]

Click Next to proceed.

4. On the Application Location page, you do not need to edit any values.

Click Next to proceed.

5. Configure the Administrator User Name and Password for WebLogic.

Provide the WebLogic password.

Click Next.

6. On the Domain Mode and JDK page:

• Select the Production Mode option.
• Provide the JDK 1.7.0_75+

7. On the Database Configuration Type page, select RCU data option in auto configuration option.

Enter <prefix>_STB schema details, database details and click ‘Get RCU Configuration’ button.

Click Next to proceed.


Select only the ODI Master Schema checkbox. Provide the following details:

• DBMS/Service: Target Database Name
• Host Name: Database Serverhost
• Port: Database Port
• Schema Owner: OUA_MASTER
• Schema Password: OUA_MASTER Password


10. Select the ODI Work Schema checkbox. Provide the below details:

• DBMS/Service: Target Database Name
• Host Name: Database Serverhost
• Port: Database Port
• Schema Owner: OUA_WORK
• Schema Password: OUA_WORK Password

Click Next to proceed.

11. On the JDBC Component Schema Test page, test the JDBC Component Schema by selecting the Select All and clicking the Test Selected Connections.

Click Next to proceed.
12. On the **Credentials** page, specify SUPERVISOR username credentials, click on +ADD button to add odi_domain credentials. The screen capture is as following, ensure it is done correctly.

13. On the **Advanced Configuration** page, select the following options:
   - Administration Server
   - Managed servers, Clusters and Coherence

   Click **Next** to proceed.

14. On the **Administration Server** page,
   - Provide the **Listening Port**, which is not in use.

   Click **Next** to proceed.

15. Configure the **Managed Servers** by providing the following:
   - **Server Name**: odi_server1
   - **Listen Address**: All Local Addresses
   - **Port**: Provide the port, which is provided in the step 8 in the section Installation Steps.

16. Configure the **Cluster**.

17. Configure the **Coherence Cluster**.

18. Configure the **Machines**.

19. On the **Configuration Summary** page, click **Create** to create the domain odi_domain.

20. Make sure configuration is successfully done.

21. Click **Next** to proceed.

22. After the domain is created, go to the domain location, create the **boot.properties** file for WebLogic login. Create the `<MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security` folder if not present.

23. Go to `<MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security`, then create **boot.properties** file with the below values:
Upgrading Oracle Utilities Analytics from Version 2.5.0.0.5

- username=weblogic
- password=Weblogic password

24. Create the `<MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security` folder if not present.

25. Go to `<MW_HOME>/user_projects/domains/odi_domain/servers/odi_server1/security`, and then create `boot.properties` file with the below values:
   - username=weblogic
   - password=Weblogic password

Starting the WebLogic Admin Server

Perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home - `<MW_HOME>/user_projects/domains/odi_domain/bin`.
2. Execute the `startweblogic` command for UNIX and Windows:

   **For Unix:**
   ```
   nohup ./startWebLogic.sh > startWebLogic.log &
   ```

   **For Windows:**
   ```
   startWebLogic.cmd
   ```

Starting the Managed Server odi_server1

Perform the following steps:

1. To start managed server odi_server1, change the directory to the WLS Home:
   Execute the following commands:
   **For Unix:**
   ```
   <MW_HOME>/user_projects/domains/odi_domain/bin
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
   ```
   **For Windows:**
   ```
   StartManagedWeblogic.cmd odi_server1
   ```
2. From the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of configured Oracle Data Integrator Java EE agent.

Executing Post-Upgrade Script

Perform the following steps to execute the post-upgrade script:

1. Execute B1_MDFIX_ODM_260 in global context.
2. Login to ODI Client and go to Designer Tab.
3. Navigate to Load Plans and Scenario Folders.
5. Right click B1_MDFIX_ODM_260, click Run and select the context as Global and click OK.

Creating a Database Directory

Create a database directory 'B1_DATA_DUMP_DIR' on the target database as well as on each source database. This directory is used for logging the export import task used during the initial
ELT load. The following is a sample SQL that creates the database directory pointing to the file system path `/scratch/file_data`:

```sql
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
```

### Configuring Source Applications

Bring down the source application server. Make sure source applications are stopped but source databases are up and accessible.

Perform the following steps mentioned in the below sections:

- **Prerequisites**
- **Configuration Steps**

#### Prerequisites

Make sure oracle data integrator (ODI) domain is created and Admin and managed servers are running before running the source configuration tool.

#### Configuration Steps

To configure the source applications, perform the following steps:

1. Perform the steps for registering a source as described in the *Registering a Source* section in the *Chapter 5: Configuring Oracle Utilities Analytics* in *Oracle Utilities Analytics Administration Guide*.

2. Please use the same context_codes to configure the existing Sources during the upgrade.

3. After config.sh GUI utility execution, execute B1_SYNC_CONTEXT.
   a. To execute B1_SYNC_CONTEXT package, login to Oracle Data Integrator Studio.
   b. Go to Designer.
   c. Navigate to Load Plans and Scenarios> Framework.
   d. Right-click on B1_SYNC_CONTEXT and select Run option.
4. Select the context related to the source application, <no agent> as logical agent, and then click OK.

5. After B1_SYNC_CONTEXT execution, execute B1_INITIAL_SETUP_PKG.

   **Note:** It is recommended to run B1_INITIAL_SETUP_PKG only once i.e. after all the sources have been configured or after at least one source is configured.

   a. To execute B1_INITIAL_SETUP_PKG package, login to Oracle Data Integrator Studio.
   b. Go to Designer.
   c. Navigate to Load Plans and Scenarios> Framework.
   d. Right-click B1_INITIAL_SETUP_PKG, choose GLOBAL context code and select Run option.

6. Start all the OGG processes on source and target:

   a. Login into each source application Golden Gate server.
   b. Go to respective Oracle Golden gate Home directory.
   c. Start manager, JAgent and all the respective context extract processes.
   d. Login into Target Oracle Utilities Analytics (OUA) Golden Gate server.
   e. Go to Oracle Golden gate Home directory.
   f. Start manager, jagent and all the respective context extract processes.

### Upgrading Source Applications to be Compatible With v2.6.0

**Note:** Please read 'Supported Source Application Versions' section in chapter 2 to see if source applications are compatible with OUA 260 and upgrade source applications if required.

Source applications databases must be in archive log mode during source applications upgrade. Oracle Golden Gate processes should be up and running on both source and target during the source applications upgrade.

Upgrade the Source application system as certified with OUA 2.6.0 but do not upgrade database software version.

After a successful source upgrade, do not release source applications for end users. Make sure source applications are stopped but source databases are up and accessible.

1. Login into the Oracle Utilities Analytics Golden gate server, go to goldengate home and execute shell script restart.sh from BI260/Scripts/restart.sh. This shell script would start the replicate processes which are stopped due to DDL changes in source system. Once all the DDL changes are synced to replication schema the shell script would be automatically terminated. Monitor restart.sh execution, move to next steps only when restart.sh execution is completed.

2. Validate that all columns are synced up.

3. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute below query. The below query should not return any records.

   ```sql
   select TABLE_NAME, COLUMN_NAME
   from DBA_TAB_COLUMNS@<CONTEXT_CODE>_LINK DTC
   where OWNER = 'SOURCE_APPLICATION_SCHEMA'
   and exists (select 1
   from MDADM.B1_REPLICATION_CFG_VW a
   where a.TABLE_NAME = DTC.TABLE_NAME
   and CONTEXT_CD = '<CONTEXT_CODE>'
   ```
Example: The following is an example query for ODM1 context.

```sql
select TABLE_NAME, COLUMN_NAME
from DBA_TAB_COLUMNS@ODM1_LINK DTC
where OWNER = 'CISADM'
and exists (select 1
    from MDADM.B1_REPLICATION_CFG_VW a
    where a.TABLE_NAME = DTC.TABLE_NAME
    and CONTEXT_CD = 'ODM1'
    and (BASE_REPLICATE_FLG = 'Y' OR CM_REPLICATE_FLG = 'Y'))
MINUS
select TABLE_NAME, COLUMN_NAME
from DBA_TAB_COLUMNS
where OWNER = 'ODM1REP'
and COLUMN_NAME not like 'JRN%';
```

4. If no source database software upgrade is required, it is not required to perform any kind of cleanup of Oracle GoldenGate processes. In this case, do the following:
   - Start all GG processes on source and target.
   - Start the source app server

   This indicates that upgrade processes is completed.

Perform the following steps to cleanup Oracle GoldenGate processes. The following procedure is only required when it is required to upgrade the source database software.

1. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below to get all the context codes.

2. Select `CONTEXT_CD` from the `b1_prod_instance` where `CONTEXT_CD<>'B1';`.

3. For each context returned by the query, perform the following steps:
   a. Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the SQL mentioned below to get source GoldenGate db server, SID and Oracle GoldenGate host, home on source server:

   ```sql
   Select DB_HOST, DB_SID, GG_HOST, GG_HOME, GG_CFG_CD from b1_gg_cfg
   where GG_CFG_CD='<Context_code>'
   ```

   b. Connect to the source database corresponding to context code with sys user and execute the following command:

   ```bash
   alter system switch logfile
   select SEQUENCE# from v$Log where STATUS='CURRENT';
   ```

   c. Note down the result of the query mentioned above.

   d. Connect to the source GoldenGate server and log into the source Oracle GoldenGate prompt.

   ```bash
   cd <GG_Home>
   ./ggsci
   ```
e. Execute the following command:

```
info extract <Context_codeXXX>,showch
```

For example, `info extract CCB1AAX,showch`

In the **Recovery Checkpoint** section, sequence should be equal or greater than one returned by "select SEQUENCE# from v$Log where STATUS='CURRENT'" query.

For example,

![Recovery Checkpoint output](image1)

Repeat the check mentioned in the **step e** for each extract process.

f. Also make sure that the pump processes transfer all the changes to the target server. Lag at the **Chkpt** and **Time Since Chkpt** should look as shown below.

For example,

![Chkpt and Time Since Chkpt output](image2)

g. On the source database server, drop all the GoldenGate processes by following these steps:

Connect to the MDADM schema of the Oracle Utilities Analytics database and execute the following query to get GoldenGate Owner name in the source database.

```
select SCHEMA_NAME
from MDADM.B1_CONTEXT_CFG_VW
where LSCHEMA_NAME = 'Journal'
and CONTEXT_CD = '<Context_code>'; 
```

Login to source GoldenGate prompt.

```
cd <GG_Home>
./ggsci
```

Execute the following commands:

```
dblogin userid < GoldenGate Owner >,PASSWORD < GoldenGate Owner password>
stop <Context_code>*
```

For example:

```
stop CCB1*
```

```
delete <Context_code>*
```

For example:
delete CCB1*

Stop JAgent and stop manager

Stop jagent

Stop mgr

**Note:** Please note down the source oracle GoldenGate extracts context_codes of each source and source GoldenGate Owner info, this information is very important. We will configure the existing Sources with same context during the upgrade.

h. Connect to the sys user of the source database server and execute the following command:

```
<GG_Home>/ddl_disable.sql
```

i. Rename the existing source GG Home on the source server. Remember to note down the **GoldenGate manager port number** and **source GoldenGate home** before renaming it.

For example, mv <GG_Home> <GG_Home>.bkp

j. On the Oracle Utilities Analytics database server, make sure the replicate processes apply all changes for the context code.

- Connect to the MDADM schema of the Oracle Utilities Analytics database and execute below to get target server and GoldenGate Home details on the target server.

```
select DB_HOST, DB_SID, GG_HOST, GG_HOME from b1_gg_cfg where GG_CFG_CD='B1';
```

- Connect to the target server and login to the GoldenGate prompt.

Execute the following commands:

```
cd <GG_Home>
./ggsci
Dblogin userid MDADM,password <MDADM user password>
Send replicat <Context_codeXX>,status
```

The current status will be at EOF as shown below in the screenshot.

![Screenshot](image)

- Check this for each replicate process for the context code and make sure the replicate processes completed writing all the changes.

- After checking the current status and after changes have been synched, for each replicate process for the context code, execute the following commands:

```
Stop <Context_code>*
```

For example:

```
stop CCB1*
```
Delete <Context_code>*
For example:
delete CCB1*

4. After all source applications changes have been synced in the Oracle Utilities Analytics database, execute the following command after connecting to the target GoldenGate Home prompt.

./ggsci
start mgr
start jagent

5. Upgrade source application databases.

Note:
- If the source database version is prior to 11.2.0.4, then upgrade to 11.2.0.4 or a later version.
- If the source database version is on 12c version, then 12.1.0.2 is mandatory.

6. Set up Oracle GoldenGate with newly upgraded database software Oracle home directory on source.

Note: This section describes the setup required in Oracle GoldenGate to work with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its installation document.

a. Download Oracle GoldenGate 12.1.2.1.0 from the Oracle Software Delivery Cloud (https://edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers.

Select the newly upgraded source database software oracle home directory while installing.

Perform the following steps for each source instance:

b. Create a directory on the source database server. For example, ../GoldenGate Home.
Oracle GoldenGate should be installed in this directory. This will be Oracle GoldenGate home (OGG_Home) on the source database server.

Important Note: Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

c. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step a.

d. Open a command terminal/window, and set the source ORACLE_SID and ORACLE_HOME variables.

Set LD_LIBRARY_PATH using the following commands:

For Unix:

export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH

For Windows:

set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%

e. In the Command window, change directory to the Oracle GoldenGate home directory, and execute the command:

For Unix:

./ggsci
For Windows:

ggsci

This opens the Oracle GoldenGate prompt.

f. On the Oracle GoldenGate prompt, execute the create SUBDIRS command.

g. On the Oracle GoldenGate prompt, execute the start mgr command to start the Oracle GoldenGate manager process.

h. On the Oracle GoldenGate prompt, execute the info all command to view the manager process is running. Exit Oracle GoldenGate by executing the Exit command.

i. Ensure that the source database is in the archivelog mode.

j. Connect to the source database as the sys user and execute the below statements:

```
alter database add supplemental log data (primary key) columns;
alter system set enable_goldengate_replication=TRUE scope=both;
```

k. Go to the Oracle GoldenGate home (OGG_Home) directory. Connect as the sys user and execute the following commands in steps l, m and n.

**Note:** While executing the SQL commands in the steps l, m and n, provide the GoldenGate owner user if prompted for. All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the sys user.

l. Run the command:
```
@marker_setup.sql
```

m. Run the command:
```
@ddl_setup.sql
```

n. Run the command:
```
@role_setup.sql
```

o. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.

p. Change directory to the Oracle GoldenGate home directory, and execute the next steps.

### 7. Perform the configuration for Encrypting Data with the ENCKEYS Method

a. Execute the following command:
```
cd $OGG_HOME
KEYGEN key_length n
```

The above command generates the key value based on the value specified in the parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

c. Repeat the step above for each key values generated.

d. Save the file with name ENCKEYS (Upper case only) without any extension.

Example:
```
cd $OGG_HOME
./keygen 128 1 0x8CE55035DD6893205A7BD6773FA8E670
```
e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

f. Input the Logical name, space and key value generated.

Example contents of file ENCKEYS:

CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

Example: It is recommended to name Logical key name after <context_code>KEY. For example: if context code is CCB1, it is recommended to name CCB1KEY.

g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.

Note: It is recommended to name Logical key name after <context_code>KEY. For example: if context code is CCB1, it is recommended to name CCB1KEY.

8. Generate the Shared Secret Password

a. Execute the following command:

```
cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
```

Example:

```
cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
Encrypted password:
AADAAAAAIAVGNHBFGLGFCHBTCVBFJFHUEJGNCFAOAFE0FBALELISFOEIFWGRBEHCCMCYGYBDAZH
Algorithm used: AES128
```

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm name used and the generated Encrypted password.

9. Set up Oracle GoldenGate JAgent on the Source Database Servers

GoldenGate JAgent setup should be done on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers.

Follow these steps to setup GoldenGate on the source servers:

After the Oracle GoldenGate software is installed and the Manager is running, follow the below steps to configure the JAGENT.

a. Ensure the rmiregistry services are running.

b. Edit the Config.properties file in the <GG home>/cfg and add/modif the below parameters.

```
<ACTUAL>    : jagent.host=localhost
<CHANGE TO> : jagent.host=<actual hostname on which OGG is installed>>

<ACTUAL>    : monitor.jmx.username=cmroot
<CHANGE TO> : monitor.jmx.username=jmx_src

<ACTUAL>    : jagent.username=root
<CHANGE TO> : jagent.username=<OGG software installed OS user>>

<ACTUAL>    : jagent.rmi.port=5559
```
10. Configure the source applications
   a. Bring down the source application server.
   b. Make sure the source applications are stopped but source databases are up and accessible.
   c. Ensure that manager and Jagent processes are running on all the sources and target database systems before executing config.sh
   d. Make sure oracle data integrator (ODI) domain is created and Admin and managed servers are running before running the source configuration tool.

Perform these next steps to configure the applications:
   e. Perform the steps for registering a source as described in the Registering a Source section in the Chapter 5: Configuring Oracle Utilities Analytics in the Oracle Utilities Analytics Administration Guide.
   f. Please use the same context_codes to configure the existing Sources during the upgrade.
   g. After executing config.sh GUI utility, start all the OGG processes on source and target:
      a. Login into each source application Golden Gate server.
      b. Go to respective Oracle Golden gate Home directory.
      c. Start manager, JAgent and all the respective context extract processes.
      d. Login into Target Oracle Utilities Analytics (OUA) Golden Gate server.
      e. Go to Oracle Golden gate Home directory.
f. Start manager, Jagent and all the respective context extract processes.

h. Start the source app server and release the source system environment.
   The upgrade processes is completed.
Upgrading Oracle Warehouse Builder Based Oracle Utilities Analytics

This section consists of the following:

- **Prerequisites**
- **Upgrading Oracle Utilities Analytics Database Component**
- **Upgrading Oracle Utilities Analytics Based ELT Component**
- **Configuring Source Applications**

**Prerequisites**

If you have Oracle Warehouse Builder based source application (Oracle Utilities Mobile Workforce Management and Oracle Utilities Meter Data Management), bring them down to make sure no one is accessing the application(s).

Follow these steps to upgrade OWB based source applications:

1. Bring down the target applications (OBIEE)
2. Inform users not to operate on the source applications and the database.
   Ensure no one is using the source before proceeding with the next step.
3. Generate the final extract from the source application and upload to the warehouse database.
4. Note the time after the final extract files have been loaded in OUA warehouse database in DD-MON-YYYY HH24:MI:SS format.
5. Stop the FPD (File processor daemon).
   a. Set the OWB environment.
      To set the OWB environment follow the below steps.
   b. Connect to RELADM schema and execute query "select server_name,env_dir from B1_INSTALL_COMPONENTS where comp_cd='BI_OWB'; " to get the server and OWB environment directory details where OWB environment is set up.
   c. cd <OWB environment directory>/etc and open the ENVIRON.INI file.
      value of SPLENVIRON variable is the OWB environment name.
   d. Please note down the OWB environment name and ensure it is the correct OWB environment you are trying to upgrade.
   e. cd <OWB environment directory>/bin and execute ksh ./splenviron.sh -e <OWB environment name>
   f. cd $SPLEBASE/bin
   g. ksh ./stopFileprocessordaemon.sh.
      Please wait for file processor to stop.
      You can verify this by executing "ps -ef | grep File" command
6. Bring down the Source apps and Database.
   It is recommended to take sound consistent source and target databases backup.
7. Upgrade the Oracle Utilities Analytics database to 12.1.0.2.0 database version
8. Install 12.1.2.1.0 version of Oracle GoldenGate on the Oracle Utilities Analytics database server and start the manager process. Note down the GoldenGate home and manager port number.
   This is applicable only if the source application is using Oracle Data Integrator based ELT.
9. Install new Oracle Data Integrator 12.1.3 (both infrastructure and ODI softwares) and apply ODI 19949726 patch on Oracle Data Integrator server.
   The patch on 12.1.3 is available on My Oracle Support (http://support.oracle.com).
10. Installing ODI 12.1.3.0.0 with Enterprise edition installation requires JDK1.7.0_75 and Oracle Fusion Middleware infrastructure 12.1.3 as prerequisite.

To summarize, the ODI installation is as follows:

- Install JDK1.7.0_75
- Install Oracle Fusion Middleware Infrastructure 12.1.3
- Install ODI 12.1.3
- Apply ODI patch 19949726

Upgrading Oracle Utilities Analytics Database Component

**Note:** Upgrade the Oracle Utilities Analytics database to 12.1.0.2.0 version, ignore if the Oracle Utilities Analytics database is already on 12.1.0.2.0 version.

**Note:** Upgrade the Oracle Utilities Analytics Database component on the Oracle Utilities Analytics database server.

**Note:** Install 12.1.2.1.0 version of Oracle GoldenGate on the Oracle Utilities Analytics database server and start the manager process. Note down the goldengate home and manager port number. This is applicable only if the source application is using Oracle Data Integrator based ELT.

This section describes how to upgrade the database component of Oracle Utilities Analytics v2.6.0. It includes the following topics:

- Copying and Decompressing the Install Media
- Creating the Users and the Tablespaces
- Installing the RELADM Schema
- Installing the MDADM Schema
- Installing the DWADM Schema

**Copying and Decompressing the Install Media**

To copy and decompress the install media, perform these steps:

1. Download Oracle Utilities Analytics version 2.6.0 Oracle Database part (Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp for a Windows machine or /OUA/temp for a Linux machine. This directory (referred as <TEMPDIR> below) must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation, can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip to <TEMPDIR> using any zip utility.

**Creating the Users and the Tablespaces**

1. Make sure to create users in the database with the following names without giving specific roles if these do not exist already:
   DWADM, DWUSER, DWREAD, MDADM, RELADM, OUA_MASTER, OUA_WORK and DWSTAGE

   **Note:** Though users can be created using any tablespace name, the same names need to be configured in a metadata table. Configure the tablespace names in Oracle Utilities Analytics Administration Tool > **Storage Configuration** page.
2. Connect to the sys user and revoke the DBA privilege from the following users if the DBA privilege has been granted to them:
   DWADM, MDADM, RELADM, OUA_MASTER, OUA_WORK, and DWSTAGE
3. Make sure to create roles with the following names if these do not exist already:
   DW_USER, DW_READ, DW_REPLICATE, and DW_PRIVS_ROLE.
4. Connect to the sys user, execute the Usersgrants.sql in /Scripts/Usersgrants.sql. This SQL provides the required grants to the created users.
5. Copy the DuplicateRecordCheck.sql file from the BI260\DWADM\Pre-Installation directory to the database server under ../<Temp> directory.
6. Connect to the DWADM schema and execute the ../<Temp>/DuplicateRecordCheck.sql.

   Note: If the system displays that no rows are selected, it is good to proceed. If the system displays some data, then contact Oracle Support team and do not proceed with the installation. It is recommended to wait until you get the data fix script.

Installing the RELADM Schema

The RELADM schema is a metadata schema that consists of the database objects used for storing the product version and component installation information.

This section describes initial installation of the RELADM schema, including:

- Reviewing the Storage.xml file
- Installation Steps
- Generating the Database Statistics

Reviewing the Storage.xml file

The storage.xml file (that comes with the product and is in location <TEMPDIR>/BI260/RELADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

   Note: If database does not have CISTS_01 tablespace or the RELADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which RELADM has quota.

Installation Steps

   Note: Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows environment

1. Add Java 7 to the path variable as shown in the example below:
   
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   
   set CLASSPATH=<TEMPDIR>\BI260\RELADM\Jarfiles\*
   ```
2. Run OraDBI.jar as shown below:
   
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,,,RELADM -
   ```
<JDK Home> -f <TEMPDIR>\BI260\RELADM\Jarfiles -v 1 -e true

In Unix environment:

1. Add Java 7 to the path variable as shown in example below:
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   export CLASSPATH=<TEMPDIR>\BI260\RELADM\Jarfiles/*

3. Run OraDBI.jar as shown below:
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,RELADM,<Password of RELADM user>,,,RELADM -j
   <JDK Home> -f <TEMPDIR>\BI260\RELADM\Jarfiles -v 1 -e true

   The utility creates the RELADM schema and system data definitions. If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating the Database Statistics

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command:

   execute DBMS_STATS.GATHER_SCHEMA_STATS('RELADM');

Installing the MDADM Schema

The MDADM schema is a metadata schema that consists of the database objects used for storing the metadata of Oracle Utilities Analytics. For example, ETL job execution status, target tables for ETL, Oracle GoldenGate configuration details, etc.

This section describes initial installation of the MDADM schema, including:

• Reviewing the Storage.xml File
• Installation Steps
• Generating the Database Statistics

Reviewing the Storage.xml File

The storage.xml file (that comes with the product and is in location <TEMPDIR>\BI260/MDADM/Install-Upgrade) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the storage.xml file by changing the tablespace name from the default value to a custom value.

   Note: If the database does not have CISTS_01 tablespace or the MDADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which MDADM has quota.

Installation Steps

Perform the following steps to install the MDADM schema:

   Note: The process prompts you for password of MDADM user. Make sure to run the ORADBI.jar (in the step below) using Java Development Kit Version 7.0.
Note: Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

In Windows environment

1. Add Java 7 to the path variable as shown in the example below:
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   set CLASSPATH=<TEMPDIR>\BI260\MDADM\Jarfiles\*
   ```
3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,,MDADM -j
   <JDK Home> -f <TEMPDIR>\BI260\MDADM\Jarfiles –v 1 –e true
   ```

In Unix environment:

1. Add Java 7 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```
2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI260/MDADM/Jarfiles/*
   ```
3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,MDADM,<Password of MDADM user>,,,,,,MDADM -j
   <JDK Home> -f <TEMPDIR>/BI260/MDADM/Jarfiles –v 1 –e true
   ```

The utility creates the MDADM schema and system data definitions.

If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

Generating the Database Statistics

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user, and execute the command:
```
execute DBMS_STATS.GATHER_SCHEMA_STATS('MDADM');
```

Installing the DWADM Schema

The DWADM schema contains the star schema objects such as facts and dimensions that contain all the data of the data warehouse.

This section describes initial installation of the DWADM schema, including:

- Executing the Pre-Installation SQL
- Reviewing the Storage.xml File
- Installation Steps
- Generating the Database Statistics

Executing the Pre-Installation SQL

Follow the steps below to execute some SQL scripts before proceeding with the installation:
1. Copy the `\Pre-Installation\PreInstallAddColumns.sql` and `\Pre-Installation\PreIndexCreation.sql` scripts to the database server under `../<Temp>` directory.

2. Change the current directory to `../<Temp>`.

3. Connect to the DWADM schema and execute the `PreInstallAddColumns.sql`.

4. Connect to the DWADM schema and execute the `PreIndexCreation.sql`.

5. Connect to the DWADM schema and execute below Anonymous block

```sql
set serveroutput on;
set timing on;
BEGIN
  -- Drop All Staging External Tables
  FOR i IN (SELECT uet.table_name
  FROM USER_EXTERNAL_TABLES uet where uet.table_name
  like 'STG%_EXT')
  LOOP
    EXECUTE IMMEDIATE 'drop table ''|| i.table_name ||'' CASCADE CONSTRAINTS ';
  END LOOP;
END;
/
```

### Reviewing the Storage.xml File

The `storage.xml` file (that comes with the product and is in location `<TEMPDIR>/BI260/DWADM/Install- Upgrade`) allocates all the base tables and indexes to the default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the default tablespace, then this has to be reflected in the `storage.xml` file by changing the tablespace name from the default value to a custom value.

**Note:** If the database does not have CISTS_01 tablespace or the DWADM user does not have quota on CISTS_01 tablespace, you must edit the Storage.xml file to indicate the correct tablespace name on which DWADM has quota.

### Installation Steps

Perform the following steps to install the DWADM schema:

**Note:** The process prompts you for the password of DWADM user. Make sure to run the OraDBI.jar (in the step below) using Java Development Kit Version 7.0.

**Note:** Ensure to copy/paste the commands into Notepad. Check for any special characters and extra spaces. If any, delete them and enter the respective characters manually. This helps to avoid any errors at run time.

#### In Windows environment

1. Add Java 7 to the path variable as shown in the example below:

   ```bash
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.

   ```bash
   set CLASSPATH=<TEMPDIR>\BI260\DWADM\Jarfiles\*
   ```

3. Run OraDBI.jar as shown below:

   ```bash
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/<
   ORACLE SERVICE NAME>,DWADM,<Password of DWADM
   user>,DWUSER,DWREAD,DW_USER,DW_READ,DWADM -j
   <JDK Home> -f <TEMPDIR>\BI260\DWADM\Jarfiles -v 1 -e true
   ```
In Unix environment:

1. Add Java 7 to the path variable as shown in example below:
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```

2. Set classpath pointing to OraDBI.jar and all dependency jars.
   ```
   export CLASSPATH=<TEMPDIR>/BI260/DWADM/Jarfiles/*
   ```

3. Run OraDBI.jar as shown below:
   ```
   java com.oracle.ouaf.oem.install.OraDBI -d
   jdbc:oracle:thin:@<DATABASE SERVER>:<DATABASE PORT>/
   <ORACLE SERVICE NAME>,DWADM,<Password of DWADM
   user>,DWUSER,DWREAD,DW_USER,DWADM -j
   <JDK Home> -f <TEMPDIR>/BI260/DWADM/Jarfiles -v 1 -e true
   ```

   The utility creates the DWADM schema and system data definitions.
   If an error occurs while executing an SQL or another utility, it logs and displays the error message and allows you to re-execute the current step.

**Generating the Database Statistics**

During the installation process, new database objects may be added to the target database. Before using the database, generate the statistics for these new objects:

Connect to the sys user and execute the command:

```
execute DBMS_STATS.GATHER_SCHEMA_STATS('DWADM');
```

**Post-installation Steps**

1. Connect to the DWADM schema of the Oracle Utilities Analytics database and execute the following:

   ```
   .../BI260\DWADM\Post-Upgrade\ControlZoneUpdate.sql
   ```

2. Connect to the Oracle Utilities Analytics database with the system user and execute the script mentioned below:

   ```
   .../BI260\DWADM\Post-Upgrade\DataCorrection2511.sql
   ```

**Upgrading Oracle Utilities Analytics Based ELT Component**

*Note:* Upgrade the Oracle Utilities Analytics Based ELT component on the Oracle Utilities Analytics application server.

Install JDK1.7.0_75, Oracle Data Integrator 12.1.3.0.0 (both infrastructure and ODI) softwares and apply ODI patch 19949726 on Oracle Utilities Analytics Application server if not done already.

This section describes how to upgrade the ELT component of Oracle Utilities Analytics v2.6.0. It includes the following topics:

- Configuring Oracle Data Integrator Repository Creation Utility (RCU)
- Setting up Oracle GoldenGate
- Copying and Decompressing the Install Media
- Starting the Installer
- Upgrade Steps

**Configuring Oracle Data Integrator Repository Creation Utility (RCU)**

Follow the steps below to configure the Oracle Data Integrator Repository Creation Utility:

1. Make sure RCU for ODI is run and the required schemas are created in the target database.
ODI_ORACLE_HOME is an Oracle Home path which was used as Oracle Home while installing ODI Infrastructure installation and Oracle Data Integrator (ODI) installation.

2. Set or export JAVA_HOME variable to the 1.7.0_55+ installed directory.
3. Go to $ODI_ORACLE_HOME/Oracle_Home/oracle_common/bin
4. Run the RCU utility

**Example:**
```
export JAVA_HOME=/scratch/bi_oradata_01/jdk1.7.0_75
cd /scratch/bi_oradata_01/Middleware_ODI_12.1.3_EE/Oracle_Home/oracle_common/bin
./rcu
```

5. In the Repository Creation Utility, select **Create Repository->System Load and Product Load** option.
6. In the second page, provide the database connection details.
7. In the **Select Components** page, the options should look like below. Unselect the Oracle Data Integrator component.

8. In the next page, make a note of or remember the passwords given as they will be required when creating the Oracle Data Integrator domain.

   It is not required to create the Oracle Data Integrator domain at this stage. It should be done after running the Oracle Utilities Analytics installer and before running source configuration tool.

**Setting up Oracle GoldenGate**

**Note:** This section describes setup required in Oracle GoldenGate to work with Oracle Utilities Analytics. For installing Oracle GoldenGate, refer to its installation document.

Download Oracle GoldenGate 12.1.2.1.0 from the Oracle Software Delivery Cloud (https://edelivery.oracle.com) and set up Oracle GoldenGate on the source and the target database servers.

This section describes the following:

- Setting up Oracle GoldenGate on the Source Database Server
• Setting up Oracle GoldenGate on the Target Database Server
• Setting up Oracle GoldenGate JAgent on Target and Source Database Servers

**Setting up Oracle GoldenGate on the Source Database Server**

**Note:** Before proceeding, start the source database and ensure it is accessible. Bring down the source application server.

Perform the following steps for each source instance:

1. Create a directory on the source database server. For example, ~/GoldenGate Home. Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home (OGG_Home)** on the source database server.
   
   **Important Note:** Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a command terminal/window, and set the source ORACLE_SID and ORACLE_HOME variables.
   
   Set LD_LIBRARY_PATH using the following commands:
   
   **For Unix:**
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```
   
   **For Windows:**
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%\lib:%LD_LIBRARY_PATH%
   ```

4. In the **Command** window, change directory to the Oracle GoldenGate home directory, and execute the command:
   
   **For Unix:**
   ```
   ./ggsci
   ```
   
   **For Windows:**
   ```
   ggsci
   ```
   
   This opens the Oracle GoldenGate prompt.

5. On the **Oracle GoldenGate** prompt, execute the **create SUBDIRS** command.

6. On the **Oracle GoldenGate** prompt, execute the **start mgr** command to start the Oracle GoldenGate manager process.

7. On the **Oracle GoldenGate** prompt, execute the **info all** command to view the manager process is running. Exit Oracle **GoldenGate** by executing the **Exit** command.

8. Ensure that the source database is in the **archivelog** mode.

9. Connect to the source database as the sys user and execute the below statements:
   ```
   alter database add supplemental log data (primary key) columns;
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. Go to the **Oracle GoldenGate home (OGG_Home)** directory.

11. Connect to the database as the sys user using the **SQL*Plus (OGG_Home)** should be the current directory while invoking **SQL*Plus**.

12. Create a new user, for example: ODM01SRC (this user is the Oracle GoldenGate owner) and make sure to assign a tablespace to this user that is not assigned to any other user.
Important Note: Make a note of the GoldenGate Owner Username; it will be used during Oracle Utilities Analytics installation.

13. Connect to the source database with sys user and execute the following commands:

   Note: Make sure to change GoldenGate owner placeholder with actual name of database user as created in previous step.

   - grant CREATE SESSION,CONNECT,RESOURCE,ALTER SYSTEM to <GoldenGate Owner>;
   - grant unlimited tablespace to <GoldenGate owner> with admin option;
   - EXECUTE dbms_goldengate_auth.grant_admin_privilege(''<GoldenGate Owner>',''capture'');
   - grant unlimited tablespace to <GoldenGate Owner> with admin option;
   - Revoke dba from <GoldenGate Owner>;
   - grant create any view to <GoldenGate Owner>;
   - grant select any dictionary to <GoldenGate Owner>;
   - GRANT CREATE ANY DIRECTORY TO <GoldenGate Owner>;
   - GRANT DROP ANY DIRECTORY TO <GoldenGate Owner>;
   - GRANT EXP_FULL_DATABASE TO <GoldenGate Owner>;
   - GRANT IMP_FULL_DATABASE TO <GoldenGate Owner>;

14. Connect to the source application ADM schema such as CISADM, and execute the below commands:

   For Oracle Utilities Customer Care and Billing source database, execute the following grants:

   - Grant select on F1_MST_CONFIG to <GoldenGate owner user created in the step mentioned above>
   - Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in the step mentioned above>
   - Grant select on F1_BKT_CONFIG to <GoldenGate owner user created in the step mentioned above>
   - Grant select on F1_BKT_CONFIG_VAL to <GoldenGate owner user created in the step mentioned above>

   For Oracle Utilities Operational Device Management source database, execute the following grants:

   - Grant select on F1_MST_CONFIG to <GoldenGate owner user created in the step mentioned above>
   - Grant select on F1_EXT_LOOKUP_VAL to <GoldenGate owner user created in the step mentioned above>

   For Oracle Utilities Meter Data Management source database, execute the following grants:

   - Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;
   - Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;

   For Oracle Utilities Work and Asset Management source database, execute the following grants:

   - Grant select on <application ADM Schema>.F1_EXT_LOOKUP_VAL to <GoldenGate Owner>;
Grant select on <application ADM Schema>.F1_MST_CONFIG to <GoldenGate Owner>;

Grant select on <application ADM Schema>. F1_BKT_CONFIG to <GoldenGate Owner>;

Grant select on <application ADM Schema>. F1_BKT_CONFIG_VAL to <GoldenGate Owner>;

Note: While executing the SQL commands in the steps 15, 16 and 17, provide the GoldenGate owner user if prompted for. All the scripts mentioned below are located in GoldenGate Home directory and must be executed after connecting to the sys user.

15. Run the command:
   @marker_setup.sql
16. Run the command:
   @ddl_setup.sql
17. Run the command:
   @role_setup.sql
18. Exit the SQL*Plus login and create a directory named diroby inside OGG_Home directory.
19. Change directory to the Oracle GoldenGate home directory, and execute the following steps:

   Configuration for Encrypting Data with the ENCKEYS Method

   a. Execute the following command:
      cd <OGG_HOME>
      KEYGEN key_length n

      The above command generates the key value based on the value specified in the parameter "n". The key value has to be copied to ENCKEYS file against a logical name.

   b. For each key value generated above, provide a logical name (Logical name should not be the same for two different key values). Enter the logical name space and then key value in the ENCKEYS file.

   c. Repeat the step above for each key values generated.

   d. Save the file with name ENCKEYS (Upper case only) without any extension.

      Example:
      cd $OGG_HOME
      ./keygen 128 1
      0x8CE55035DD6893205A7BD6773FA8E670

   e. Open a new ASCII ENCKEYS file if it does not exist for adding a new entry or open an existing ENCKEYS text file to append.

   f. Input the Logical name, space and key value generated.

      Example contents of file ENCKEYS:
      CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670

   g. The source ENCKEYS file entry has to be appended to the intermediate server or target server which would be configured with the source system where target OGG is being configured.
**Note**: It is recommended to name Logical key name after `<context_code>KEY`. For example: if context code is CCB1, it is recommended to name CCB1KEY.

**Generating the Shared Secret Password**

a. Execute the following command:

```
cd <OGG_HOME>
ggsci
ENCRYPT PASSWORD <GG Owner password> <algorithm> ENCRYPTKEY <key_name>
```

Example:

```
cd $OGG_HOME
./ggsci
GGSCI (hostname) 1> ENCRYPT PASSWORD CCB01SRC AES128 ENCRYPTKEY CCB1KEY
Encrypted password:
AADAAAAAAIAAVGNHBFLGFCHBTFHUEJGNCFAOAFEFOBAELEISPOEIFWGRBZHCMMGYBDAGZH
Algorithm used: AES128
```

b. Note down the above generated ENCKEYS file Logical name/key value, algorithm name used and the generated Encrypted password.

**Setting up Oracle GoldenGate on the Target Database Server**

Perform the following steps:

1. Create a directory on the target database server. For example, `../GoldenGateHome`. Oracle GoldenGate should be installed in this directory. This will be **Oracle GoldenGate home (OGG_Home)** on the target Oracle Utilities Analytics database server.

   **Important Note**: Make a note of this directory location; it will be used during the Oracle Utilities Analytics installation.

2. Install Oracle GoldenGate software and provide the GoldenGate Home location as the directory location created in the step 1.

3. Open a Command window and set the target `ORACLE_SID` and `ORACLE_HOME` variables.

   Set `LD_LIBRARY_PATH` using the following commands:

   For Unix:
   ```
   export LD_LIBRARY_PATH=$ORACLE_HOME/lib:$LD_LIBRARY_PATH
   ```

   For Windows:
   ```
   set LD_LIBRARY_PATH=%ORACLE_HOME%/lib:%LD_LIBRARY_PATH%
   ```

4. In the Command window, change the directory to the **GoldenGate home directory** and execute the command:

   For Unix:
   ```
   ./ggsci
   ```

   For Windows:
   ```
   ggsci
   ```

   This opens the Oracle GoldenGate prompt.

5. On the **Oracle GoldenGate** prompt, execute the `create SUBDIRS` command.
6. On the **Oracle GoldenGate** prompt, execute the `start mgr` command to start the Oracle GoldenGate manager process.

7. On the **Oracle GoldenGate** prompt, execute the `info all` command to view the manager process is running.

8. Exit Oracle GoldenGate by executing `exit` command and create a directory named `diroby` inside the `OGG_Home` directory.

9. Connect to the target database as the `sys` user and execute below statement:

   ```sql
   alter system set enable_goldengate_replication=TRUE scope=both;
   ```

10. Go to `OGG_Home` directory.

11. If `ENCKEYS` file does not exist, open a new ASCII `ENCKEYS` file and add those key value/values generated on the sources to `ENCKEYS` file in target OGG home for the context codes for which source configuration is being done.

    Example contents of `ENCKEYS` file in target OGG home:

    ```
    CCB1KEY 0x8CE55035DD6893205A7BD6773FA8E670
    ```

**Setting up Oracle GoldenGate JAgent on Target and Source Database Servers**

GoldenGate JAgent setup should be done on Oracle Utilities Analytics GoldenGate server and on all the source application GoldenGate servers.

Follow these steps to setup GoldenGate on target and source servers:

After the Oracle GoldenGate software is installed and the Manager is running, follow the below steps to configure the JAGENT.

1. Start the `rmiregistry` services and note down the port on which RMI server is started. Use the following command:

   ```
   rmiregistry 5559 &
   ```

   Here, we have specified port number as 5559. If the port number is not specified, default port 1099 is used.

2. Edit the `Config.properties` file in the `<GG home>/cfg` and add/modify the below parameters.

   ```
   <ACTUAL>   : jagent.host=localhost
   <CHANGE TO> : jagent.host<<actual hostname on which OGG is installed>>
   <ACTUAL>    : monitor.jmx.username=cmroot
   <CHANGE TO> : monitor.jmx.username=jmx_src
   <ACTUAL>   : jagent.username=root
   <CHANGE TO> : jagent.username<<OGG software installed OS user>>
   <ACTUAL>    : jagent.rmi.port=5559
   <CHANGE TO> : jagent.rmi.port=5557 or any free port other than the one on which the rmiregistry is started
   <ACTUAL>    : agent.type.enabled=OGGMON
   <CHANGE TO> : agent.type.enabled=OEM
   ```

3. Add the following parameter:

   ```
   jagent.ssl=false
   ```

4. Edit the `GLOBALS` file in the `<GG home>` and add the below command.

   ```
   EnableMonitoring
   ```

5. Execute the below command from `<GG Home>`

   For Unix:

   ```
   ./pw_agent_util.sh -jagentonly
   ```
For Windows:

   pw_agent_util.bat -jagentonly

6. Enter the Oracle wallet password. This password has to be entered as the password for the JAGENT while running the installer (for target gg) and while running source configuration (for source gg). Please make a note of the password.

7. Create a folder with the Context_code name in <GG Home>/dirdat

   For example: If WAM2 is the context being created for the WAM source then create a folder with name "WAM2" within the <GG Home>/dirdat/ folder.

8. Create a folder with name in <GG Home>/diroby

9. Go to OGG_Home directory and go to the GoldenGate prompt:

    ggsci

10. Start the jAgent process using the following command:

    start jagent

Copying and Decompressing the Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.6.0 Multiplatform part (Oracle Utilities Analytics V2.6.0 Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).

2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.

3. Unzip Oracle Utilities Analytics V2.6.0 Multiplatform.zip to <TEMPDIR>.

Starting the Installer

1. Go to the temporary folder where you have downloaded the installer and run the following command from this folder:

   java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest

   Note: The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7

3. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

   Note: If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:\spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

Upgrade Steps

To install Oracle Data Integrator Based ETL, perform the following steps

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location and click Next.
3. The Select Installation Type page appears. In the Select Installation Type page, select ODI Based ETL and click Next.

**Note:** Based on the selected installation type, the options on the left navigation panel changes. When you select Oracle Data Integrator Based ETL as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details, Oracle Data Integrator Home and Schema Details, Oracle Data Integrator Agent and Repository Details and Target GoldenGate Details.

4. The Database and Java Home Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>This is the JDK home location.</td>
<td>Provide location of JDK 1.7 Example: /u01/jdk_1.7.0.75</td>
</tr>
</tbody>
</table>

5. The Target Database Connection Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

6. The ODI Home and Schema Details page. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Home</td>
<td>The directory where Oracle Data Integrator (ODI) has been installed.</td>
<td>Example: /u01/Middleware/Oracle_ODI1</td>
</tr>
<tr>
<td>Supervisor User</td>
<td>The name of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR</td>
</tr>
</tbody>
</table>
7. The **ODI Agent and Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor Password</td>
<td>The password of the Oracle Data Integrator Supervisor.</td>
<td>SUPERVISOR user password</td>
</tr>
<tr>
<td>Confirm Supervisor Password</td>
<td>Confirm the password of the Supervisor here.</td>
<td></td>
</tr>
<tr>
<td>Master Repository Schema Name</td>
<td>Oracle Data Integrator master repository schema name.</td>
<td>OUA_MASTER</td>
</tr>
<tr>
<td>Master Repository Schema Password</td>
<td>The password of the master repository schema.</td>
<td>OUA_MASTER user's password</td>
</tr>
<tr>
<td>Confirm Master Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator master repository schema here.</td>
<td></td>
</tr>
<tr>
<td>Work Repository Schema Name</td>
<td>Oracle Data Integrator work repository schema name.</td>
<td>OUA_WORK</td>
</tr>
<tr>
<td>Work Repository Schema Password</td>
<td>The password of the work repository schema.</td>
<td>OUA_WORK user's password</td>
</tr>
<tr>
<td>Confirm Work Repository Schema Password</td>
<td>Confirm the password of the Oracle Data Integrator work repository schema here.</td>
<td></td>
</tr>
</tbody>
</table>

8. The **Target GoldenGate Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>ODI Agent Host</td>
<td>The host on which Oracle Data Integrator WebLogic Domain is created.</td>
<td>It is Oracle Data Integrator Server host name.</td>
</tr>
<tr>
<td>ODI Agent Port</td>
<td>The port on which Oracle Data Integrator WebLogic agent is configured to run. This is the port of Oracle Data Integrator WebLogic Managed Server Port.</td>
<td>Provide available port and make sure to use the same port while creating Oracle Data Integrator managed server.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>GoldenGate Host</td>
<td>The host on the Oracle GoldenGate Manager.</td>
<td>Example: /opt/local/ggs_12.1.2.1.0</td>
</tr>
<tr>
<td>GoldenGate Home</td>
<td>This is the Oracle GoldenGate installed location.</td>
<td>Example: /opt/local/ggs_12.1.2.1.0</td>
</tr>
</tbody>
</table>
9. The **Target JAgent Details** page appears. Enter the target JAgent server details in the respective fields and click Next

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Database Home</td>
<td>This is the database home installed location on the target database server. In case GoldenGate for target is not installed on the OUA database server, provide oracle client home location on the server on which GoldenGate is installed.</td>
<td>Example: /u00/oracle/app/oracle/product/12.1.0.2.0/dbhome_1</td>
</tr>
<tr>
<td>GoldenGate Manager</td>
<td>The port number on which Oracle GoldenGate Manager is running on the GoldenGate host.</td>
<td>The default value is 7830</td>
</tr>
<tr>
<td>GoldenGate Algorithm</td>
<td>This is the algorithm configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is BLOWFISH.</td>
</tr>
<tr>
<td>GoldenGate Encryptkey</td>
<td>This is the Encrypt Key configured in Oracle GoldenGate on the target database server.</td>
<td>The default value is “DEFAULT”.</td>
</tr>
<tr>
<td>GoldenGate Shared</td>
<td>This is shared secret key configured in Oracle GoldenGate on the target database server. The default value is &quot;DEFAULT&quot;.</td>
<td>Go to the Oracle GoldenGate prompt and run the command: encrypt password &lt;password of MDADM user&gt;, encryptkey DEFAULT Provide the result of above command as the value.</td>
</tr>
<tr>
<td>Secret</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>JAgent Host</td>
<td>The host of the Oracle GoldenGate JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent GoldenGate</td>
<td>This is the Oracle GoldenGate installed location where GoldenGate JAgent is running.</td>
<td>Example: /opt/local/ggs_12.1.2.1.0</td>
</tr>
<tr>
<td>JAgent Port</td>
<td>Use the JAgent RMI port which is defined in the config properties file.</td>
<td></td>
</tr>
<tr>
<td>JAgent User</td>
<td>This is the OS user which is used to configure JAgent.</td>
<td></td>
</tr>
<tr>
<td>JAgent Wallet Password</td>
<td>This is the JAgent Wallet password.</td>
<td></td>
</tr>
</tbody>
</table>
10. The **Installation Summary** page appears. Verify the installation options you selected.

11. Click **Install** to begin the installation.

   If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

12. The **Installation Progress** page appears which allows you to see the progress of the installation. Operations being performed as a part of the installation are logged to the terminal from which the installer was run. The Detailed logs of the installation are also available in the logs/system directory under the installation location.

   If you want to quit before the installation is completed, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

13. In the **Installation Completed** page, click **Finish** to close the installer.

The Oracle Data Integrator based ETL is now installed.

**Creating the WebLogic Domain for Oracle Data Integrator Agent**

The WebLogic Domain should be created for bringing up the WebLogic Agent (ODI Agent) to complete the steps.

Perform the following steps to bring up the WebLogic ODI Agent:

1. Navigate to the Oracle Data Integrator (ODI) installed location `<MW_HOME>/oracle_common/common/bin`, run the below command and follow the steps to provide the masterschema and workschema provided in the configuration.

   For Unix:
   - Run `./config.sh`

   For Windows:
   - Run `config.cmd`

2. Create a new WebLogic domain.

   Choose option to create a new domain in Configuration Type screen and select correct Domain Location.

   Recommended domain location is `$ODI_ORACLE_HOME/Oracle_Home/user_projects/domains/odi_domain`

   Click **Next**.

3. On the Templates screen, make sure **Create Domain Using Product Templates** is selected, and then select the following templates:

   - Oracle Enterprise Manager Plugin for ODI - 12.1.3.0 [em]
     Selecting this template automatically selects the following as dependencies:
     - Oracle Enterprise Manager - 12.1.3.0 [em]
     - Oracle JRF - 12.1.3.0 [oracle_common]
     - WebLogic Coherence Cluster Extension - 12.1.3.0 [wlserver]
     - Oracle Data Integrator - Agent - 12.1.3.0 [odi]

     Selecting this template automatically selects the following as dependencies:
- Oracle Data Integrator - Agent Libraries - 12.1.3.0 [odi]
- Oracle Data Integrator SDK Shared Library Template - 12.1.3.0 [odi]
- Oracle Data Integrator - Console - 12.1.3.0 [odi]

Click **Next** to proceed.

4. On the **Application Location** page, you do not need to edit any values.

Click **Next** to proceed.

5. Configure the **Administrator User Name** and **Password** for WebLogic. Provide the WebLogic password.

Click **Next**.

6. On the Domain Mode and JDK page:
   - Select the **Production Mode** option.
   - Provide the **JDK 1.7.0_75+**

7. On the **Database Configuration Type** page, select RCU data option in auto configuration option.

Enter <prefix>_STB schema details, database details and click 'Get RCU Configuration’ button.

Click **Next** to proceed.


Select only the **ODI Master Schema** checkbox. Provide the following details:
   - DBMS/Service: Target Database Name
   - Host Name: Database Serverhost
   - Port: Database Port
   - Schema Owner: OUA_MASTER
   - Schema Password: OUA_MASTER Password

9. Deselect the **ODI Master Schema** checkbox.

10. Select the **ODI Work Schema** checkbox. Provide the below details:

    - DBMS/Service: Target Database Name
    - Host Name: Database Serverhost
    - Port: Database Port
    - Schema Owner: OUA_WORK
    - Schema Password: OUA_WORK Password

Click **Next** to proceed.

11. On the **JDBC Component Schema Test** page, test the JDBC Component Schema by selecting the **Select All** and clicking the **Test Selected Connections**.

Click **Next** to proceed.
12. On the **Credentials** page, specify SUPERVISOR username credentials, click on +ADD button to add odi_domain credentials. The screen capture is as following, ensure it is done correctly.

![Credentials Page](image)

13. On the **Advanced Configuration** page, select the following options:

- Administration Server
- Managed servers, Clusters and Coherence

Click **Next** to proceed.

14. On the **Administration Server** page,

- Provide the **Listening Port**, which is not in use.

Click **Next** to proceed.

15. Configure the **Managed Servers** by providing the following:

- **Server Name**: odi_server1
- **Listen Address**: All Local Addresses
- **Port**: Provide the port, which is provided in the step 8 in the section Installation Steps.

16. Configure the **Cluster**.

Click **Next**.

17. Configure the **Coherence Cluster**.

Click **Next**.

18. Configure the **Machines**.

Click **Next**.

19. On the **Configuration Summary** page, click **Create** to create the domain odi_domain.

20. Ensure configuration is successfully done.

21. Click **Next** to proceed.

22. After the domain is created, go to the domain location, create the boot.properties file for WebLogic login. Create the `<MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security` folder if not present.

23. Go to `<MW_HOME>/user_projects/domains/odi_domain/servers/AdminServer/security`, then create boot.properties file with the below values:
24. Create the $MW_HOME$/user_projects/domains/odi_domain/servers/odi_server1/security folder if not present.

25. Go to $MW_HOME$/user_projects/domains/odi_domain/servers/odi_server1/security, and then create boot.properties file with the below values:

- username=weblogic
- password=Weblogic password

Starting the WebLogic Admin Server

Perform the following steps:

1. In the command shell, change the directory to the directory of the WLS Home - $MW_HOME$/user_projects/domains/odi_domain/bin.
2. Execute the startweblogic command for UNIX and Windows:
   
   **For Unix:**
   ```
   nohup ./startWebLogic.sh > startWebLogic.log &
   ```
   
   **For Windows:**
   ```
   startWebLogic.cmd
   ```

Starting the Managed Server odi_server1

Perform the following steps:

1. To start managed server odi_server1, change the directory to the WLS Home:
   Execute the following commands:
   
   **For Unix:**
   ```
   <MW_HOME>/user_projects/domains/odi_domain/bin
   nohup ./startManagedWebLogic.sh odi_server1 > StartManagedWeblogic.log &
   ```
   
   **For Windows:**
   ```
   StartManagedWeblogic.cmd odi_server1
   ```
2. From the Oracle Data Integrator Studio, navigate to Topology > Agents > OracleDIAgent. Right-click on OracleDIAgent and click Test to test connectivity of configured Oracle Data Integrator Java EE agent.

Executing Post-Upgrade Script

Perform the following steps to execute the post-upgrade script:

1. Execute B1_MDFIX_ODM_260 in global context.
2. Login to ODI Client and go to Designer Tab.
3. Navigate to Load Plans and Scenario Folders.
5. Right click B1_MDFIX_ODM_260, click Run and select the context as Global and click OK.

Creating a Database Directory

Create a database directory 'B1_DATA_DUMP_DIR' on the target database as well as on each source database. This directory is used for logging the export import task used during the initial
ELT load. The following is a sample SQL that creates the database directory pointing to the file system path `/scratch/file_data`:

```sql
CREATE DIRECTORY B1_DATA_DUMP_DIR AS '/scratch/file_data';
```

**Configuring Source Applications**

To configure source applications such as Oracle Utilities Meter Data Management, Oracle Utilities Mobile Workforce Management, Oracle Utilities Network Management System, which were earlier configured with Oracle Warehouse Builder, refer to section **Configuring Source** in the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.

For the other source applications, such as Oracle Utilities Customer Care Billing, Oracle Utilities Operational Device Management, which were earlier configured with Oracle Data Integrator, perform the following steps mentioned in the below sections:

- **Prerequisites**
- **Configuration Steps**

**Prerequisites**

Make sure oracle data integrator (ODI) domain is created and Admin and managed servers are running before running the source configuration tool.

**Configuration Steps**

To configure the source applications, perform the following steps:

1. Perform the steps for registering a source as described in the Registering a Source section in the Chapter 5: Configuring Oracle Utilities Analytics in Oracle Utilities Analytics Administration Guide.
2. Please use the same context_codes to configure the existing Sources during the upgrade.
3. After config.sh GUI utility execution, execute B1_SYNC_CONTEXT.
   a. To execute B1_SYNC_CONTEXT package, login to Oracle Data Integrator Studio.
   b. Go to Designer.
   c. Navigate to Load Plans and Scenarios> Framework.
   d. Right-click on B1_SYNC_CONTEXT and select Run option.
4. Select the context related to the source application, <no agent> as logical agent, and then click OK.

5. After B1_SYNC_CONTEXT execution, execute B1_INITIAL_SETUP_PKG.
   
   **Note:** It is recommended to run B1_INITIAL_SETUP_PKG only once i.e. after all the sources have been configured or after at least one source is configured
   
   a. To execute B1_INITIAL_SETUP_PKG package, login to Oracle Data Integrator Studio.
   
   b. Go to Designer.
   
   c. Navigate to Load Plans and Scenarios > Framework.
   
   d. Right-click B1_INITIAL_SETUP_PKG, choose GLOBAL context code and select Run option.

   
   a. Login to Oracle Data Integrator Studio.
   
   b. Go to Designer.
   

7. Start all the OGG processes on source and target:
   
   a. Login into each source application Golden Gate server.
   
   b. Go to respective Oracle Golden gate Home directory.
   
   c. Start manager, JAgent and all the respective context extract processes.
   
   d. Login into Target Oracle Utilities Analytics (OUA) Golden Gate server.
   
   e. Go to Oracle Golden gate Home directory.
f. Start manager, jagent and all the respective context extract processes.

8. Start the source application server:
   a. Login into each source application
   b. Start the application and ensure application is up and accessible.

9. Update the slice_start_dttm in B1_JOB_CONFIG table for the product based on the time noted in Step 3.
   The time is the one we noted when we generated final extract from the source application and upload to the warehouse database.
   Please read 'Upgrading Oracle Utilities Analytics' chapter 5 of Oracle Utilities Analytics Admin Guide for upgrade statement and for a specific source product.
Upgrading Oracle Utilities Analytics Administration Tool Component

The instructions for upgrading Oracle Utilities Analytics Administration Tool Component from v2.5.0.0.5 are the same as the instructions for upgrading from v2.5.1.2 or v2.5.2.0.1.

Please follow the steps detailed in Chapter 4: Upgrading Oracle Utilities Analytics Administration Tool Component to upgrade the Administration Tool Component.
Upgrading Oracle Utilities Analytics Dashboards Components

The instructions for upgrading Oracle Utilities Analytics Dashboard Components from v2.5.0.0.5 are the same as the instructions for upgrading from v2.5.1.2 or v2.5.2.0.1.

Please follow the steps detailed in Chapter 4: Upgrading Oracle Utilities Analytics Administration Tool Component to upgrade the Analytics Dashboard Component.
Chapter 6
Installing Demo Database

This chapter provides instructions for installing the demo database.

Note: The demo installation does not support ETL functionality. The ETL Job Control dashboard accesses the Oracle Data Integrator tables, and the demo dump does not have Oracle Data Integrator objects. Hence, the ETL dashboard is not supported in the demo installation.

The chapter includes the following topics:

• Installing Oracle Utilities Analytics Demo Database Component
• Installing Oracle Utilities Analytics Dashboards Component

Installing Oracle Utilities Analytics Demo Database Component

This section describes how to install the demo component of Oracle Utilities Analytics. The section includes the following:

• Copying and Decompressing the Install Media
• Creating the Database and Importing the Dump File
• Configuring the Security
• Configuring the Spatial Data

Copying and Decompressing the Install Media

To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Analytics V2.6.0 Demo Data part (Oracle Utilities Analytics V2.6.0 Demo Data.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).
2. Create a temporary directory such as c:\OUA\temp or /OUA/temp (Referred to <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as part of the installation, can be deleted after completing a successful installation.
3. Unzip Oracle Utilities Analytics V2.6.0 Demo Data.zip to <TEMPDIR>.
Creating the Database and Importing the Dump File

This section describes how to create the demo database with AL32UTF8 character set using the database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for Windows), including:

- UNIX Database Creation Utility
- Windows Database Creation Utility
- Importing Demo Data Manually
- Post-Import Tasks

Ensure that Oracle Database Server Enterprise Edition 12.1.0.2.0 is already installed on the machine in order to create the database.

The UNIX and Windows database creation utilities creates an empty database with AL32UTF8 character set and at least one tablespace for storing the application objects before running the installation. The default name of the application tablespace is CISTS_01.

If you get the following error messages while importing demo data, it is recommended to ignore:

ORA-31684: Object type USER:"MDADM" already exists
ORA-31684: Object type USER:"RELADM" already exists
ORA-31684: Object type USER:"DWADM" already exists

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT EXECUTE ON "MDADM"."B1_TEXT_ARRAY" TO "CCB1REP"

ORA-39083: Object type OBJECT_GRANT failed to create with error:
ORA-01917: user or role 'CCB1REP' does not exist
Failing sql is:
GRANT SELECT ON "MDADM"."B1_PROD_INSTANCE" TO "CCB1REP"

Job "SYSTEM"."SYS_IMPORT_SCHEMA_01" completed with 5 error(s)

UNIX Database Creation Utility

The files are located in BI260/DatabaseCreation/Unix to create the database.

1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX server.
2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.
3. Execute the utility cdxdba.plx by executing the following command:
   perl cdxdba.plx
4. Provide the following parameter values when the script prompts:
   - Instance name (DEMO): DEMO
   - ORACLE_BASE: The directory where the setup files for the database will be created (/oraw/app/oracle):
   - ORACLE_HOME: The folder where the current version of Oracle software is installed (/oraw/app/oracle/product/):
   - ORACLE_DATA: The directory where the data files for the database will be created (/db05/oradata):
   - Character set for the database (AL32UTF8):
5. Enter the values based on the settings of your database server. You can also accept the default values displayed if they match your database server settings. You will be prompted to confirm the settings and select Y or N to create the database.

ORACLE_SID: DEMO
ORACLE_HOME: /orasw/app/oracle/product/
ORACLE_BASE: /orasw/app/oracle
ORACLE_DATA: /db05/oradata
Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select Y to import the Demo Install data.

For the demo installation use the dump file exp_demo.dmp.

Do you want to import a demo database dump into this database (Y/N)? Y

Enter the name of the dump file (exp_demo.dmp):

Enter the name of the dump file directory (data_pump_dir):

Enter the name of the log file (exp_demo.log):

Note: The dump_dir must exist in the created database before continuing with the import. You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the exp_demo.dmp.gz file first to extract the exp_demo.dmp file. This file is in ..\BI260\Demo directory.

Update the oratab file for the new database, and then check the connectivity to this database from another server and from your desktop after updating local tnsnames.ora file.

Windows Database Creation Utility

The files are located in ..\BI260\DatabaseCreation\Windows. You should be logged in as a user who is a member of local ORA_DBA group on that server. The ORA_DBA group should have “Administrator” privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from command prompt. The utility displays the following options:

E - Export a schema from the database
R - Refresh a schema with a database dump
C - Create/Recreate a local database
H - See help for the command line options
Q - Quit

2. Select the option C to create an empty database on your machine and provide the below inputs:

• Provide the instance name (DEMO): <DB Name> For example, BIDEMO.
• Enter the character set of the database (AL32UTF8): AL32UTF8.
• Enter ORACLE_BASE: The directory where the setup files for the database will be created (c:\oracle): <Oracle_Base> For example, C:\app\oracle.
• Enter ORACLE_HOME: The folder where the current version of Oracle software is installed (c:\oracle\product\11.1.0.6\Db_1)<Oracle_Home> For example, c:\app\oracle\db_home.
• Enter ORACLE_DATA: The directory where the data files for the database will be created (C:\app\oracle\oradata)<Directory where data files will be created>.

3. Once the database has been created, select the R - Refresh a schema option with a database dump file to load the demo install data.
   • Select an option: R
   • Enter the instance name (DEMO): <DB name>.
   • Is it a LOCAL database (exists on the same machine) (Y/N): < provide Y or N>.
   • Enter the name of the Oracle account that owns that application schema (spladm): DWADM.
   • Enter the password for DWADM (spladm): DWADM.
   • Enter the character set of the database (AL32UTF8): AL32UTF8.
   • Enter the name of data pump directory (DATA_PUMP_DIR): DATA_PUMP_DIR.
   • Enter the name of the dump file (expDWADM.dmp): exp_demo.dmp.
   • Enter the name of the log file (impDWADM.log): exp_demo.log.

The option R causes the utility to drop all the objects from the schema and import the schema from a database dump file.

For the demo installation, use the exp_demo.dmp dump file.

   Note: The dump_dir must exist in the database created above before continuing with the import. You should also copy the exp_demo.dmp file to the dump_dir. Uncompress the exp_demo.dmp.gz file to extract the exp_demo.dmp file. This file is in the ..\BI260\Demo directory.

Check the connectivity to this database from another server and from your desktop after updating the local tnsnames.ora file.

Importing Demo Data Manually
The demo data can also be imported by using the below command after successful database creation.

   Note: Run this command from the database server:

   Note: Make sure to change the tablespace_name to the tablespace name on which DWADM, RELADM and MDADM have the quota. If DWADM, RELADM and MDADM users have quota on cists_01 tablespace, then exclude whole remap_tablespace clause from the command.

1. Set the correct ORACLE_SID and ORACLE_HOME first, and then run below command to import demo dump.

   impdp directory= dump_dir dumpfile= exp_demo.dmp logfile= exp_demo.log schemas=DWADM,RELADM,MDADM
   remap_tablespace=cists_01:<tablespace_name>

2. Provide the system as the user and system user's password when prompted.
**Post-Import Tasks**

Connect to MDADM schema, and execute the below commands:

```
create public synonym B1_TARGET_ENTITY for B1_TARGET_ENTITY;
create public synonym B1_PROD_INSTANCE for B1_PROD_INSTANCE;
create public synonym B1_JOB_CONFIG for B1_JOB_CONFIG;
grant select on B1_TARGET_ENTITY to public;
grant select on B1_PROD_INSTANCE to public;
grant select on B1_JOB_CONFIG to public;
```

**Configuring the Security**

For configuring the security, perform the following steps:

1. Navigate to the ..\BI 260\DWADM\Security folder.
2. Edit the file `OraGenSec.bat`, which is in the same location, and replace the parameter `database-name` with the name of your database. This file is provided for your convenience and executes the `Oragensec.exe` utility based on the parameters passed into it.

   **Note**: Ensure to run `OraGenSec.bat` from a Windows desktop that has the Oracle 12c 32 bit client installed. Your database should already be listed in the local file `tnsnames.ora`.

   The script executes as the following:

   ```
oragensec -d DWADM,<DWADM password>,database_name -r DW_READ,DW_USER - a A -u DWUSER,DWREAD
   ```

3. Execute the edited `OraGenSec.bat` file from the command prompt.

**Configuring the Spatial Data**

This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities Analytics.

Use the following procedure to load spatial metadata in the target database:

1. Create the `dump_dir` directory in the database and copy the `user_sdo.dmp` file from ../BI260/Spatial-Metadata folder to that location.
2. Import the released spatial tables to the target database using the following command:

   ```
   impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=impdp_user_sdo.log schemas=DWADM
   remap_tablespace=cists_01:<tablespace_name>
   ```

   **Note**: Run this command from database server.

   **Note**: Make sure to change the `tablespace_name` to `tablespace` name on which DWADM has the quota. If DWADM user have quota on cists_01 tablespace, then exclude whole `remap_tablespace` clause from command.

3. Review the `impdp_user_sdo.log` file to ensure the tables are imported successfully.
4. After importing the tables, run the following SQL scripts from the ../BI260/Spatial-Metadata folder:

   ```
   - sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql
   - sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql
   ```

5. Review the log files.
Installing Oracle Utilities Analytics Dashboards Component

Ensure that the same Operating System (OS) user is used to install the Oracle Utilities Analytics Dashboards component that is used to install all the prerequisite software.

Verify that the prerequisite software products mentioned in the section Prerequisite Software for Oracle Utilities Analytics Dashboards Component are installed.

Install the Oracle Utilities Analytics Dashboards component on the Oracle Utilities Analytics application server.

This section describes how to install the dashboards component of Oracle Utilities Analytics. The section includes the following:

- Copying and Decompressing the Install Media
- Starting the Installer
- Installation Steps
- Deploying the Repository (RPD) File
- Deploying the Web Catalog
- Configuring and Deploying the MapViewer
- Post-deploying the Custom MapViewer
- Enabling WriteBack
- Deploying the Analytics EAR
- Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 11.1.1.9.1

Copying and Decompressing the Install Media

To download and decompress the install media, perform these steps:

1. Download the Oracle Utilities Analytics version 2.6.0 ELT component based on Oracle Data Integrator part (Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip) from the Oracle Software Delivery Cloud (https://edelivery.oracle.com).
2. Create a temporary directory, such as c:\OUA\temp or /OUA/temp (Referred to as <TEMPDIR> below). This directory must be located outside any current working Oracle Utilities application environment. All files that are placed in this directory as a part of the installation can be deleted after completing a successful installation.
3. Unzip Oracle Utilities Analytics V2.6.0 Oracle Database Multiplatform.zip to <TEMPDIR>.

Starting the Installer

Go to the temporary folder where you have downloaded the install and run the following command from this folder:

```bash
java -jar <TEMPDIR>/OUA_2.6.0.0.0_generic.jar -logLevel finest
```

**Note:** The minimum JDK required for running the Oracle Utilities Analytics installer is JDK 1.7.

The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.
A navigation pane on the left that summarizes the tasks the installer will help you complete. Each item in the navigation pane represents a specific installer screen that will prompt you for information required to install the software.

Note: If you are running the installer multiple times on a server, check for a file named ENVIRON.INI in /tmp (in Unix) and C:\spl\temp (in Windows). If the file exists, delete the file before invoking the installer.

Installation Steps

To install the Dashboards, perform the following steps:

1. Run the Oracle Utilities Analytics Installer. The Welcome page appears. Review this information before you begin the installation and click Next to continue with the installation.

2. The Installation Location page appears. Define the Installation Location here and click Next.

   Note: The specified Oracle home directory must be an empty directory.

3. The Select Installation Type page appears. In the Select Installation Type page, select Dashboards and click Next.

   Based on the selected installation type, the options on the left navigation panel changes. When you select Dashboard as an Installation Type, you need to define Database and Java Home Details, Target Database Connection Details and OBIEE Home Details.

4. The Database and Java Home Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database Client Home</td>
<td>This is the database client home location.</td>
<td>Example: /u01/app/product/12.1.0/dbhome_1</td>
</tr>
<tr>
<td>Java Home</td>
<td>This is the JDK home location.</td>
<td>Provide location of JDK 1.7 (1.7.0_75)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example: /u01/jdk_1.7.0_75</td>
</tr>
</tbody>
</table>

5. The Target Database Connection Details page appears. Enter the following details in the respective fields and click Next:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host</td>
<td>The host name of the server where the database resides.</td>
<td>Oracle Utilities Analytics Database Server</td>
</tr>
<tr>
<td>Port</td>
<td>The database port number on the database server used for connecting to the database.</td>
<td>Oracle Utilities Analytics Database Port. The default value is 1521.</td>
</tr>
<tr>
<td>Service Name</td>
<td>The service name for the database</td>
<td></td>
</tr>
<tr>
<td>Target Schema Password</td>
<td>The password for the target schema (DWADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Target Schema Password</td>
<td>Confirm the password for the target schema (DWADM) here.</td>
<td></td>
</tr>
</tbody>
</table>
6. The **OBIEE Home Details** page appears. Enter the following details in the respective fields and click **Next**:

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metadata Schema Password</td>
<td>The password for the metadata schema (MDADM).</td>
<td></td>
</tr>
<tr>
<td>Confirm Metadata Schema Password</td>
<td>Confirm the password for the metadata (MDADM) schema here.</td>
<td></td>
</tr>
</tbody>
</table>

7. The **Installation Summary** page appears. Verify the installation options here.

8. Click **Install** to begin the installation.

   If you want to make any changes to the configuration before starting the installation, use the navigation pane and select the topic you want to edit.

9. The **Installation Progress** page appears which allows you to see the progress of the installation. Operations being performed as part of the installation are logged to the terminal.
from which the installer was run. Detailed logs of the installation are also available in the logs/system directory under the installation location.

If you want to quit before the installation is completed, click **Cancel**. Doing so will result in a partial installation; the portion of the software that was installed on your system before you click **Cancel** will remain on your system, and you will have to remove it manually.

10. In the **Installation Completed** page, click **Finish** to close the installer.

The Dashboards component is now installed.

### Deploying the Repository (RPD) File

If you have not made any changes to the deployed RPD, then take the RPD file from the following location: `<install_dir>/Reports/rpd/UtilitiesBusinessAnalytics.rpd`, where `<install_dir>` is the Oracle Utilities Analytics Dashboard component installation directory.

If you have done merging, then take the merged RPD and make the required database changes.

This RPD file should be copied to the windows machine on which Oracle Business Intelligence Enterprise Edition 11.1.1.9.1 (Install Oracle Business Intelligence Enterprise Edition 11.1.1.9.0 and apply the patch 21235195) is installed.

Follow these steps to deploy the RPD file:

1. Oracle Business Intelligence Enterprise Edition 11.1.1.9.1 should be installed on the Windows machine before proceeding with the below steps.

2. Launch the **Administration** Tool from the **Start** menu.
   
   **Start > Programs > Oracle Business Intelligence > BI Administration**

3. Open the RPD in offline mode by selecting **File > Open > Offline...**

4. Provide the RPD password. The default password is "oracle123".
5. Edit the **Connection Pools** shown below by double-clicking on them.

![Connection Pools Diagram]

6. In the **Init Block Connection Pool** group, enter the following:
   - Datasource name = BI Database name
   - User name = DWREAD
   - Password = DWREAD User password

7. In the **Init Block Pool - MDM** group, provide the following (only for MDM):
   - Datasource name = MDM database name
   - User name = CISUSER
   - Password = CISUSER User password

8. In the **Materialized Views Connection** group, enter the following:
   - Datasource name = BI Database name
   - User name = DWREAD
   - Password = DWREAD User password

9. In the **MDM Database Connection** group, provide the following (only for MDM):
   - Datasource name = MDM database name
   - User name = CISUSER
   - Password = CISUSER User password

10. In the **ODIDEV Connection Pool** group, provide the following:
    - Datasource name = BI database name
    - User name = DWUSER
    - Password = DWUSER User password

11. In the **OUBI Database Connection** group, provide the following:
    - Datasource name = BI database name
    - User name = DWREAD
    - Password = DWREAD User password
12. Click Save.

   Note: Click Yes when you see the prompt 'Do you wish to check global consistency?' and ignore any warnings that appear after consistency check is complete.

13. Log into the Oracle Business Intelligence Enterprise Edition Enterprise Manager console.

14. Navigate to BI Instance > Coreapplication > Deployment.

15. Lock and edit.

   The repository text box will be enabled.

16. Browse to the modified rpd file and submit.

17. Provide the RPD password “oracle123”, and then click Apply.

18. Activate the changes and then restart Oracle Utilities Analytics services.

   Note: All the above-mentioned database sets of the connection pool should be updated in the tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/admin.

### Deploying the Web Catalog

To deploy the web catalogs, follow these steps:

1. Go to the <Catalog location>/root/shared and delete the existing catalogs that were delivered out-of-box with the Oracle Utilities Analytics product in the previous release. Any catalog added by you can be retained. If Oracle Utilities Network Management System BI publisher reports were deployed, they should be retained.

2. Go to <Catalog location>/root/system and remove spatialmetadata directory and spatialmetadata.atr file.
Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment > Repository for viewing the catalog location. At the bottom, you will see the catalog location.

For UNIX:

1. Navigate to <Install_Dir>/bin directory.
   
   cd <Install_Dir>/bin.

2. Add Java 7 to the path variable as shown in example below:
   
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH

3. Run ksh ./deploycatalog.sh.

4. Enter the physical catalogs location configured in the Enterprise Manager.
   
   Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment > Repository for viewing the catalog location. At the bottom, you will see the catalog location.

For Windows:

1. Navigate to <Install_Dir>/bin directory.

   cd <Install_Dir>/bin.

2. Add Java 7 to the path variable as shown in example below:

   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%

3. Run deploycatalog.cmd.

4. Enter the Physical Catalogs location configured in the Enterprise Manager.

   Note: Login to the Enterprise Manager, navigate to Coreapplication > Deployment > Repository for viewing the catalog location. At the bottom, you will see the catalog location.

Configuring and Deploying the MapViewer

Configuring and deploying the MapViewer involves the following:

• Configuring the MapViewer
• Modifying the instanceconfig.xml
• Deploying the Custom MapViewer

Configuring the MapViewer

To configure Mapviewer, follow these steps:

1. Log into the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' datasource.

3. Lock and edit.

4. Navigate to Services > Data Sources.

5. Select New > Generic Data Source and provide the following:

   Name = MAP_DS
   
   JNDI Name = MAP_DS
   
   Database Type = oracle

6. Click Next.

7. Enter the following:

   Database Driver = *Oracle's Driver (Thin) for Service connections; Versions 9.0.1 and later
8. Click **Next**.
9. Do not change any values on the next page and click **Next**.
10. Enter the following connection properties:
    - Database Name: BI Database Name
    - Host Name: Database host
    - Port: Database port
    - Database User Name: dwadm
    - Password: dwadm password
11. Click **Next**.
12. On the next page, click **Test Configuration** button. After the successful test, click **Next** again.
13. The **Select Target** page opens. Now select AdminServer under **Servers** and bi_cluster under **Clusters**. Click **Finish**.
14. Click **Activate Changes**.
15. Update the mapViewerConfig file with the below-mentioned tags:
   - File location: `<Install Dir>\user_projects\domains\bifoundation_domain\config\fmwconfig\mapviewer`  
   - File: mapViewerConfig.xml
16. If there is a proxy used, insert the list of host names for all the third-party service providers in the `security_config` node.
   - `<proxy_enabled_hosts>`
   - elocation.oracle.com
   - `</proxy_enabled_hosts>`
17. Add the following `ns_data_provider` node:
   - `<ns_data_provider id="obieeNsdp" class="com.oracle.utilities.birdseye.BirdseyeNSDP" />`
18. Add the current `map_tile_server` with the following `map_tile_server` node:
   - `<map_tile_server>`
   - `<tile_storage default_root_path="/mytilecache/"/>`
   - `</map_tile_server>`

**Modifying the instanceconfig.xml**

Update the instanceconfig.xml file after taking a backup.

The following are the examples of location of instanceconfig.xml file.

**For UNIX:**

```
<OBIEE_INSTALL_DIR>/instances/instance1/config/OracleBIPresentationServicesComponent/coreapplication_obips1
```

**For Windows:**

```
<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesComponent\coreapplication_obips1
```

Perform the following changes to the instanceconfig.xml file:
1. Update the security node with the following values. If the security node is not present, add the following code before </ServerInstance>:

```
<Security>
  <ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
  <HttpOnlyCookies>false</HttpOnlyCookies>
  <CookieDomain />
  <CookiePath>/</CookiePath>
</Security>
```

2. Update the following <ServerInstance> element:

```
<LightWriteback>true</LightWriteback>
```

3. Add the following before the end tag </ServerInstance>:

```
<UI>
  <DefaultStyle>oubi</DefaultStyle>
  <DefaultSkin>blafp</DefaultSkin>
</UI>
```

4. Add the following lines in between the <ServerInstance> </ServerInstance> tags.

```
<Prompts>
  <MaxDropDownValues>256</MaxDropDownValues>
  <AutoApplyDashboardPromptValues>true</AutoApplyDashboardPromptValues>
  <AutoSearchPromptDialogBox>true</AutoSearchPromptDialogBox>
  <AutoCompletePromptDropDowns>
    <SupportAutoComplete>true</SupportAutoComplete>
    <CaseInsensitive>true</CaseInsensitive>
    <MatchingLevel>MatchAll</MatchingLevel>
    <ResultsLimit>50</ResultsLimit>
  </AutoCompletePromptDropDowns>
</Prompts>
```

### Deploying the Custom MapViewer

**Note:** The custom MapViewer is required to integrate weather information into Outage Analytics.

To deploy the custom MapViewer, follow these steps:

**For UNIX:**

1. Navigate to <Install_Dir>/bin directory.
   
   ```
   cd <Install_Dir>/bin
   ```

2. Add Java 7 to the path variable as shown in example below:
   
   ```
   export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   ```

3. Run ksh ./deploymapviewer.sh.

4. Enter the WebLogic Domain Console Password. For example, weblogic123.

**For Windows:**

1. Navigate to <Install_Dir>/bin directory.
   
   ```
   cd <Install_Dir>/bin
   ```

2. Add Java 7 to the path variable as shown in example below:
   
   ```
   set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
   ```

3. Run deploymapviewer.cmd.

4. Enter WebLogic Domain Console password. For example, weblogic123.
Post-deploying the Custom MapViewer

Perform the following steps after deploying the custom MapViewer:


2. Update the MapViewer configuration by navigating to MapViewer > Administration > Configuration. Login to the Mapviewer at this location: http://<HOST>:<MANAGERPORT>/mapviewer

3. Add the below content in the mapViewerConfig.xml with the appropriate values:

   <map_data_source name="MAPCONN"
   jdbc_host="<DB server name>"
   jdbc_sid="<DB Service name>"
   jdbc_port="1521"
   jdbc_user="DWADM"
   jdbc_password="!<DWADM user password>"
   jdbc_mode="thin"
   number_of_mappers="32"
   allow_jdbc_theme_based_foi="true"
/>

   Note: The exclamatory mark in the front of the password ensures that the password is encrypted.

4. Click Save, and then restart.

   Note: The above step has to be performed each time after running the deploymapviewer command.

Enabling WriteBack

For enabling the WriteBack, perform the following steps:

1. Log into Analytics and navigate to Administration>Manage Privileges>WriteBack>Write Back to Database.

2. Click Denied:Authenticated User and select the permission Granted.

Deploying the Analytics EAR

To deploy the Analytics' EAR, perform these steps:

1. Run the following commands:

   For UNIX:
   Perform the following steps:
   a. Navigate to <Install_Dir>/bin directory.
      
      cd <Install_Dir>/bin
   b. Add Java 7 to path variable as shown in the example below:
      
      export PATH=/scratch/softwares/jdk1.7.0_71/bin:$PATH
   c. Run ksh ./deployanalyticsear.sh.
   d. Enter the WebLogic Domain Console password. For example, weblogic123.

   For Windows:
   Perform the following steps:
   a. Navigate to <Install_Dir>/bin directory.
      
      cd <Install_Dir>/bin
b. Add Java 7 to the path variable as shown in example below:

```bash
set PATH= C:\Java\jdk1.7.0_79\bin;%PATH%
```
c. Run `deployanalyticsear.cmd`.
d. Enter the WebLogic Domain Console password. For example, weblogic123.
e. Restart the Oracle Utilities Analytics core services.
f. Restart WebLogic and all Oracle Utilities Analytics services after the Oracle Business Intelligence Enterprise Edition deployment is completed.

---

**Enabling the Auto Complete Feature on Oracle Business Intelligence Enterprise Edition 11.1.1.9.1**

To enable auto complete feature on Oracle Business Intelligence Enterprise Edition, perform the following steps:

1. Restart the Oracle Business Intelligence Enterprise Edition admin server, managed server and opmn services.

   **Note**: Refer to Oracle Business Intelligence Enterprise Edition documentation for the detailed instructions on how to start, stop admin server, managed server and opmn services.

2. Login to analytics (http://<Server>:<port>/analytics).
3. Click on the **WebLogic User** (top-most-right section of the page).
4. From the drop-down menu, select **My Account**.
5. Set **Prompt Auto Complete** to **ON**, and click **OK**.
Chapter 7
Spatial Configuration

This chapter contains information on how to setup spatial data for the Oracle Business Intelligence Enterprise Edition dashboards in Oracle Utilities Analytics and how to set up the spatial data. The mapping between the spatial columns and the dimensional columns, such as City, State from the Address dimension is defined in the spatial metadata catalog, which is available as a part of the Web Catalog component in Oracle Utilities Analytics. Using the spatial data and the map metadata, users can view the star schema data in on the map reports delivered out-of-the-box as part of Oracle Utilities Analytics.

This chapter has the following sections:

• Acquiring the Spatial Data
• Installing Spatial Data
• Importing the Spatial Data into Oracle Utilities Analytics Spatial Data Tables
• Loading the Oracle Utilities Specific Themes

Acquiring the Spatial Data

Oracle Utilities Analytics does not include any spatial data. The spatial data can be loaded from the various third party vendors. Some of the spatial data vendors who partner with Oracle can be found in the below Oracle Technology Network page:


Some of these vendors might require you to purchase a separate license for the spatial data. You need to get in touch with the vendor directly for the same. After this, you would be able to download a spatial data dump from the spatial data vendor.

Installing Spatial Data

The spatial data acquired from a third party vendor can be in various formats. Typical vendors provide shape files (.shp) or a database dump for download. The exact spatial data model varies from vendor to vendor and there is no generic format to this. Hence, the documentation that comes along with the spatial data is of utmost importance. This is required to identify what type of spatial data is available in which table.

The first task is to import the data in the shape file into the DWADM schema. A database dump can be imported by the standard oracle impdp command. A shape file can also contain the spatial data tables along with the data that can be imported by Oracle MapBuilder. Follow the steps mentioned below for this:
1. Unzip or decompress the .zip file (Typically, the shape file is zipped for data compression) to a temp directory. For example, C:\Spatial

2. Download the standalone MapBuilder application from this site:

3. Start the MapBuilder. On windows, run this to start: java -jar mapbuilder.jar
   
   Note: Refer to the MapViewer documentation for detailed instructions on installing and running MapBuilder from this site: http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html

4. Create a connection to the DWADM schema in the Oracle Utilities Analytics Data Warehouse database by navigating to File > New Connection.

5. Navigate to Tools > Import Shapefile, and click Next.

6. Click the Shapefile.

7. Browse to the C:\Spatial directory, select the .shp file, and click Open.

8. Click Next.

9. Ensure the Create Predefined Theme box is unchecked, and click Next.

10. Review the summary information and click Finish. A sample screenshot is shown below.

![](image)

**Importing the Spatial Data into Oracle Utilities Analytics Spatial Data Tables**

Once the spatial data tables from an third party vendor have been imported into the DWADM schema, the next step is to import the spatial data needed by Oracle Utilities Analytics into certain specific tables. This step to import a certain subset of the data into a standardized set of Oracle Utilities Analytics tables is for decoupling. This decoupling helps the Oracle Business Intelligence Enterprise Edition map reports and other Oracle Business Intelligence Enterprise Edition map configuration to remain oblivious to the variations in the spatial data schema coming from various vendors. This way you need not touch any of the spatial metadata catalog or modify any of the map reports being delivered out-of-the-box.
Oracle Utilities Analytics needs the administrative boundary type of spatial data at four levels - State, City, County and Postal Code. All map reports in Oracle Utilities Analytics are using one of these levels. Since the spatial data model varies from vendor to vendor, further details provided in this section is based on a sample spatial data from a specific vendor.

The following sections describe how the import the data based on a sample spatial data dump provided by HERE maps (formerly NAVTEQ). This sample data set contains administrative boundary data for the OHIO city in the US country. The sample data set from the Oracle partner can be downloaded from the Oracle Utilities Analytics OTN (Oracle Technology Network) page: http://www.oracle.com/technetwork/database/options/spatialandgraph/downloads/spatial-partners-data-087203.html

However, the steps can be used with a little variation to setup the spatial data for Oracle Utilities Analytics for any city from any country. The extent of the changes need to be done varies based on the vendor used to purchase the spatial data. Read through the documentation of the spatial data model provided by the vendor to understand what type of data lies in what table.

Below table provides a simple mapping based on the HERE maps sample data.

<table>
<thead>
<tr>
<th>Spatial Data Level</th>
<th>Table in Navteq Sample Data</th>
<th>Additional Filters</th>
<th>Oracle Utilities Analytics Spatial Data Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>WOM_AREA</td>
<td>Feature Type = 90996</td>
<td>Q1_STATES54004</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ISO Country Code = ‘USA’</td>
<td></td>
</tr>
<tr>
<td>City</td>
<td>PL39_d00</td>
<td>Q1_CITY54004</td>
<td>lsad_trans = 'city', 'village'</td>
</tr>
<tr>
<td>County</td>
<td>CO39_D00</td>
<td>Q1_COUNTY54004</td>
<td></td>
</tr>
<tr>
<td>Postal Code</td>
<td>ZT39_D00</td>
<td>Q1_USZIP54004</td>
<td></td>
</tr>
</tbody>
</table>

Apart from these four levels, there are also some standard themes and styles that need to be imported.

Below sub-sections contain the SQL statements to create and populate the various spatial data tables for Oracle Utilities Analytics. The prerequisite is that spatial data has been purchased by you and the spatial data dump has been imported into the DWADM schema. It is assumed that the eLocation website is being used as the base map in the Oracle Business Intelligence Enterprise Edition mapviewer setup, for which the SRID (Spatial Reference System Identifier) is 54004. The SRID is a unique value used to identify the coordinate system used in a Geographic Information System (GIS) application. If some other base map is used, then the transform parameter in the insert statements should specify the SRID of the base map being used.

**Importing Theme Related Spatial Data into Oracle Utilities Analytics**

The sdo_ tables are standard tables expected to be present in the spatial data from any vendor.

```sql
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;
```
Importing State Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_STATES54004 is used to store the state related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

```sql
CREATE TABLE Q1_STATES54004
(
    feature_id NUMBER,
    feature_name VARCHAR2(255),
    area_id NUMBER,
    name_langcode VARCHAR2(35),
    feature_type VARCHAR2(30),
    country_code_3 VARCHAR2(5),
    geometry SDO_GEOMETRY,
    carto_id NUMBER(10,0)
);

INSERT INTO Q1_STATES54004_SDX
SELECT NULL, name, NULL, lang_code, feature_type,
ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), carto_id
FROM WOM_AREA WHERE feature_type = 909996 AND iso_country_code = 'ISO';
```

*Note:* Customize the table name WOM_AREA, the feature type value and the ISO country code as per the spatial data model obtained by you. The below insert statement is to define the Q1_table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.

```sql
INSERT INTO user_sdo_geom_metadata VALUES
('Q1_STATES54004', 'GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',-19000000,50000000,0.0005)), 54004);
CREATE INDEX Q1_STATES54004_SDX ON Q1_STATES54004 (geometry)
indextype IS MDSYS.SPATIAL_INDEX;
```

Importing City Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_CITY54004 is used to store the city related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

```sql
CREATE TABLE Q1_CITY54004 AS
SELECT upper(name) FEATURE_NAME, sdo_cs.transform(geometry, 54004) geometry, 'OHIO' state
FROM pl39_d00 WHERE lsad_trans IN ('city', 'village');
```

*Note:* Customize the table name pl39_d00 and additional filters as per the spatial data model obtained by you. Map the state name dynamically for the current city record in the spatial data. The below insert statement is to define the Q1_table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.

```sql
INSERT INTO user_sdo_geom_metadata VALUES
('Q1_CITY54004', 'GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004);
CREATE INDEX Q1_CITY54004_SDX ON Q1_CITY54004 (geometry)
indextype IS MDSYS.SPATIAL_INDEX;
```
INSERT INTO user_sdo_geom_metadata VALUES ('Q1_CITY54004', 'GEOMETRY', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005), MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004);

CREATE INDEX Q1_CITY54004_sdx ON Q1_CITY54004 (geometry) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_CITY54004 SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing County Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_COUNTY54004 is used to store the county related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_COUNTY54004 AS
SELECT name FEATURE_NAME, sdo_cs.transform(geometry, 54004) geometry, 'OHIO' state FROM CO39_D00;

Note: Customize the table name CO39_D00 as per the available spatial data model. The below insert statement is to define the Q1_ table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.

INSERT INTO user_sdo_geom_metadata VALUES ('Q1_COUNTY54004', 'GEOMETRY', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005), MDSYS.SDO_DIM_ELEMENT('X',-50000000,19000000,0.0005)), 54004);

CREATE INDEX Q1_COUNTY54004_sdx ON q1_county54004 (geometry) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_COUNTY54004 SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Importing Postal Code Spatial Data into Oracle Utilities Analytics

In Oracle Utilities Analytics, the table Q1_USZIP54004 is used to store the county related administrative boundary. Create the table based on the DDL below and insert the values from one of the spatial data tables obtained from the vendor.

CREATE TABLE Q1_USZIP54004 AS
SELECT zcta ZCTA5CE, sdo_cs.transform(geometry, 54004) geom. FROM ZT39_D00;

Note: Customize the table name ZT39_D00 as per the available spatial data model. The below insert statement is to define the Q1_ table as a spatial table and update the spatial metadata view to reflect the dimensional information for the areas. The parameters for the insert statement are table name, geometry column name, and X and Y boundaries (the latitude and the longitude) based on the data and the tolerance value.
INSERT INTO user_sdo_geom_metadata VALUES ('Q1_USZIP54004', 'GEOM', MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',-20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('Y',-50000000,19000000,0.0005)), 54004);

CREATE INDEX Q1_USZIP54004_SDX ON Q1_USZIP54004 (geom) indextype IS MDSYS.SPATIAL_INDEX;

UPDATE Q1_USZIP54004 SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);

**Improving Performance by Prefetching the Map Tiles**

Rendering map tiles dynamically can affect system performance. To avoid this, you may consider prefetching tiles by issuing an admin request to MapViewer on a non-production server or when the server is not under load. When MapViewer receives a prefetching request, it issues many concurrent map tile requests to itself, which are basically XML map requests, and stores them in the cache. This improves the system’s performance as the images are readily available.

Follow the following procedure to prefetch map tiles. These instructions are for MapViewer 11.1.1.9.1 version. If you are using a different version, refer to the MapViewer documentation for instructions.

1. In the **MapViewer** console, click **Admin** in the top-right corner of the page and log into the Admin Console page.
2. In the **Admin Console** page, click **Management > Manage Map Tile Layers**.
3. Select the required online map tile and click **View map/Manage Tiles**.

   The **Prefetching** wizard opens:
4. Enter the X, Y coordinates of the center of the map, the SRID and zoom level, and click Show Map.

To prefetch map images, enter the latitude and longitude values. You need to know the latitude and longitude values of the center of the location in interest. The SRID is a unique value used to identify the coordinate system used in a GIS application.

The X and Y axis used in the following example is for Ohio:

<table>
<thead>
<tr>
<th>Center X</th>
<th>Center Y</th>
<th>SRID</th>
<th>Zoom Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>5211578.9</td>
<td>4887077.75</td>
<td>54004</td>
<td>5</td>
</tr>
</tbody>
</table>

5. When you see the map, turn on the Area Selection tool and select the area on the map for which you want to prefetch the tiles.

6. Select one or more zoom-levels for which you want to prefetch the tiles.

### Loading the Oracle Utilities Specific Themes

This section describes how to load spatial metadata in the USER_SDO* tables for Oracle Utilities Analytics.

Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in the database and copy the user_sdo.dmp file from ../BI260/Spatial-Metadata folder to that location.

2. Import the released spatial tables to the target database using the following command:

```
impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=impdp_user_sdo.log schemas=DWADM remap_tablespace=cists_01:<tablespace_name>
```

**Note**: Run this command from database server.

**Note**: Make sure to change the tablespace_name to tablespace name on which DWADM has the quota. If DWADM user have quota on cists_01 tablescape, then exclude whole remap_tablespace clause from command.

3. Review the impdp_user_sdo.log file to ensure the tables are imported successfully.

4. After importing the tables, run the following SQL scripts from the ../BI260/Spatial-Metadata folder:

   - sqlplus dwadm/<dwadm user password>@database-name @copy_spatial_metadata.sql
   - sqlplus dwadm/<dwadm user password>@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

### Additional Setup for Oracle Utilities Outage Analytics

The Outage Analytics product within Oracle Utilities Analytics needs some additional spatial data setup. The reason is that Outage Analytics alone uses point information from spatial data for plotting outage event related information on maps. This section should be skipped if NMS is not one of the source systems for Oracle Utilities Analytics.

The very first step is to replicate the DIAGRAM_OBJECTS table into the Oracle Utilities Analytics database. However, a suitable mechanism needs to be built to refresh this table with the latest data from Oracle Utilities Network Management System whenever there are changes in the source system.
Once this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps set the Oracle Utilities Analytics dashboards up to use the data in this replicated table.

1. Create the required spatial metadata:

   INSERT INTO user_sdo_geom_metadata
   VALUES ('DIAGRAM_OBJECTS','LL_GEOMETRY',
   MDSYS.SDO_DIM_ARRAY (  
     SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05),  
     SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)  
   ), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The LL_GEOMETRY column by default stores spatial data using SRID 54004, so this works without changes with the eLocation base map:

   create index Q1_DIAGRAM_OBJECTS_SDX  
   on diagram_objects (ll_geometry)  
   indextype is mdsys.spatial_index;

Once DIAGRAM_OBJECTS table is replicated to the Oracle Utilities Analytics database, follow the below steps to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to the DWADM schema of Oracle Utilities Analytics database and execute the following:

   CREATE TABLE Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;

2. INSERT INTO user_sdo_geom_metadata:

   VALUES ('Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY',
   MDSYS.SDO_DIM_ARRAY (  
     SDO_DIM_ELEMENT ('X', -20037508, 20037508, .05),  
     SDO_DIM_ELEMENT ('Y', -45884542, 45884542, .05)  
   ), 54004);

3. CREATE INDEX Q1_DIAGRAM_OBJECTS_SDX_54004 on Q1_DIAGRAM_OBJECTS_54004 (ll_geometry) indextype is mdsys.spatial_index;
4. Under **Tile Operations**, click on **Prefetch Tiles**. Here is a snapshot of the area selection and the tile operation.

This process takes some time, depending upon the hardware configuration of the system and the amount of data to be prefetched. To check the current status of the operation, click **Refresh** under the **Operation Status**. The status will change to “Finished” when the operation is done.
Chapter 8
Installing the NMS Business Intelligence Publisher Reports

This section describes the steps to be performed while installing the Oracle Utilities Analytics NMS IEEE outage reports:

1. Unzip the IEEE outage reports contained in OUA NMS BI Publisher reports.zip from the installation media to a temporary directory (ex. TEMPDIR) on the server where Oracle BI Publisher is installed.

2. Log into Oracle BI Publisher (http://<BI Publisher server name>:9704/xmlpserver/) as the Administrator from a browser that has access to the TEMPDIR folder from the step 1.

3. Set up a database connection as follows:
   a. Navigate to Oracle BI Publisher Administration > Data Sources > JDBC Connection.
   b. Click Add Data Source.
   c. In the Data Source Name field, enter NMS BI Publisher or a name of your choice.
   d. Set the Driver Type to Oracle 9i/10g/11g.
   e. Set the Database Driver Class to oracle.jdbc.OracleDriver.
   f. Set the Connection string to:jdbc:oracle:thin:@<yourmachine>:<Port>:<ORACLE_SID>
      
      Note: The database connection referring to OUA have to be setup here.
   g. Set the username and password to match your Oracle Utilities Analytics database login values.
      
      Note: The username should be “DWREAD” and the password corresponding to this user.
   h. Click Test Connection and verify that it is properly configured.
   i. Click Apply.

4. From the BI Publisher Catalog page, select Shared Folders from the folders tree.

5. On top of the folders section, click the New drop-down list and select Folder from the list.

6. Enter NMS IEEE Reports as the folder name (or a name of your choice), then click Create. The new folder is added. You may have to click Refresh button to update the Folders list.
7. Select the **NMS IEEE Reports** folder in the folder list. Under the **NMS IEEE Reports** folder, create another new folder named **NMS IEEE Data Models**.

8. Select the **NMS IEEE Data Models** directory, and then click **Upload** in the **Tasks** section on the bottom left.
   
   a. Browse to the directory where the NMS IEEE BI Publisher reports exist (TEMPDIR from step 1).
   
   b. Locate all of the data model files and upload them to the **NMS IEEE Data Models** directory. These files contain an extension of .xdmz and include the following files:
      
      • CriticalCustomerOutages.xdmz
      • DailyTroubleReport.xdmz
      • DeviceOutageHistory.xdmz
      • IEEEIndiceCalculations.xdmz
      • IndicesByCity.xdmz
      • OutageSummary.xdmz
      • RecurringDeviceOutages.xdmz
      • SustainedOutagesByCauseSummary.xdmz
      • SustainedOutageSummary.xdmz

9. Select the **NMS IEEE Reports** directory, and then click **Upload** in the **Tasks** section on the bottom left.
   
   a. Browse to the directory where the OUA NMS IEEE BI Publisher reports exist (TEMPDIR from step 1).
   
   b. Locate all of the report files and upload them to the **NMS IEEE Reports** directory. These files contain an extension of .xdoz and include the following files:
      
      • CriticalCustomerOutages.xdoz
      • DailyTroubleReport.xdoz
      • DeviceOutageHistory.xdoz
      • IEEEIndiceCalculations.xdoz
      • IndicesByCity.xdoz
      • OutageSummary.xdoz
      • RecurringDeviceOutages.xdoz
      • SustainedOutagesByCauseSummary.xdoz
      • SustainedOutageSummary.xdoz

10. Assign the appropriate JDBC connection to the imported data models.
    
    a. Click **Catalog**.
    
    b. Select the **NMS IEEE Data Models** directory, and then select the CriticalCustomerOutages.xdmz data model.
    
    c. Click **Data Model** on the top left.
    
    d. In the **Properties** frame on the right, make sure that **Default Data Source** points to the data source you created earlier. This defaults to **NMS BI Publisher**.
    
    e. You must perform this step for all of the data models under the NMS IEEE Data Models directory.
11. Assign the appropriate data model to all the NMS IEEE Reports.
   a. Click on Catalog.
   b. Select the NMS IEEE Reports directory. Click Edit for the CriticalCustomerOutages report.
   c. At the top left of the page, click Search.
   d. Browse and select the appropriate data model file (will match the name of the report with an extension of .xdmz).
   e. Save the current report by clicking Save on the top-right of the page.

You should now be able view the standard IEEE indices reports from BI Publisher by simply selecting the desired report from the NMS IEEE Reports directory under the Catalog.